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NO lea este manual completamente … a no ser que lo desee.   

• Los capítulos 1 - 3 son muy importantes en cuanto a la configuración de su Force y configuración de corte 
de aprendizaje. 

• Los capítulos 4 cubre cómo exportar SVG desde los programas de diseño soportados. Por favor, lea la 
sección en el programa de diseño que usted estará utilizando.   

• El Capítulo 5 cubre la función de doble cabezal y cómo utilizar mejor las herramientas de accesorio de la 
Force. 

• El Capítulo 6 es para aquellos propietarios que desean realizar aplicaciones de impresión y corte. 

• El Capítulo 7 cubre la herramienta rotatoria de la Force. 

• El Capítulo 8 cubre materiales y aplicaciones populares usados en la Force. 

 

No es práctico imprimir este manual completo porque: 

• Es un desperdicio de papel y tinta si usted solo necesita ciertas secciones. 
 

• Los enlaces directos a videos, publicaciones de blog, productos, etc. no funcionarán. 
 

• Los manuales de usuario son actualizados de vez en cuando. 
 

• Usted No puede buscar palabras individuales 
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Capítulo 1 Introducción a la KNK Force 1 
 

 
¡Gracias por Comprar KNK Force! Si usted es nuevo en cortadoras digitales, por favor lea los siguientes 
párrafos antes de pasar abajo a leer la sección IMPORTANTE. 
 

Su nueva KNK Force tiene las siguientes capacidades: 

 Usando el porta cuchilla y cualquiera de los tres tipos de cuchillas, la Force puede cortar materiales finos 
tales como vinil, papel, cartulina, cartulina espumada, vinil de transferencia por calor, materiales de 
plantillas para imitaciones de diamantes, tela, felpa, cuero, foami, hojas magnéticas, acetato, cartón, papel 
de azúcar, y más! 

 Las limitaciones en lo que se puede cortar con una cuchilla se basan tanto en el espesor y la densidad del 
material. Usted no puede cortar materiales más gruesos de 3 mm. También, con la cuchilla, usted no puede 
cortar acrílico duro, acero, vidrio y otros materiales densos. Con algunos materiales, como el plástico de 
artesanía y estireno, usted puede cortar láminas finas (0,02 "o 0,5 mm), pero no hojas más gruesas. Una 
regla general es que, si usted lo puede cortar a mano con un cuchillo de artesanía, en su mayoría 
probablemente se puede cortar con el porta cuchilla de Force. 

 Si usted ha adquirido la herramienta rotatoria KNK Force opcional, usted tiene más opciones para cortar. 
Por ejemplo, 1/8 "(3 mm) acrílico duro puede ser cortado. También puede realizar grabados profundos que 
si se utiliza el grabador Force opcional que sólo puede lograr “raspar” grabados de línea fina.  

 La KNK Force tiene dos herramientas asientos en la cabeza. Esto significa que usted puede realizar 
funciones tales como puntuación y corte, relieve y cortar, dibujar y relieve, etc. por tener diferentes 
herramientas insertadas en los lados izquierdo y derecho de la cabeza de la máquina. 

 La KNK Force tiene una cámara que facilita la calibración de las posiciones relativas de dos herramientas. 
Esto es también utilizado en aplicaciones de impresión y corte, en el que usted envía un diseño a su propia 
impresora. La imagen se imprime, junto con las marcas de registro. La cámara entonces localiza las 
marcas de registro que fueron impresas y recorta las figuras como corresponden. 

 
¡IMPORTANTE!  ¡La KNK Force es diferente a cualquier otra cortadora de cuchilla en el mercado! 
Independientemente de su experiencia con otras cortadoras, incluyendo modelos KNK previos, es MUY 
importante que usted entienda los nuevos principios para cortar.  ¡Por favor tome el tiempo para leer lo 
siguiente antes de probar su nueva e increíble máquina! 

• IMPORTANTE:  Antes de conectar su Force y encenderla, favor leer la secuencia recomendada en la 
Sección 2.02.3. 

• La KNK Force tiene el control del eje Z. En lugar de la cabeza "caer" para iniciar el corte, se moverá hacia 
abajo a una velocidad controlada. Este cambio fue necesario para añadir la capacidad de herramienta 
rotativa. Esto también ha añadido una gran cantidad de poder, así como funcionalidad, a la cortadora 

 La cuchilla ahora estará completamente extendida en todo momento. Con los nuevos ajustes de 
profundidad, usted puede controlar cuan "abajo" la cuchilla tratará de cortar. Sin embargo, Las cuchillas son 
frágiles, así que tenga cuidado insertando o removiendo su porta cuchilla de la Force, así como el 
almacenamiento del mismo. ¡Además, evite “ver qué pasa” mediante el uso de ajustes extremos! ¡Usted 
fácilmente puede romper una cuchilla haciendo esto! 

 Cada vez que inserte el porta cuchilla, usted establecerá el origen del Eje Z con la punta de la cuchilla 
descansando sobre la parte superior del material o de la parte superior del tapete de corte. Así que ya no 
necesitará más estimar qué tan alto insertar el porta cuchilla por encima del material. Es importante, al fijar 
este origen, no tener la herramienta apretada dentro del asiento del porta cuchilla hasta después que el 
asiento del porta cuchilla caiga. ¡El texto en la pantalla le recordará porque esta es otra manera que usted 
puede romper una cuchilla! 

                                                 
1 © 2015, 2016 Accugraphic Sales, Inc., Todos los Derechos  
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 El porta cuchilla tiene un ajuste de Tensión de Cuchilla. Este ajuste se utiliza para proporcionar 

más o menor fuerza, dependiendo del material a ser cortado. Un material tal como vinil y papel 

fino requerirá la menor cantidad de tensión, mientras que un material como cartulina requerirá más 

cantidad de tensión. Más es cubierto en la Sección 1.08.  

 Ya no existe un ajuste de Fuerza o Presión. Esto es debido al hecho de que la fuerza aplicada es una 
combinación de la Profundidad Terminando (Ending Depth) y los ajustes de tensión en la cuchilla (Blade 
Tension). Esto se discutirá en más detalle en el capítulo 3 

 Con el corte de múltiples pasadas, usted ahora tiene la habilidad de cortar progresivamente a través de un 
material en lugar de la cuchilla estar tratando de penetrar todo el espesor en la primera pasada. Usted 
entrará una Profundidad Comenzando (Starting Depth), una Profundidad Terminando (Ending Depth), 
y el número de Pasadas. 

 Hay cambios en cómo cortar algunos materiales en comparación con la forma en que ellos habían sido 
cortados en el pasado. Por ejemplo, habrá diferentes ajustes para cortar vinil sobre el tapete de corte a 
cortar el vinil sin usar el tapete de corte. Estos serán presentados por separado en la tabla de ajustes 
recomendados. 

 Use el bolígrafo de prueba incluido hasta que sepa, con confianza, donde cortarán las figuras. 

 Se recomienda leer Capítulos 1 y 2, además de las Secciones 3.01 - 3.05 antes de utilizar el porta cuchilla. 
El resto del manual puede ser utilizado como una guía de referencia para los temas específicos de interés, 
tales como leer el Capítulo 7 para aprender cómo utilizar la herramienta rotatoria o leer el Capítulo 6 para 
aprender cómo hacer una impresión y corte. 

 
 

1.01 Opciones del Manual del Usuario 

• Este manual del usuario es publicado en dos formatos: un manual interactivo en línea, y una versión PDF. 
Ambos formatos contienen la misma información; las dos opciones de formato son para su 
conveniencia/preferencia personal los diferentes formatos son para su conveniencia. 

• Tener la tabla de contenido continuamente visible facilita la navegación. También es útil saber cómo buscar 
palabras o términos específicos. Aquí hay un enlace a un tutorial que cubre cómo hacer estas dos cosas: 
How to Get the Most from your KNK UM (Cómo sacar el máximo provecho de su UM de KNK) 

• Tenga en cuenta los iconos verdes  que enlazan a vídeos relacionados con la sección en la que 

estos se encuentran. Estos videos mejorarán tu aprendizaje. 

 
 

1.02 Seguridad y Advertencias 

Por favor tenga en cuenta las siguientes guías de seguridad cuando trabaje con la KNK Force: 

• Puntos de Presión:  Mantenga las manos, cabellos largos, ropa suelta, prendas, etc. alejadas de las partes 
en movimiento. 

• Riesgo para Niños y Mascotas:  Por favor supervise a los niños que estén alrededor de la Force, cuando 
esta esté en uso. Particularmente, el dispositivo rotatorio puede representar un peligro para las mascotas y 
niños sin supervisión.  

• Protección de Ojos:  Se recomienda usar protección de ojos, como gafas de seguridad, cuando esté 
trabajando con el dispositivo rotativo. 

• Instrucciones Para Herramienta Rotatoria: Lea las Secciones 7.01 - 7.07 antes de usar la herramienta 
Rotatoria Opcional. 

• Moviendo y Tocando:  No mueva la KNK Force o toque algún circuito mientras esta esté conectada.   

 Además: 

 NO toque o bloquee la vía del trazador o cortador mientras esta esté en funcionamiento. Es 
responsabilidad del propietario si la cortadora se daña.  

 NO sacuda la cortadora mientras esté en funcionamiento. 

http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Getting-the-Most-from-KNK-User-Manuals.pdf
https://www.youtube.com/watch?v=HdsaGSMD_0I&t=48s
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 NO corte ningún material que tenga grapas, presillas, u otros adornos atachados. 

 NO toque la cortadora con magnetos. Sin embargo, es seguro cortar materiales magnéticos, tales como 
aquellos usados en refrigeradores y exterior de carros. 

 NO permita que objetos pequeños caigan en la cortadora. 

 Transportando: Cuando transporte la cortadora, mueva las palancas de las ruedas de presión hacia 
arriba o remuévalas de la Force deslizando hacia el extremo derecho (parado de frente a la cortadora). 
Remueva la cuchilla del porta cuchilla y cubra la punta con la tapa plástica. Remueva también los 
artículos de los compartimientos de almacenaje dentro de la mesa plegable.   

 

 
1.03 Garantía 

• ¡IMPORTANTE! Si su KNK Force es dañada durante el envío o parece estar defectuosa, entonces su 
vendedor debe ser notificado tan pronto como sea posible. Si los daños son reportados después de tres 
semanas del envío, entonces será responsabilidad del propietario enviar la cortadora dañada de regreso a 
KNK USA para repararla.   

• La garantía de un año en piezas y labor cubre solamente defectos de fabricación y no incluye el uso y 
desgaste normal. Si el trabajo de garantía es requerido, el dueño es responsable de todos los costos de 
envió desde y hacia KNK USA. 

• Los dueños de KNK Force fuera de USA deben contactar sus vendedores para procedimientos en cuanto a 
Trabajo de garantía o envío dañado. 

• También se recomienda que usted guarde la caja original con los materiales de empaque en caso que 
tenga que enviar su KNK Force.  

 
 

 

 
 
1.04 Apoyo 

• Si usted se encuentra con dificultades operando su KNK Force, apague la corriente y busque una solución 
en este manual. El Apéndice A es una lista de Soluciones a problemas de preguntas frecuentes. Si 
continúa teniendo preguntas técnicas o problemas, por favor, contacte su vendedor KNK lo antes posible.  

• Para cualquier problema en el envío, incluyendo retrasos o daños, favor ponerse en contacto tan pronto 
como sea posible con KNK USA (o su distribuidor KNK si usted está fuera de los Estados Unidos) para que 
las acciones apropiadas con la compañía de transporte puedan ser iniciadas. 

 Para cualquier problema mecánico, favor contactar KNK USA.  

 Para obtener más ayuda en el aprendizaje de la Force, así como compartir ideas y  fotos de proyectos con 
otros dueños de Force, los siguientes grupos son recomendados:  

 KNK Force Yahoo group: https://groups.yahoo.com/neo/groups/KNK_Force/ 

 All KNK Yahoo group: http://groups.yahoo.com/group/Klic-N-Kut/ 

 KNK Force Facebook group: https://www.facebook.com/groups/KNKForce/ 

 All KNK Facebook group: https://www.facebook.com/groups/KNKMaxx/ 

 For inspiration and tips on cutting specific materials: http://teamknk.com/ 

 Cortadoras KNK español: https://www.facebook.com/groups/1701215543429595/ 

 

 

KNK USA Phone: 800-268-3672 

Support Ticket: http://knkusa.com/support/ 

https://groups.yahoo.com/neo/groups/KNK_Force/
http://groups.yahoo.com/group/Klic-N-Kut/
https://www.facebook.com/groups/KNKForce/
https://www.facebook.com/groups/KNKMaxx/
http://teamknk.com/
https://www.facebook.com/groups/1701215543429595/
http://knkusa.com/support/
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1.05 Desempacando 

 

• Después de abrir la caja, deslice para afuera la KNK Force cuidadosamente.  Usted no quiere rasgar o 
romper las piezas de los extremos de la espuma de poli-estireno, en caso de que los necesite en un 
momento futuro. 

• Remueva los protectores de espuma de poli-estireno al final de la tapa de cualquier lado. Corte, abra y 
remueva la bolsa de plástico alrededor de la Force.  Coloque la Force en una superficie plana y firme 

• Abra la tabla plegable frontal y remueva las piezas de espuma grandes y pequeñas insertadas alrededor de 
la cabeza de corte. 

• Debido a que el tapete de corte debe estar doblado para caber en la caja, éste se pudo haber redondeado 
ligeramente durante el envío. Suavemente enrolle el tapete de corte en la dirección opuesta para eliminar la 
redondez y colóquelo sobre una mesa plana para asegurarse de que el tapete se encuentra ahora en 
posición horizontal a la superficie. Consulte la Sección 1.10 para obtener instrucciones adicionales sobre la 
preparación del tapete para su uso. 

• Le recomendamos conservar la caja original con las piezas de espuma en caso de que tengas que enviar 
su KNK. 

• Verifique que ha recibido todo lo contenido. Hay una lista de verificación en la sección 1.06. Favor notificar 
a su suplidor KNK inmediatamente si falta algo. 

 

 
1.06 Contenido2 

• Su paquete KNK Force viene con lo siguiente: 

 Cortadora digital KNK Force 

 Tapete de Corte 15” x 15”  (refiérase a la Sección 1.09 para instrucciones) 

 Porta Cuchillas (refiérase a la Sección 1.08 para instrucciones)  

 Dos cuchillas: cuchilla para material fino (tapa roja) y cuchilla para material grueso (tapa azul) 

 Bolígrafo para pruebas  

 Ensamblaje de tres ruedas de presión (refiérase a la Sección 1.10 para instrucciones)  

 Cable de corriente y adaptador AC/DC       

 Cable Ethernet  

 USB – Wi-Fi adaptador y CD (Nota: el CD adjunto no requiere instalación. Ya se ha hecho y el 
adaptador ya está conectado en el lado derecho de la Force) 

 

 

 

 

 

 

 

 

 

 

 

 

                                                 
2 Si usted fue un participante en la campaña KNK Force Kickstarter, usted debe haber recibido un total de 5 cuchillas, 3 tapetes de corte, 

2 porta cuchillas y un repujador. 

http://cutterpunk.com/knk-force-videos/#unboxing
http://knkusa.com/product/force-12-x-12-mat-red-grid/
http://knkusa.com/product/force-blue-bladeholder/
http://knkusa.com/product/knk-force-standard-material-detail-blade/
http://knkusa.com/product/knk-force-thick-material-blade/
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1.07 Partes de la KNK Force  

 
 

 

 
Frente  

 

 
Lado Derecho 

 
 

 
1.08 Porta Cuchillas y Cuchillas  

 Hay tres tipos de cuchillas para la KNK Force:  

 

 

 La de 45 grados, cuchilla con cubierta roja, es ideal para cortar materiales más finos como papel, todo tipo 
de cartulina, transferencias térmicas, y vinil.  

 La de 60 grados, cuchilla con capa azul, es una cuchilla más larga y es muy adecuada para el corte de 
materiales gruesos, como las pastas de goma, plástico artesanal, y el material de plantillas para 
imitaciones de diamantes.   

 La de 30 grados, cuchilla con capa amarilla, es una cuchilla ancha y es adecuada para el corte de tela y 
fieltro.  

Cabeza/Carro Cuchilla 

Ruedas de Presión: 
Total de 3  

Asientos para el Porta Cuchilla 
con tornillos frontales (total de 2) 
 

Mesa Delantera Plegable 

Etiquetas Gris de 
Posicionamiento: 
Total de 4 

Franja de Corte 

Ejes de Grano (uno directamente 
debajo de cada etiqueta gris): 
Total de 4 

Botón de Encendido 

Tapete de Corte (Hoja 

Portadora) 

Puerto de 
Corriente 

Puerto USB: 
Total de 4 

Adaptador Wi-Fi  

Puerto Ethernet  

 Roja             Azul        Amarilla 

http://knkusa.com/product/knk-zing-standard-material-detail-blade/
http://knkusa.com/product/knk-zing-fabric-blade/
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• Tenga en cuenta que la cuchilla de capa roja y la cuchilla de capa azul tienen un corte en el lado opuesto de la 
hoja (lado derecho, en la foto anterior). Esto reduce el valor del desplazamiento (offset) de la cuchilla y permite 
un corte detallado en figuras pequeñas.   

• Hay tres porta cuchillas vendidos para la Force: rojo, azul, y amarilla. Estos tres porta cuchillas son idénticos, 
excepto el color. Por lo tanto, cualquier color de porta cuchilla puede ser usada con cualquiera de los tres tipos 
de cuchilla.  

• Dueños que a menudo cambian de materiales, muchas veces encuentran conveniente tener los porta-cuchillas 
asignados a cada tipo de chuchilla, cuya cubierta de la cuchilla coincida con el color del porta-cuchilla. En otras 
palabras, ellos solo usarán su porta-cuchilla rojo con su cuchilla con cubierta roja, cuchilla con cubierta azul en 
su porta-cuchilla azul y cuchilla con cubierta amarilla en su porta-cuchilla amarillo. Una vez más, esto es una 
elección personal. Cualesquiera de los tres tipos de cuchilla se pueden utilizar en cualquiera de los tres porta-
cuchillas. 

 

 
1.08.1 Instalación de la Cuchilla3  

 

 

 

• La cuchilla debe insertarse con cuidado en el porta-cuchilla. Haz esto sobre una superficie blanda, como 
una toalla de papel. ¡Es Importante proteger la frágil cuchilla!   

• Desenrosque y ponga a un lado la cubierta de la cuchilla en la parte inferior del porta-cuchilla. Remueva la 
cubierta protectora de plástico (por ejemplo, la cubierta roja) de la cuchilla. Asegure esta cubierta de 
plástico para que usted pueda cubrir la cuchilla otra vez cuando cambies a otro tipo de cuchilla.   

• La siguiente fotografía muestra cómo la cuchilla será instalada respecto a la cubierta del porta-
cuchilla y la sección principal del porta-cuchilla: 

 

 

• Inserte la cuchilla en la sección principal del porta-cuchilla, con el extremo no afilado 
dentro de un pequeño agujero en el centro del porta-cuchilla. Si sus cuchillas vinieron 
con pequeños resortes, deslice un resorte sobre la cuchilla. 

  

 

                                                 

3 Nota: Al momento de escribir, sólo tenía disponible un porta cuchilla rojo. El porta cuchilla enviado con la Force es azul. Además del 

color, no hay diferencia en los porta cuchillas, por lo tanto, los siguientes procedimientos se aplican a cualquier porta cuchilla de la Force.  

 

Ajustador de Tensión 

 Tapa de la 
Cuchilla 

Tapa Inferior 

 Cuchilla  Mango 

Escala de Tensión 

 Sección principal del porta 
cuchilla 

Cuchilla 

¡IMPORTANTE!: Algunos porta cuchillas de la Force tienen una abertura que es 

ligeramente demasiado grande y la cuchilla pudiera caerse durante el corte. Por 

esta razón, si sus cuchillas vienen con pequeños resortes, por favor, deslice un 

resorte sobre la cuchilla antes de reemplazar la tapa. 

Cuchilla con resorte 

http://knkusa.com/product/force-red-bladeholder/
http://knkusa.com/product/force-blue-bladeholder/
http://knkusa.com/product/force-yellow-bladeholder/
https://www.youtube.com/watch?v=xK67zdUFRxc
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• La parte de adentro de la tapa del porta-cuchilla es un inserto con un agujero. Cuidadosamente coloque la 
tapa del porta-cuchilla sobre la cuchilla de manera que la punta de la cuchilla se deslice dentro de ese 

agujero: 

   

• Comience apretando la tapa. Si hay alguna Resistencia, asegúrese de que la punta de la cuchilla se está 
introduciendo en el agujero de la tapa. Atornillar la tapa trasera en el porta-cuchilla hasta que quede 

ajustada. 

 

 
• Debido a que la cuchilla está completamente expuesta, es muy importante tener cuidado insertando y 

removiendo el porta cuchilla de la Force. Ya que los porta cuchillas (con las cuchillas expuestas) pueden 
ser fácilmente almacenados en el interior de la mesa plegable, usted querrá remover los porta cuchillas 
antes de transportar su cortadora. A Michele Harvey se le ocurrió una gran idea para proteger las puntas de 
las cuchillas. Ella almacena los porta cuchillas en sus tubos plásticos originales, pero le ha añadido dos 

puntos de poli-estireno en la parte inferior del tubo para que la cuchilla se apoye en el poli-estireno: 

 

• Si usted no tiene estos puntos de poli-estireno o espuma, hay otras alternativas, como el corte de unos 
cuadrados pequeños de Foamy (goma eva) o de un cartón de huevos o incluso de algún material grueso 

como el fieltro.  

 

 Agujero dentro 
de la tapa del 
porta cuchilla 

Guía de la tapa 
sobre la Cuchilla 
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1.08.2 Ajustando la Tensión de la cuchilla (BT) 

• El interior del porta-cuchilla de la Force es un resorte grande el cual puede ser comprimido o 
descomprimido para cambiar la cantidad de tensión en la cuchilla. Tensiones más bajas son necesarias 
para el corte de materiales delgados mientras que tensiones más altas son mejores para cortar materiales 
densos más gruesos.  

• El extremo superior del porta-cuchilla de la Force es la escala de tensión ajustable que va de 1 (tensión 

más ligera) a 6 (máxima tensión): 

 

• Para ajustar la Tensión de la Cuchilla (BT), sujete la tapa superior del porta-cuchilla firmemente con una 
mano, asegurándose que pueda ver los números en la escala de tensión. Con la otra mano, gire la parte 

principal del porta-cuchilla. A medida que gira la sección principal del porta-cuchilla, la tensión cambiará: 

 

     

Cuando se ajusta el BT de acuerdo a un valor recomendado, ajuste el porta-cuchilla de manera que la mitad 
del número esté cubierto, como la mitad mostrada en la foto anterior donde el valor es 5.   

Hay aproximadamente cuatro revoluciones entre cada dos números. Si la mitad del ajuste es recomendado, 
como por ejemplo 3.5, entonces el porta-cuchilla sería girado alrededor de dos revoluciones de manera que la 

tensión esté aproximadamente a la mitad entre 3 y 4: 

 

Para aprender más acerca de la importancia de la Tensión de Cuchilla, favor leer la Sección 3.  

 

 
1.09 Herramientas de Accesorios 

 
Los siguientes accesorios pueden ser comprados para usarse con la KNK Force: 

• Herramienta Rotatoria: Usada para cortar materiales más gruesos, grabado en metal/madera/acrílico, y 
para taladrar o hacer agujeros. Refiérase al Capítulo 7. 

• Herramienta de Repujado o grabado al relieve: Usado para marcar y repujar productos de papel y cuero 
fino. Referirse a la Sección 5.05. 

• Herramienta de Grabado: Usada para marcar plástico artesanal y hacer líneas finas “rayadas” grabadas en 
metal, papel vegetal, y acrílico. Referirse a la Sección 5.06. 

• Herramienta de Perforación/Ponche: Usada para perforar pequeños agujeros en papel, papel vegetal, y 

otros materiales finos suaves. Referirse a la Sección 5.07. 

Escala Tensión 
Escala: 1 a 6  

Gire en dirección de las 
manecillas del reloj para 
disminuir BT.  
Gire en sentido opuesto al 
de las agujas del reloj para 
aumentar BT.   

Sujete esta parte mientras 
giras la parte principal del 

porta cuchillas 

BT está ajustado a 5. 

BT ajustado a ~3.5. 

http://knkusa.com/product/knk-force-rotary-tool/
http://knkusa.com/product/force-embossing-tool/
http://knkusa.com/product/force-engraving-tool/
http://knkusa.com/product/force-punchpiercing-tool/
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1.10 Preparando y Cuidando el Tapete de Corte 

 

Tapete muy pegajoso:   Añadiendo más adhesivo al tapete:  

 

 

 
1.10.1 Consejos Sobre el Uso del Tapete de Corte 

• Siempre utilice un tapete de corte para sujetar el material a no ser que el material a cortar tenga su propio 
protector en la parte trasera. Por ejemplo, el vinil y la transferencia de calor, ambos traen una capa que 
usted no corta. Por lo tanto, esta capa sirve como soporte para el corte. El papel y la cartulina no tienen 

esta capa, por lo que se deben cortar usando el tapete de corte. 

• ¡IMPORTANTE! Un nuevo Tapete para la Force tiene la mejor pegajosidad para cortar tela y plástico. Sin 
embargo, es demasiado pegajosa si usted está cortando productos de papel. Esto puede causar dificultad 
removiendo elementos cortados sin que se rompan. Coloque una toalla de baño vieja pero limpia sobre la 
superficie del tapete y presione con un rodillo. Luego, tire hacia arriba. Pruebe la pegajosidad presionando 
la palma de su mano en medio de la alfombra y elevándola. Si la alfombra se mantiene pegado a la mano 
durante más de un segundo o dos, repetir hasta que el tapete pueda ser levantado, pero se suelte. Debe 
tener sólo unas pocas presiones para reducir en gran medida la pegajosidad, pequeñas fibras (demasiado 
pequeño como para ser visible) de la toalla son añadidas a la superficie. 

• Si usted tiene cortes inconsistentes entre el medio del tapete y los lados, añada algo como una estiva de 
libros o una caja detrás de la Force. 

• No deje las ruedas de presión en la posición baja cuando la Force no esté en uso. Esto deforma el plástico 
antes de tiempo, acortando la vida útil del tapete de corte. Con el tiempo, tendrá que ser reemplazado.  

• Uno de los propietarios de la Force diseñó una guía para tapete para facilitar cargar el tapete de corte en la 
misma posición y estabilizar este para el corte. Para más información, refiérase a Appendix B.4. 

 
1.10.2 Limpiando y Reposicionando el Tapete de Corte 

• Cuando los tapetes de corte comienzan a perder pegajosidad, ellos pueden ser lavados: 

 Utilice un detergente suave, agua tibia y un cepillo suave para limpiar la superficie. Usted no está 
tratando de restregar el pagamento solo está mojando las fibras invisibles que se han depositado por los 
cortes de los materiales para sacarlos del pegamento. 

 Enjuague bien, sacuda el exceso de agua y coloque el lado pegajoso hacia abajo sobre una toalla de 
baño.  

 Seque completamente el lado no pegajoso del tapete de corte con otra toalla.  

 Levante el tapete de corte y el lado pegajoso ahora debe estar lo suficientemente seco para usarse de 
inmediato. Pruébelo asegurándose de que el tapete de corte se pegará a su mano.  

 Mientras que el lavado con agua y jabón debería reactivar el pegamento original, usted puede agregar 
más pegamento si es necesario:  

 Prácticamente cualquier pegamento reposicionable puede ser utilizado en el tapete de corte. Algunas de 
las opciones populares incluyen: Krylon Easy Tack, Aleene’s Tack It Over and Over (diluído 1 parte 
pega: 2 partes agua) Crafter's Companion Stick and Spray, Zig 2 Way Glue con tapa ancha, Craft Smart 
Off 'N On (diluída también), y Scotch Repositionable Craft Stick. 

 Si estas cortando material más grueso, como “oil board” o estireno, entonces es posible que desee 
experimentar con un pegamento más fuerte y utilizar cinta adhesiva de pintor para asegurar el material 
al tapete de corte. Si está cortando algo fino como papel, entonces es posible que desee experimentar 
con un adhesivo ligero.   

http://knkusa.com/product/force-12-x-12-mat-red-grid/
http://knkusa.com/product/knk-force-mat-guides-left-right/
https://www.youtube.com/watch?v=anoUwS0OJwg&t=24s
https://www.youtube.com/watch?v=DJjhBLV_ql0&t=15s
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 Con la mayoría de los adhesivos reposiciónales, usted puede controlar la pegajosidad basado en la 
cantidad aplicada. Por lo tanto, siempre añada un poco a la vez. Como mencionado anteriormente, si se 
agrega demasiado pegamento, sólo añada una capa o dos de fibras de algodón presionando con una 
toalla de baño.  

• Otros métodos reportados para la limpieza del tapete de corte: 

 Utilice una espátula de plástico (una tarjeta de crédito vieja funcionará) para raspar cualquier residuo de 
material en el tapete de corte después de un corte.   

 Para partículas más finas de papel o pelusas, se puede usar un rodillo de pelusa. Arranque una hoja y 
luego presione hacia abajo y tire hacia arriba a través de la superficie del tapete de corte para limpiar en 
las secciones. Toallitas húmedas para bebés pueden realizar la misma tarea.  

 Para eliminar completamente el adhesivo del tapete, se aplica Goo Gone o removedor de pega “Duck 
Adhesive Remover” sobre la superficie. Permita un minuto en remojo y luego raspe con una espátula de 
metal afilado. Repita según sea necesario hasta que el tapete de corte esté completamente limpio y no 
pegajoso. Lave, seque y luego añada cualquier adhesivo que sea reposicionable.  

• Un problema conocido con los nuevos tapetes de corte KNK Force es la tinta roja impresa en el lado no 
pegajoso. La tinta comenzará a desaparecer y a adherirse a la parte superior de la mesa plegable, así 
como a la banda de corte. Para limpiarla, use Windex, Un- du, Goo Gone o incluso Ritz color Remover 
(gracias, Julie Flanagan!). Para evitar que la tinta manche la mesa, cubre la parte inferior del tapete de 
corte con papel transparente de contacto, cinta de transferencia de imitación de diamantes, o alguna otra 
hoja adhesiva transparente fina. 

• Cuando sea necesario, las ruedas de goma y los ejes se pueden limpiar con alcohol, o Un-Du. Mueva la 
rueda lejos del eje de granos, aplique el limpiador en un trapo limpio y sin pelusa y frote todo el eje de 

granos hasta que quede libre de adhesivo.  

 

 
1.11 Instalando las ruedas de presión  

 

 

• Las ruedas de presión deben estar previamente montadas. Si las palancas no están adjuntadas, siga las 
instrucciones en el Apéndice B1.  

• Para insertar los rodillos de presión en la Force: 

  Primero tire de la palanca hacia arriba para que la rueda de presión esté en la posición “arriba” cuando 

se inserte en la Force: 

 

 

 Luego, gire la Force alrededor de modo que estés de frente a la parte trasera de la cortadora.  

https://www.youtube.com/watch?v=E1fAG8hLiFQ
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 Coloque el conjunto de ruedas de presión en la Force de modo que este descanse sobre la placa 

inferior, en el lado izquierdo donde se encuentra la ranura. 

 

 

 Levante el conjunto de ruedas hacia arriba y luego lejos de usted (hacia la parte delantera de la 

cuchilla):  

 

 Luego deslice el conjunto hacia la derecha en la barra.   

Hueco adentro, entre 
el borde final y 
barandilla horizontal 
 

Ranura Horizontal en la 
que el conjunto de ruedas 
de presión se deslizará. 

Descanse el montaje en la 
parte izquierda, usted 
parado de frente a la parte 
trasera de la Force. 
 

Levante hacia arriba 
despegándolo de la 
mesa 
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 ¡Eso es todo!  Repita con las otras dos ruedas de presión. 

• Yo personalmente, recomiendo aplicar una pequeña cantidad de WD40 a la parte de arriba y la parte de 
debajo de la barra para que las ruedas de presión se deslicen más fácilmente. ¡No aplique el rociador 
WD40 en la barra directamente! En su lugar, rocíe una pequeña cantidad sobre un paño o toalla de papel y 
luego páselo a la barra para aplicarlo. Ahora debe poder deslizar más fácilmente las ruedas de presión 
hacia la izquierda y hacia la derecha. Si aún todavía tienes dificultad deslizándolas, trate de aplicar una 
pequeña cantidad de WD40 a las partes del ensamblaje de ruedas de presión que están en contacto 
directo con la barra. 

• Tenga en cuenta que cuando usted esté listo para usar la Force, las ruedas de presión tendrán que estar 
alineadas bajo los rectángulos grises para que estén ubicadas sobre los ejes de presión. Más información 

sobre esto está cubierta en la Sección 2.6.2. 
 
1.12 Otras Herramientas y Suministros Útiles 

 
• La siguiente lista tiene elementos que usted puede o puede no necesitar mientras disfruta de su Force. 

Estas son sugerencias basadas en diez años de recopilando información de propietarios de cortadoras: 
 

 Rodillo o Palo de masar: (1) para aplicar las pelusas de una toalla en un tapete de corte excesivamente  
pegajoso (2) para presionar uniformemente los materiales a un tapete de corte. 

 
 Toalla de baño vieja mullida: (1) para secar un tapete lavado (2) para aplicar una capa invisible de 

pelusa sobre un tapete excesivamente pegajoso. 
 

 Jabón para Lavar Platos: (1) para reponer un tapete de corte. 
 

 Cepillo Suave: (1) para suavemente eliminar los residuos durante el lavado de una estera. 
 

 Cuchillo de Paleta de artista: (1) para suavemente retirar de un tapete de corte las figuras cortadas (2) 
para raspar pequeños pedazos o residuos de un tapete de corte.  

 Cinta de Adhesiva Azul para pintor: (1) para poner alrededor de los bordes en materiales más gruesos 
que podrían deslizarse durante el corte. 

 Adhesivos Removible: (1) para añadir más adhesivo a un tapete de corte (la mayoría de cualquier 
marca o tipo pueden ser utilizados, siempre que sea removible. Cuando se utiliza un tipo de 
pegamento, diluir con agua en una proporción 2:3 pegamento a agua. 

Lezna o Perforador de papel (u otra herramienta con punta afilada): (1) para escoger o levantar un 
corte de prueba para verificar los resultados.  

Estabilizadores: un estabilizador es un material adhesivo que se aplica a la parte inferior del material 
que estas cortando para que un corte limpio sea logrado. El estabilizador trabaja en o en más de las 
siguientes formas: (1) proporciona un contacto más firme con el tapete de corte (2) proporciona una 
capa final que no necesita ser cortado si el estabilizador se eliminará después del corte (3) previene 
que algunos materiales ligeramente elásticos sean estirados por la cuchilla. Estabilizadores 

Deslice el 
ensamble en la 
barra. 



18 

 

recomendados para materiales específicos serán enumerados en las secciones relevantes del manual 
del usuario 

• Los siguientes ítems son recomendados cuando se usa la herramienta rotatoria KNK: 

 Caliper: (1) para medir el espesor de un material. Lo más probable esto no es algo que usted 
“necesita”, sino más bien una comodidad a la hora de determinar la mejor configuración basándose en 
las sugerencias de la tabla. A menudo usted puede encontrar el espesor en las etiquetas de empaque, 
pero en ocasiones es posible coger un material y no estar seguro si este es de 5 milésimas frente a 7 
milésimas de pulgada o 1/8" frente a 3/32". 

 Gafas de Seguridad: (1) para proteger sus ojos 

 Máscara contra el polvo: (1) para evitar la inhalación de partículas de polvo fino 

 Tapete de auto-regeneración: (1) aconsejable cuando corte materiales con la herramienta rotatoria 
KNK. 

 Cinta de pintor azul: (1) para poner alrededor de los bordes de materiales que podrían aflojarse durante 
el corte. 
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1.13 Resumen Capítulo 1 

 
1.3.1 Varias Cosas a Tomar en Cuenta: 
 

• La KNK Force es diferente a las otras cortadoras en el mundo del pasatiempo. Esta tiene control de eje Z: 

 Esto cambia la configuración utilizada por el corte: en lugar de un ajuste de presión, son ajustes de 
profundidad y más velocidades. 
 

 Múltiple pasada ahora significa que una cuchilla puede trabajar su trayectoria a través de un material 
en lugar de tratar de presionar a través del material desde el principio. Esto también es importante 
cuando se utiliza la herramienta rotatoria. 

 Es necesario utilizar el Porta Cuchilla de la Force (en comparación con otras marcas), ya que este 
contiene un gran resorte que contrarresta la fuerte presión hacia abajo. El porta cuchilla tiene un ajuste 
de tensión: utilice un número bajo para materiales más blandos, más delgados; un número mayor para 
materiales más densos más gruesos. Consulte la Sección 1.08.2. 

 La hoja está ahora totalmente expuesta ya que el corte es controlado por los ajustes de profundidad. 

 

• Nunca utilice ajustes extremos. Esto puede resultar en cuchillas rotas, tapetes de cortes perforados, y 
daños a la superficie de la Force. 

• Lea el Capítulo 1, Capítulo 2, y las Secciones 3.01-3.05 antes de cortar. El resto del manual puede ser 
usado como guía de referencia para temas específicos de interés. 

• Video de la Instalación de la Cuchilla:   Refiérase a la sección 1.08.  

• El tapete nuevo de la Force es demasiado pegajoso si usted está cortando productos de papel. Coloque 
una toalla de baño vieja pero limpia sobre la superficie del tapete y presione con un rodillo. Luego, tire hacia 
arriba. Debe sólo tomar unas pocas presiones para reducir considerablemente la pegajosidad, ya que 
diminutos (demasiado pequeño para ser visible) fibras de la toalla se añaden a la superficie. 

• Los tapetes de cortes pueden ser lavados y repuestas, según sea necesario. Referirse a la Sección 1.10.  

• Videos sobre Instalación de las Ruedas de Presión:   Refiérase a la Sección 1.11. 

• Si usted tiene preguntas acerca del uso de la Force, tal como ayuda cortando algún material en específico, 
únase a uno de los grupos de apoyo que se recomiendan en la Sección 1.04. El grupo Force Facebook es 
el más popular. 

• Si usted tiene algún problema mecánico con la Force, favor comunicarse con KNK USA al (800-268-3672) 
o comenzar un boleto de apoyo. 

  

https://www.facebook.com/groups/KNKForce/
http://knkusa.com/support-ticket-request/
https://www.youtube.com/watch?v=xK67zdUFRxc&t=3s
https://www.youtube.com/watch?v=E1fAG8hLiFQ&index=5&list=UUjMw4weVU6HGHF9PcBgwI-A
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Capítulo 2   Empezando 
 

 

 
2.01 Qué es C3? 

• La KNK Force viene con el programa de centro de mando (C3) instalado en la computadora dentro de la 
cortadora. Este manual del usuario actual se basa en la versión C3 0.5.29. 

• C3 es un programa para cortar que abrirá archivos .SVG ( Scalable Vector Graphics). Por lo tanto, para el 
diseño personalizado y modificación de archivos, usted tendrá que utilizar cualquier programa de vector 
que guarde o exporte formato .SVG. Los programas más comunes usados para crear archivos de corte son 
Make The Cut, Inkscape, Sure Cuts a Lot, KNK Studio, Adobe Illustrator y Corel Draw.  

• Hay muchos otros programas en el mercado, así como los programas de bordado y los programas de CAD. 
Antes de comprar cualquier Programa de diseño para usarlo con la Force, verifique que usted será capaz 
de exportar en formato .SVG Y que el formato abrirá y cortara desde C3.  

• Contacte KNK USA si usted necesita asistencia seleccionando un programa para diseñar o tratar archivos 
SVG desde otros programas no listados en este manual. Información adicional acerca de archivos .SVG es 
presentada en el Capítulo 4 y también en este blog posteada por Darrel Farris: http://cutterpunk.com/svg-
files-for-cutting-machines/. 

• Para acceder al programa C3, usted tendrá que elegir entre uno de los tres métodos de conexión 
disponibles con el fin de completar la configuración entre su computadora o dispositivo inteligente y la 
Force. Una dirección IP es asignada por su red durante la instalación. Anote esta dirección IP ya que la va 
a usar cada vez que abra el programa C3. Esa dirección se escribe en cualquier programa del navegador 
que se utiliza normalmente (Firefox, Safari, Google Chrome, etc). En este momento, Internet Explorer y 
Edge han tenido algunos problemas trabajando correctamente con C3. Por lo tanto, se recomienda que se 
use un programa de navegador alterno.  

• Usted usará la misma dirección IP a no ser que la conexión sea cambiada. Una vez que configure la 
conexión en uno de sus dispositivos (por ejemplo, el ordenador), usted entonces, puede acceder a la Force 
de otros dispositivos (por ejemplo, teléfonos inteligentes, tabletas, otra computadora) sin necesidad de 
repetir el procedimiento establecido. Entrando misma dirección IP en el navegador del dispositivo lanzará 
C3. 

• Cuando esté disponible una actualización para C3, usted verá una notificación pop-up cerca de la parte 
superior de la pantalla. Usted puede instalar estas actualizaciones descargando dentro de C3 o 
descargándolo y grabando la actualización como un archivo en su computadora. Detalles son proveídos en 
la Sección 4.03. 

• ¡IMPORTANTE! Cuidadosamente y Completamente siga las instrucciones en las siguientes secciones para 

asegurarse de que todo está configurado correctamente. 

 
2.02 Configurando la Force 

• ¡IMPORTANTE! Si su Force fue enviada antes de febrero 16, 2016 usted necesitará usar las instrucciones 
en el Apéndice B7.2 para configurar la Force. Una vez eso esté completado, usted puede entonces 
regresar y comenzar a leer la Sección 2.06.  

• Si usted está intentando volver a conectar (después de tener una conexión con éxito en el pasado) y que 

está viendo “knk_recovery” en la lista de redes disponibles, favor ver este video:  

http://cutterpunk.com/svg-files-for-cutting-machines/
http://cutterpunk.com/svg-files-for-cutting-machines/
https://www.youtube.com/watch?v=C9F2Q1W9VrQ
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2.02.1 Terminología 

• Algunos de los primeros propietarios de Force proporcionaron información sobre su desconocimiento de 
algunos de los términos utilizados en los procedimientos de configuración de la Force. Por lo tanto, una lista 
y explicación de los términos usados en esta sección se presentan en el Apéndice B7.1. Estas definiciones 

se han escrito específicamente con la conexión de la Force en la mente.  

 
2.02.2 Eligiendo el Modo de Conexión 

• Usted tiene tres opciones para conectar la Force a su computadora: Autónomo (ad hoc), Ethernet, o Wi-Fi. 

Revise la información en la siguiente tabla para entender las diferencian entre estas opciones:  

Opción Autónoma (Ad Hoc) Ethernet Inalámbrica (Wi-Fi)

Descripción Comunicación está 

directamente entre la 

computadora (o dispositivo 

inteligente) y la Force 

La Force está conectada a un 

router de red mediante un 

cable Ethernet

La Fuerza está conectada de 

forma inalámbrica a un router 

de red

Requerimientos (1) Adaptador Wi-Fi 

(preinstalado en la Force)

(1) Cable Ethernet (incluído) 

(2) Router de Red

(1) Cable Ethernet (incluído y 

solo necesario durante la 

instalación)

(2) Router de Red Inalámbrico

(3) Adaptador Wi-Fi  

(preinstalado en la Force)

Pros Fácil de instalar; se puede 

configurar en cualquier parte 

ya que no es necesario otro 

router

Conexión más fiable; la 

comunicación más rápida

La Force puede estar ubicada 

en cualquier lugar dentro del 

alcance del router 

Cons Equipo ahora está conectado 

a la Force, por lo que no hay 

acceso inalámbrico a Internet 

o a otros dispositivos 

inalámbricos.

La fuerza está conectado al 

router con un cable Ethernet 

de 6 pies a menos que un 

cable más largo es comprado

Requiere mas pasos para ser 

configurada

 

• Tenga en cuenta que la implementación de cualquiera de estas opciones no les impide cambiar a otro, 
según sea necesario. 
 

• Una cuarta opción está disponible mediante el cual se puede conectar, a través de Ethernet, de la Force a 

su ordenador, en lugar de a su router (enrutador). Favor referirse al Apéndice B8. 

 
2.02.3 Conectando y Accesando C3  

 
 
 
 
(1)   Coloque la Force sobre una superficie plana y resistente ubicada de acuerdo al modo que usted planea 

utilizar: 

¡IMPORTANTE! Siga el paso 2 debajo exactamente como se le 

indicó antes de encender su Force por primera vez. 
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 Ethernet: Coloque su Force, dentro de seis pies de su router. Conecte la Force a un puerto disponible 
en el router utilizando el cable Ethernet incluido. No retire el adaptador Wi-Fi. Este necesita permanecer 
en su lugar, incluso después de establecer una conexión Ethernet. 

 Wi-Fi: Coloque su Force, dentro de seis pies de su router. Conecte la Force a un puerto disponible en 
el router utilizando el cable Ethernet incluido.  Una vez la configuración de Wi-Fi es completada, el 
cable Ethernet puede ser removido y la Force relocalizada dentro del alcance de su router. 

 Ad Hoc: Coloque la Force de ~100 pies de su ordenador o dispositivo inteligente 

(2) ¡IMPORTANTE! Siga esta secuencia para conectar el adaptador AC/DC y el cable de corriente: 

 Conecte el adaptador AC/DC al lado derecho de la Force 

 Enchufe el cable de corriente al adaptador AC/DC. 

 Enchufe el otro extremo del cable de corriente a la toma de corriente o a la tira de corriente. 

(3) Para activar la Force, pulse el botón de encendido en la parte delantera. La luz de encendido se encenderá 
y el cortador se inicializará (el carro se moverá a la derecha de la cortadora). Usted notará una serie de 
luces intermitentes rápidas dentro de la Force, seguido por una serie de luces azules intermitentes más 
lentas. El programa de la computadora está siendo cargado y esto tomará unos 90 segundos.  

(4) Para apagar la Force, mantenga el botón de encendido hasta escuchar dos pitidos. Luego, la luz 
parpadeará ~ diez veces antes de que la máquina se apague. (Por ahora, no hay razón para apagar la 
máquina. Esto es mencionado solo para futuras referencia) 

(5) Antes de comenzar, cierre todas las aplicaciones innecesarias del ordenador o dispositivo inteligente. 
También es recomendable que desactive temporalmente el software antivirus y el firewall. 

(6) Los siguientes pasos se han escrito para un sistema operativo Windows 10 y para un sistema operativo 
Mac 10.9.4. Los pasos deben ser prácticamente idéntico para otras versiones. Nota: Si elige el modo 
Ethernet y sabes cómo acceder a su panel de administración del router, puede omitir los pasos 7 y 8. 
Necesitará saber cómo encontrar su lista de clientes del router para saber a qué IP ha sido asignada a su 
KNK Force. Con la Force en modo de luz estable y el cable conectado al router, debe ser capaz de usar 
esa dirección IP en la barra de direcciones de su navegador e iniciar C3 y continúe con el paso 9. 

(7) Con la luz en modo estable de la Force, localice y accese el icono del network para su computadora: 
 

 

   

     

(8) Usted verá KNK_Force como un dispositivo al que se puede conectar. Haz clic en eso 

En una PC: 

Click on the Network icon. 
(usually in lower right corner) 

On a PC: 

Click on the Network icon. 
(usually in upper right corner) 

On a Mac: 
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En una Mac: 

 

(9)  Una vez conectado, el navegador web predeterminado debería abrirse y C3 (Centro de Comando de la 

cortadora) será mostrado: 

 

• Si su buscador Web no aparece automáticamente, ábralo y escriba 10.0.0.1 en la barra de direcciones de 
su navegador. Ahora debería tener acceso a C3 y verá la pantalla anterior en el paso 9. Nota: 10.0.0.1 será 
siempre la dirección IP predeterminada de la KNK Force cuando en modo independiente. 

 

• Siga a una de las siguientes secciones para el modo de conexión que hayas elegido 

Presionar 

aquí: 
Luego Presionar 

Connect 

Presione sobre 

KNK_Force 
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2.03 Conexión Independiente (Stand-alone (Ad Hoc) Connection) 
 
2.03.1 Primera Vez Modo Independiente (Standalone Mode) 

 

• Después de completar los pasos descritos en la Sección 2.02.3 previa, usted ahora está listo para 
comenzar a utilizar su Force y puede proceder a la Sección 2.06. Sin embargo, favor leer el resto de esta 
sección, ya que contiene información que necesitará en algún momento. 
 

• Mientras esté en modo independiente con un equipo inalámbrico, usted ya no tendrá que estar conectado a 
la red normal a menos que usted está conectado a través de Ethernet. Por lo tanto, usted no tendrá acceso 
a Internet. Por otro lado, si su equipo está conectado a través de Ethernet a un router, entonces usted debe 
tener acceso a Internet usando esa conexión. 

 

• Para realizar futuras actualizaciones de C3, necesitará conectar la Force, ya sea por Ethernet o por Wi-Fi o 

descargue la actualización como un archivo instalable. Refierase a la Sección 4.03.3. 

 
2.03.2 Switching to Stand Alone Mode after Being in Another Mode 

 

• Apague la Force. Si usted tiene un cable de red conectado a la Force, remuévalo. 
 

• Encienda la Force y espere por la luz fija. Tenga en cuenta qué puerto se está utilizando para el adaptador 
Wi-Fi. Luego, retírelo y espere a que las luces se vuelven rojas. 

 

• Coloque el adaptador Wi-Fi de nuevo en la misma ranura y espere a que las luces se vuelven verdes. 

• Vaya a las conexiones de red inalámbricas de su ordenador: 
 

 Encuentra la conexión knk_force_recovery y haga clic en él. (Tenga en cuenta que puede tardar 
hasta 90 segundos o menos para que esta conexión aparezca en el menú). 

 
 Aparecerá una ventana que muestra la pantalla de configuración de C3. Si no es así, abra un 

navegador web que no sea de Microsoft y vaya a http://10.0.0.1. No cambie nada en esta ventana. 
 

 Haga clic en Try these settings. 
 

• Vuelva a las conexiones de red inalámbricas de su ordenador: 
 

 Espere de nuevo por knk_force_recovery ser listada. No seleccione knk_force, si esa opción aparece. 
 

 Si usted tuviera una página web abierta, esta eventualmente mostrará un Error de Servidor (Server 
Error) (página no encontrada). 
 

 Cuando knk_force_recovery aparezca, haga clic en ella (conéctese a ella). 
 

 Una vez conectada, una ventana debe mostrar que indica “conexión se realizó correctamente” 
(Connection Succeeded) y mostrará una dirección IP asignada de 10.0.0.1. Haga clic en el botón 
Save these settings and continue. 
 

• Una ventana le mostrará instrucciones para conectarse a su Wi-Fi regular y hacer clic en el enlace a 
http://10.0.0.1. No hagas esto. 
 

• En lugar de ello, espere ~ 60 segundos para que la red inalámbrica knk_force a aparezca. Si esta no 
aparece, reinicie su Force y esta debería aparecer después de la secuencia de inicio es completada y su 
Force muestre una luz blanca. 

 

http://10.0.0.1/
http://cutterpunk.com/knk-support/knk-force/knk-force-reset-network-settings/


25 

 

• Una vez conectada a la red inalámbrica knk_force, abra su navegador Web y vaya a http://10.0.0.1. C3 
debería mostrarse ahora. 

 

• Nota: En un ajuste con otros propietarios de Force (como un retiro KNK), se producirán conflictos de 
comunicación cuando los propietarios intenten configurar el modo independiente. Un propietario, a la vez, 
tendrá que encender su computadora y la Force, completar los pasos anteriores y luego, cambiar el nombre 
de su red inalámbrica antes de que comience la siguiente persona. Para cambiar el nombre de la red 
inalámbrica, cambie los valores en el campo “Network hostname” (es decir, Force-nuevo nombre) y en el 
campo “Wireless network name” (ESSID) (es decir, newname_force). 

 

 
2.04 Conexión Ethernet  

 

• Una vez C3 se ha cargado, haga clic en la pestaña “Status” en la parte superior de la pantalla. Desplácese 
a Wired (Ethernet) networking status y tome nota de la dirección IP. Esta es la dirección que usted 
utilizará para conectarse a C3 

 
 

• Con la conexión Ethernet, usted debería ser capaz de conectar con su Force usando otros dispositivos 
conectados a su router, como otra computadora u ordenador, teléfono inteligente o tableta. Usted sólo 

necesita escribir la dirección IP en una ventana del explorador en ese dispositivo. 

• ¡IMPORTANTE! En este momento, la Force necesita el adaptador Wi-Fi conectado, aun cuando esté 
conectado vía Ethernet. 

• Para actualizar a la última versión de C3, refiérase a la Seccion 4.03. 

• ¡Usted está listo para comenzar a usar C3! Por favor, vaya a la Sección 2.06. 

 
2.05 Conexión Wi-Fi  

 

• Si usted está intentando volver a conectar (después de haber tenido una conexión con éxito en el pasado) y 
usted está viendo "knk_recovery" en la lista de redes disponibles, por favor ver este video  

• Por favor lea la siguiente información IMPORTANTE cuidadosamente. Esta contiene los requisitos actuales 
para que la Force se conecte a su router exitosamente.   

 La red inalámbrica debe estar protegido con contraseña. Usted deberá saber el nombre de su red y la 
contraseña para el proceso de conexión. 
 

 Si su red está configurada para estar invisible, entonces usted probablemente necesitará seleccionar 
“otra red” en la lista del menú desplegable y escribir en esta. 
 

 Algunos dueños de dispositivo de modem/router combinado están teniendo problemas para ser 
conectados. Si usted no puede conseguir que las siguientes instrucciones trabajen, favor contacte KNK 
USA para asistencia. Usted puede iniciar un boleto para apoyo usando este enlace: 
http://knkusa.com/support/ o comuníquese al 800-268-3672.   

 

 

http://10.0.0.1/
http://knkusa.com/support/
https://www.youtube.com/watch?v=C9F2Q1W9VrQ
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2.05.1 Obteniendo la Dirección IP Wi-Fi  

(1) Haga clic en la pestaña “Status” estado en la parte superior de la pantalla. Desplácese a “Wired (Ethernet) 
network status” y anote la dirección IP. Usted necesitará usar esta dirección más adelante, así que puede 

que quieras anotarla: 

 

 

 

(2) Haga clic en la pestaña “Settings” en la parte superior de la pantalla y presione sobre Network Settings. 
Haga clic en la flecha hacia la derecha en el cuadro bajo redes inalámbricas (Wireless networking mode) 

y cámbiela de modo independiente (Standalone) a LAN. 

 

(3) Presione en Escanear por redes (Scan for networks) y seleccione el nombre de la red entre las opciones 
disponibles en el menú. Luego, introduzca la contraseña de la red inalámbrica y haga clic en “Apply 
changes”:  

 

(4) Introduzca la dirección IP Alambrada (Ethernet) en la barra de direcciones de su navegador y relanzar 
C3. 

(5) Haga clic en la pestaña “Status” en la parte superior de la pantalla. Desplácese hacia abajo a estado red 
inalámbrica Wi-Fi (Wireless (Wi-Fi) network status) y anote la dirección IP. Esta es la dirección que 
usted va a utilizar cuando se conecta a la Force usando la computadora inalámbrica o dispositivo 

inteligente: 

 

 

Ir a la sección Wired (Ethernet)  

Anote esta dirección IP 

Seleccione LAN aquí 

1. Presione aquí. 

2. Seleccione su red 4. Presione sobre Apply changes 

3. Entre la contraseña de 

su red 
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(6) La Force ahora se puede accesar de forma inalámbrica. Desconecte el cable Ethernet y escriba la 
dirección IP del paso 5 o apague la Force, desconecte el cable Ethernet y mueva la Force a la ubicación 
deseada dentro del alcance del router de la red. 

• Con la conexión Wi-Fi, usted debería ser capaz de conectarse con otros dispositivos conectados al router, 
tales como otra computadora u ordenador, teléfono inteligente o tableta. Sólo es necesario escribir la 
dirección IP en una ventana del explorador en ese dispositivo. 

• Para actualizar a la última versión de C3, refiérase a la Sección 4.03. 

 
2.05.2 Configurando un IP Estático 

El siguiente procedimiento es opcional si su red está configurada como una red DHCP (el cual es el tipo más 
popular de red doméstica). Ajustando un IP estático puede eliminar problemas de comunicación. La dirección 
IP no cambiará y la conexión tiende a ser un poco más rápida. 

(1) Haga clic en la pestaña “Status” y anote las cuatro configuraciones en la sección Wireless (Wi-Fi) Status: 

 

(2) Haga clic en la pestaña “Settings” y haga clic en Network settings. Desactive donde dice Automatic 

(DHCP) settings for wireless connection: 

 

 

 

(3) Esto espandirá esa sección: 

 

 

 

Escriba esta dirección IP 

Ir a la sección Wireless (Wi-Fi) 

Presione aquí para desactivar 
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(4) En la sección expandida, entre la dirección IP Inalámbrica, Wireless netmask, Wireless gateway y 

Wireless broadcast anotadas en el Paso 1: 

 

 

(5) Una vez completado, haga clic en Apply changes. Su KNK Force ahora permanecerá en la dirección IP 

que fue originalmente asignada por su router. 

 
2.06 Configuración para la Comunicación Probando y Dibujando  

 
2.06.1 Seleccionando el archivo de prueba  

• Usted necesitará un archivo .SVG para probar.  Usted puede utilizar el archivo existente que se 
encuentra en C3 una vez usted abre el programa. Alternativamente, por conveniencia, un archivo 
comprimido de figuras básicas en formato .SVG está disponible para descargarse desde aquí: 

http://www.iloveknk.com/FreeFiles/SVG/Force-Testing-and-Calibration-Files.zip. 

• Luego de grabar este archivo a su computadora, extraiga los archivos, recuerde donde los archivos 
están siendo grabados. 

• Para abrir los archivos, presione el botón Choose File al lado derecho: 

 

• Navegue el archivo conteniendo las Basic Shapes y seleccione una. Luego precione Open. 

Debería ahora estar OFF  

Entre los ajustes anotados en el paso 1 

Presione sobre Choose File 

  

http://www.iloveknk.com/FreeFiles/SVG/Force-Testing-and-Calibration-Files.zip
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• Una nueva pantalla indicará que el archivo está siendo leído. Luego un botón aparecerá para regresarlo a 

usted a la pantalla principal nuevamente: 

 

 

• La figura importada aparecerá ahora como una imagen miniatura al lado izquierdo de la pantalla. La 

dimensión de la figura importada será mostrada también: 

 

 
2.06.2 Preparando la Force para Dibujar 

• ¡IMPORTANTE! Asegúrese haber leído la Sección 1.10 antes de usar el tapete de para la Force incluido. 
Es extremadamente pegajoso y usted querrá reducir la pegajosidad antes de usarlo. 
 

• Presione una hoja de papel sobre el tapete, aproximadamente centrada de izquierda a derecha. Debido a 
que las ruedas de presión presionan tan fuertemente sobre el tapete de corte, el dibujo y el corte 
inconsistentes pueden ocurrir si el papel está debajo o inmediatamente junto a una rueda de presión. 

 

• Suba las palancas de las ruedas de presión en la parte trasera y deslice el tapete en la cortadora, 
alineando las líneas horizontales en el tapete cuadriculado con ranuras horizontales sobre la Force bajo el 
tapete. Asegúrese que las ruedas de presión estén alineadas bajo los rectángulos grises en la 
cortadora. Estas ubican las ruedas directamente sobre los ejes de grano bajo el tapete. Sin la alineación 
adecuada el tapete de corte está sujeto a sesgarse. 

 

Presione aquí después del archivo haber 

sido subido 

Seleccione cualquier 

archivo. 

  

Presione Open. 

  



30 

 

 

• Las ruedas de presión pueden deslizarse a la izquierda y a la derecha, según sea necesario. Una vez 
que queden debajo de los rectángulos, soltar las palancas. Tenga en cuenta que sólo dos ruedas 
deben ser utilizados para esta prueba o cuando corte la mayoría de los materiales. Usted puede dejar 
la rueda de presión central hacia arriba, si se desea, siempre y cuando la rueda del extremo izquierdo 

y extremo derecho estén ambas pinchando el tapete de corte: 

 

 

 

 Asegúrese que el bolígrafo de prueba va a escribir haciendo garabatos en el papel. En este momento no 

inserte la pluma en la Fuerza. 

 
2.06.3 Estableciendo el origen Z 

• ¡IMPORTANTE! El origen del eje Z establece una ubicación de referencia en el cual usted establece 
entonces profundidades para cortar, grabar, dibujar, etc. Este Debe hacerse cada vez que usted cambie el 
porta cuchilla o herramienta o, en algunos casos, el material. ¡Siga las instrucciones con cuidado! 

• Este origen se establece con la punta de la cuchilla (u otra herramienta) tocando la parte superior del tapete 
de corte O tocando la parte superior del material cuando el porta cuchilla está en la posición hacia abajo. 
¡IMPORTANTE!  para evitar daños a la herramienta, no inserte bolígrafo de prueba o el porta cuchilla en la 
Force hasta que se le indique! 

• Para la prueba de dibujo en el papel, el origen Z se establecerá en la parte superior del material. Pero 
habrá aplicaciones en las que el origen se establecerá con la punta de la herramienta en el tapete de corte. 
Utilice las siguientes pautas o guías para igual establecer el origen en la parte superior del tapete de corte o 
en la parte superior del material. Para obtener más información acerca de este tema, consulte el Apéndice 

B2. 

 

Las Ruedas deben estar 

centralizadas bajo los 

rectángulos grises.  

Siempre use las ruedas de presión del extremo derecho 

y extremo izquierdo con el tapete de corte 
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Aplicación Herramienta en uso Tapete Material
Se debe restablecer origen Z

cuando cambio el material?

Cortar un material sobre el Tapete Porta Cuchilla NO

Cortar un material sobre el Tapete Herramienta Rotatoria Sí

Grabar, Repujar, Dibujar Herramientas Accesorias sí

Perforar un material sobre el tapete Herramienta Perforadora No

Grabar Herramienta Rotatoria Sí
 

• Coloque una hoja de papel en el tapete de corte. No presione hacia abajo porque los tapetes están 
típicamente muy pegajosos cuando están nuevos. Alinear el papel en o cerca de la esquina inferior 

derecha: 

 

• Deslice el tapete en la Force, bajo las ruedas de presión. La esquina inferior derecha del papel debe estar 

bajo el asiento izquierdo del porta cuchilla. Luego baje las ruedas de presión: 

 

• Ahora usted está listo para insertar el bolígrafo de prueba. ¡IMPORTANTE! Utilice siempre el lado izquierdo 
cuando utilice una sola herramienta. Independientemente el uso de una herramienta sencilla o doble, el 
lado izquierdo es siempre la base de referencia para el origen XY. 

Observe la ubicación del 

Tapete de Corte en relación 

con la Force. 
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• En la parte inferior de la pantalla C3, haga clic en Replace Left Tool (Reemplazar herramienta de la 
Izquierda). El motor para la cabeza se encenderá y la cabeza se moverá a la izquierda. Aparecerá la 

siguiente instrucción: 

 
 

 
• ¡IMPORTANTE!: Si usted todavía tiene el porta cuchilla u otra herramienta instalada en el lado izquierdo, 

remuévalo. Luego presione Continúe (Continuar). El asiento del lado izquierdo del porta cuchilla bajará y 

aparece la siguiente instrucción: 

 

 

• Antes de insertar el bolígrafo de prueba en la Force, haga garabatos con él para asegurarse de que la tinta 
fluya. Luego inserte el bolígrafo de prueba en la Force. Puede ser que necesites aflojar los tornillos un poco 

en el asiento izquierdo para que el bolígrafo pueda ser insertado. Luego apriete ambos tornillos: 

 

• Tenga en cuenta que si estaba usando el porta cuchilla, en cuyo caso el origen Z se fuere a establecer 
sobre el tapete de corte, entonces usted debería deslizar el tapete hacia atrás para que el asiento del porta 
cuchilla esté sobre el margen frontal del tapete de corte. Luego inserte el porta cuchilla y apriete los 

tornillos: 

 

• Alternativamente, se pueden utilizar otras partes del tapete de corte. Es una elección personal. Sólo 
recuerde dejar caer las ruedas de presión antes de apretar los tornillos para que el tapete esté lo más plano 
posible. 

El Origen Z es configurado 

con la punta del bolígrafo 

tocando el material. 

Origen Z es establecido con 

la punta de la cuchilla 

tocando el tapete de corte. 

Si hay algo insertado en el 

lado izquierdo, remuévalo 

antes de presionar Continúe. 
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• Haga Clic en Continúe (continuar) y la cabeza ahora se moverá hacia el lado derecho y el ventilador o 
abanico de enfriamiento se apagará. Nuevamente presione Continue (continuar) para regresar a la 

pantalla principal C3. 

 
2.06.4 Introduciendo Ajustes  

• Debajo, la sección Pattern en la pantalla principal del C3 , está la Layer Section (Sección de capa). Aquí 
es donde los ajustes se introducen para dibujar, cortar, grabar, etc. Por ahora, sólo cambie la configuración 
para que coincidan con la siguiente captura de pantalla. Los detalles respecto a cada ajuste se cubren en la 

Sección 3.02. 

 

 
 

 
2.06.5 Configuración de los Origenes X y Y y Dibujo  

• Ahora que el archivo está importado, el bolígrafo de prueba está instalado, el origen Z establecido y los 
ajustes entrados, La Force está lista para llevar a cabo la prueba. El último paso antes de cortar es 
ajustar el origen XY, el cual aproximadamente corresponde a la esquina inferior derecha del recuadro 

de selección alrededor de la imagen en miniatura que usted ve en C3.  

 

• Haga clic en el siguiente botón debajo de Layer Settings: 

  

La siguiente pantalla aparece: 

Origen XY 
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• Haga clic en los iconos de dirección en la pantalla o presione en las flechas del teclado para mover la 
cabeza. Desplace el “Jog Distance” para cambiar el tamaño de paso de cada movimiento. Tome nota de 
los atajos disponibles de teclado que están disponibles. 

• Si usted tiene que cancelar y volver a la pantalla principal C3, haga clic en Cancel this job (Cancelar este 
trabajo) o pulse la tecla Esc del teclado.   

• Mueva la punta del bolígrafo a la esquina frontal derecha del papel sobre el tapete de corte. Una vez que el 
bolígrafo está en posición, haga clic en Cut job at current location (Cortar trabajo en la ubicación actual) o 

pulse la tecla Enter en el teclado. 

 

• La luz dentro de la Force se pondrá roja mientras que la información es transmitida y procesada. Luego la 
luz cambiará a blanco y la Force comenzará a dibujar la figura. Al final del proceso, la cabeza regresará a 
su origen. 

• Tenga en cuenta que antes de cada corte, se necesita fijar un origen XY a no ser que la herramienta sola 
pasa a estar ya en el lugar deseado. Además, el origen siempre es basado en la ubicación de la 
herramienta del lado izquierdo, incluso si sólo se está utilizando el lado derecho. 

• Para practicar, intente configurar el origen en una ubicación diferente en el papel de prueba. Antes de 

utilizar archivos que no sean las figuras básicas proveídas, usted tendrá que leer el capítulo 3.04. 

  

Haga clic en estos iconos de 

dirección para establecer el origen 

en la esquina inferior derecha del 

material. 

Presione aquí para 

iniciar el corte. 
Presione aquí para cancelar y 

regresar a la pantalla principal 

C3. 

Establece el origen en la 

esquina delantera derecha del 

papel 

Note los atajos 

opcionales 

Desplace para cambiar el tamaño de 

paso de cada empujoncito 
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2.07 Pantallas C3 y Configuración Miscelánea  

2.07.1 Pestañas C3 

Pestaña Corte (Cut) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sections 3.02.11 and 6.05 

 

 

Guarda el Archivo 

corriente con Ajustes: 

Sección 3.02.12 

 

 

Establece Origen Z: Sección 

2.06.3 

 

 

Accesa la Ventana de 

Corte: Sección 2.06.5 
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Pestaña “Status”  

  

 

 

 

Pestaña de Configuraciones “Settings” 

 

• “Automatically check for updates” debe ser dejados en la configuración actual mostrada. 

Presiones sobre la Pestaña Settings 

(Configuraciones) 

Nombre su Force: 

Sección 2.07.3 

 

Unidades Preferidas: 

Sección 2.07.2 

 

Tamaño Calibración: Sección 3.06 

 

Actualizar el Enlace: 

Sección 4.03 

 

Presione la pestaña 

Status  

 

Configuración de la 

Red: Secciones 2.04 y 

2.05 

 

Sizing resolución: Sección 3.06 
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• Debajo de la sección “Basic settings” está la sección de las configuraciones de la máquina 

“Machine settings”. Haga clic en él para abrir: 

 

 

Pestaña “Settings” > Ajustes de la Maquina (Machine Settings) 

 

 
 

 Profundidad por defecto y ajustes de velocidad: Sección 3.0211 
 Compensar (Offset) X y Compensar (Offset) Y para el ojo electrónico: Sección 6.02 
 Compensar (Offset) X y Compensar (Offset) Y para segunda herramienta: Sección 5.02 
 Altura de la Superficie: Sección 7.04.2 
 Compensar cuchillas Roja, Azul, y Amarilla: Sección 3.02.9 

 

• Bajo la sección “Machine settings”, Configuración de la máquina, está la sección Configuración de red, 

“Network settings”. Haga clic en ella para abrir: 

 

 
 
2.07.2 Seleccionando Unidades 

• Hay tres opciones para las unidades de C3: pulgadas, centímetros o milímetros. Haga clic en la 
pestaña "Settings” y seleccione la unidad de su elección en el menú desplegable para las Unidades. 
Haga clic en Apply Changes. 

• Las unidades que elija afectarán las dimensiones que se muestran para el patrón actual cargado en 
C3, así como los valores que usted introdujo para algunos parámetros, tales como Blade Offset y 

Closed Path Overcut. Consulte las Secciones 3.02.9 y 3.02.11. 

 

Clic aquí 

para abrir 

Configurac

iones de 

red: 

Sección 

2.05 

 

 

Presione aquí 

para abrir 
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2.07.3 Nombre su Force 

• ¡Usted puede elegir un nombre alternativo para KNK Force, si así lo prefiere! Haga clic en la pestaña 
Settings y escriba un nuevo nombre bajo Machine Name. Haga clic en Apply Changes.  

• Este nuevo nombre aparecerá en la esquina superior izquierda de la pantalla C3 y en la pestaña del 

navegador para C3.  

 
2.08 Repaso del Capítulo 2 

2.08.1 Cosas Misceláneas a Tener en Cuenta 

 
• Todas las pestañas y ajustes en C3 están presentadas en la Sección 2.07.1. Utilice estas capturas de 

pantalla para encontrar otras secciones en el manual del usuario con más información. 
 

• En este momento hay problemas con la exportación de archivos SVG de AI, por lo que no se recomienda 
comprar Illustrator hasta que estos problemas se hayan resuelto completamente. En su lugar, considere el 
uso de “Sure Cuts a Lot o Make The Cut para sus diseños. 

 

• Hay tres maneras para conectarse a la Force: Independiente (también conocido como Ad-hoc), Ethernet y 
Wi-Fi. Consulte la Sección 2.02.2 para obtener información sobre los pros y los contras de cada uno. 

 

• Después de conseguir configurar la Force, si necesita ayuda para cambiar de un modo a otro, ver este 

video:  

 
• Es recomendado configurar una dirección IP estática para evitar problemas con algunos routers (Sección 

2.05.2). 
 

• Unos conjuntos de formas básicas para pruebas pueden ser descargados desde aquí:   
http://cutterpunk.com/files/knk/BasicShapes.zip. 

 

• Siempre verifique que las ruedas de presión están centradas bajo las etiquetas rectangulares grises. De lo 
contrario el tapete no será bien fijada (Sección 2.06.2). 
 

• El Origen Z se debe restablecer cada vez que usted cambia la herramienta que está utilizando (Sección 
2.06.3). 

 

• El Origen XY debe establecerse antes de cada corte y siempre se basa en la ubicación de la punta de la 
herramienta del lado izquierdo. Por lo general, ese origen estará cerca de la esquina inferior derecha del 
material (Sección 2.06.5). 

 

• Únicamente utilice el lápiz de prueba hasta que haya leído las Secciones 3.1 a 3.5 

 
2.08.2 Quick Guide: Setting the Z Origin (Resumen de la Seccion 2.06.3) 

 
(1) Haz un clic sobre Replace Left Tool (o Replace Right Tool). 

 
(2) Remueva la herramienta a ser removida. Haga clic sobre Continue. 

 
(3) La cabeza se bajará. Inserte la herramienta. Si usted está utilizando un tapete de corte y utilizando el 

porta cuchilla o la herramienta de perforación, entonces la punta de la herramienta debería estar 
tocando el tapete de corte. De lo contrario, la punta de la herramienta debe tocar el material. 

 
(4) Apriete el tornillo frontal firmemente y haga clic en Continue. 

 

¡IMPORTANTE!: No use el porta-cuchilla para 

cortar hasta haber leído el Capítulo 3.01 – 3.05. 

 

http://cutterpunk.com/files/knk/BasicShapes.zip
https://www.youtube.com/watch?v=C9F2Q1W9VrQ
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Capítulo 3  Cortando 

 

 

 
3.01 Lo que Usted Necesita Entender Acerca de Cortar  

 
Usted Tiene que Cometer Errores 

 
• Propietarios exitosos son aquellos que: 

 No tienen miedos de cometer errores  

 Tienen paciencia con los errores   

 Encuentran por qué ellos cometieron esos errores  

 Intentan nuevamente, basados en información nueva  

• Cometiendo errores es que usted aprende más sobre los principios de corte. ¡Una vez que usted consigue 
ir más allá de los errores y tiene cortes exitosos, su confianza comienza a elevarse y estarás muy contento 
de ampliar su gama de proyectos! 

 
Comience con Materiales Fáciles y Figuras Fáciles  

• Usted no comienza su primera lección de conducir en la autopista. Probablemente comenzó a conducir 
en una granja o en un estacionamiento. Entonces usted progresó y comenzó a conducir en el barrio y 
otras calles de poco tráfico. Luego, comenzó a conducir en las calles principales. ¡Piense en cortar de 
la misma manera y no comience sus primeros cortes con materiales gruesos o archivos de corte con 
mucho detalle! En su lugar, empiece a cortar figuras básicas y materiales de bajo costo, como la 
cartulina de Wal-Mart, o simplemente retazos que tiene a mano. Trabaje los cortes más difíciles 
después de haber dominado los más fáciles 

 
Use La Cuchilla Correcta Según el Material a Cortar  

• Su KNK Force viene con una cuchilla de 45° (tapa roja) y una cuchilla de 60° (tapa azul). También se 
vende una Cuchilla opcional de 30° (tapa amarilla). Utilice lo siguiente como una guía para seleccionar 
la cuchilla apropiada para el material que esté cortando 

 La cuchilla de 45° (tapa roja) debe ser utilizada para cortar vinil, papel, cartulina, Dura-lar, Mylar, 
Transferencia de calor, Papel albanene. 

 La cuchilla de 60° (tapa azul) debe ser utilizada para cortar cartón, Grungeboard (es un material 
comprimido), fieltro, goma eva, y algunos de los materiales de las plantillas de la imitación de 
diamantes.  IMPORTANTE! Esta cuchilla es muy fragil! 

 La cuchilla de 30° para tela (tapa amarilla) debe ser usada para cortar todo tipo de tela y felpa. 

• Refiérase a las Secciones 1.08, 3.02.9, 3.02.11, y 3.03 para más información relacionada a las cuchillas de 
la KNK Force. 

 

Establezca el Origen Z Cuando sea Requerido 

 

• El Origen Z es un ajuste importante ya que este le dice a la cortadora en donde se encuentra la punta de 
la herramienta. El procedimiento se explica en la Sección 2.06.3. Como recordatorio: 

IMPORTANTE: La KNK Force es diferente 

a cualquier otra cortadora basadas en 

cuchillas en el mercado! Por favor, lea todo 

en el tópico 3.01 – 3.05 

https://www.youtube.com/watch?v=yxbLhgQ_a0I
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 El origen se establece con la punta de la herramienta en la parte superior del tapete cuando estés 
cortando o utilizando la herramienta de perforación. De lo contrario, el origen se establece con la 
punta en la parte superior del material. 

 Establezca el origen en el momento correcto (no un paso antes ni un paso después). Esto es lo que 

debe mostrarse en C3 en el momento de insertar la herramienta: 

 

 Debido a que el tapete es utilizado para ajustar el Origen Z cuando se corta, no es necesario reiniciar 
el origen al cambiar los materiales, siempre y cuando el soporte de la cuchilla permanece posicionado 
en el asiento de soporte de la cuchilla en la Force. 

 
Entienda los Ajustes de Corte  

• Hay ajustes recomendados para una amplia gama de materiales al final de este capítulo. Sin embargo, la 
calidad de un corte puede verse afectada si la cuchilla es nueva, la condición del tapete de corte, la 
humedad (la cual añade humedad a muchos materiales), y las cualidades del material incluyendo color, 
textura y consistencia. Por lo tanto, es muy importante saber qué ajuste(s) hacer con el fin de mejorar un 
corte.  

• Para controlar la cantidad de fuerza aplicada durante el corte con el porta cuchilla, dos ajustes se pueden 
hacer: Profundidad de Corte (Cutting Depth) (también llamado Profundidad Final (Ending Depth)) y la 
Tensión de la Cuchilla (Blade Tension). El Cutting Speed, Starting Depth, y el número de Pasadas 
(Passes) son también importante ajustar para algunos materiales. 

• En la sección 3.02, todos los ajustes se presentan en detalle. Al final de este capítulo hay ajustes 
recomendados. Cuando esté ajustando los parámetros, vaya aumentando en pequeños incrementos (~ 5 a 
la vez). Bajo ninguna circunstancia intente utilizar "valores extremos" para ver qué va a suceder. 

¡Realice Cortes de Prueba! 

• Tenga archivos disponibles para realizar cortes de prueba. No proceda con el corte hasta que el corte 
de prueba esté limpio. Cuando esté cortando figuras complicadas, una prueba de corte de una imagen 
complicada, tal como una letra o una parte pequeña de su patrón de imitación de diamante, podría ser 
un mejor indicador de la configuración correcta que una simple figura como un círculo o un cuadrado. 
Refiérase al Apéndice B6 para un procedimiento de diagrama de flujo para la prueba de corte con el 
porta cuchilla de la Force y el Apéndice B6 para un procedimiento similar utilizando la herramienta 
rotativa. Consulte la Sección 3.05 para un procedimiento paso a paso. 

 

 
Anote sus Éxitos 

• Cuando usted comience a tener cortes exitosos tome nota de la configuración utilizada. Hay un formulario 
en blanco al final de este capítulo que se puede imprimir y utilizar para registrar los resultados de sus 
cortes. Al final del capítulo 5 es un formulario en blanco para registrar sus resultados con el grabador, 
repujador Force, perforador, o sus propios marcadores, bolígrafos de pega, etc. El final del capítulo 7 es un 
formulario en blanco para registrar los resultados con la herramienta rotatoria. También hay ajustes 
sugeridos para una gama de materiales al final de esos mismos capítulos. Utilice estos como guías de 
partida, pero recuerde que sus resultados pueden variar basado en los muchos factores que pueden 
afectar un corte. 

• Usted puede enviar sus ajustes exitosos a este enlace: 

http://cutterpunk.com/knk-support/knk-force/knk-force-material-cut-settings/ 

• Usted puede ver ajustes de varios materiales y accesorios en este enlace: 

http://cutterpunk.com/knk-support/knk-force/knk-force-material-cut-settings/
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http://cutterpunk.com/knk-support/knk-force/user-submitted-cut-settings/ 

 

 

Mantenga el Tapete de Corte Limpio y Pegajoso 

• Materiales como el vinil tienen una lámina protectora que no es penetrado durante el corte. Estos 
materiales respaldados no necesitan ser colocados en el tapete de corte si al menos dos ruedas de presión 
pueden sujetarlos durante el corte. Sin embargo, si un material no tiene una hoja de respaldo (y la mayoría 
no), entonces el material debe ser estabilizado presionándolo sobre un tapete de corte pegajosa para 
cortar. 

• Siempre presione sus materiales uniformemente al tapete de corte. Considere usar un rodillo antes Y 
después del corte. Volver a presionar el material después del corte puede ayudar grandemente a limpiar los 
residuos o desperdicios de la figura cortada. 

• Cuando sea necesario, sujete al tapete de corte los materiales más gruesos con cinta adhesiva para evitar 
deslizamientos durante el corte. Pero recuerde que poniéndole cinta adhesiva a los bordes no es lo mismo 
cuando se está seguro que el material en su totalidad está presionado al tapete de corte 

• Si usted corta una variedad de materiales, usted podría necesitar más de un tapete de corte para que usted 
pueda tener un tapete de corte más pegajoso para ciertos materiales o tapetes de corte con menos 
adhesivo para otros materiales. Refiérase a la Sección 1.10. 

 

Sepa Dónde Sus Imágenes Cortarán 

• Practique con el bolígrafo de prueba hasta que sepa, con 100% de confianza, dónde se dibujarán sus 
imágenes. Esto es importante ya que usted no quiere estar adivinando cuando usted comience 
realmente a cortar con la cuchilla. Debido a que la ubicación del corte es basada siempre en donde las 
figuras fueron situadas en relación con el área del documento, usted necesitará entender mejor cómo 
esto es controlado en el programa originado. Consulte la Sección 3.04. 

• Cuando utilice solamente una herramienta, monte esta en el lado izquierdo porque el origen XY 
siempre es basado en el lado izquierdo, incluso si usted cambia la configuración de capa al lado 
derecho. 

 

¡No se Frustre, Busque Ayuda! 

• Además de tener su propio distribuidor KNK como la primera línea de contacto, hay muchos foros de 
usuarios, tablones de anuncios, grupos de Yahoo, etc. donde usted puede publicar preguntas y obtener 
respuestas de otros usuarios y distribuidor KNK. ¡Utilice estos recursos! Una lista recomendada fue 
presentada en la Sección 1.04   

 

• Favor seguir algunas “reglas de etiqueta” por respeto a aquellos que están dispuestos a ayudar. Esto 
ahorra tiempo y la publicación de soluciones incorrectas. Algunas guías sugeridas:  

 Diga el modelo de la cortadora, programa, y el Sistema operativo instalado en su computadora. 

 Describa el problema en detalle: 

o Un mal mensaje sería, “Mi cortadora no está cortando bien.”     

o Un mejor mensaje sería, “Estoy intentando cortar cartulina y estoy viendo muchos desgarres.” 
  

o El mejor mensaje sería, “Estoy tratando de cortar cartulina de 65 lb y estoy viendo muchos 
desgarres”. Mi Profundidad de corte (Cutting Depth) es de 85, mi Tensión de cuchilla (Blade 
Tensión) está configurada a 3, y mi Velocidad de Corte (Cutting Speed) es de 16. Estoy usando la 
cuchilla con tapa roja.” 

http://cutterpunk.com/knk-support/knk-force/user-submitted-cut-settings/
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 Postee fotos si es posible. Si la Force parece estar teniendo algún problema mecánico durante el corte 
o no se está comportando en una manera esperada, hacer un video rápido es altamente recomendado. 

 Regrese a verificar a menudo. Nada es más frustrante que estar ayudando a alguien y no escuchar 
nunca de esa persona otra vez. Incluso si usted consigue ayuda en otro lugar, o si usted encuentra el 
problema por usted mismo, es respetuoso publicar la solución encontrada. ¡Esta solución puede ayudar 
a otros en el futuro! 

 

 
3.02 Ajustes de Corte en C3 

• Bajo la sección Pattern (Patrones) está la sección Layer Settings (Ajustes de Capas). 

Dependiendo si las Pasadas (Passes) están ajustadas a 1 ó ajustadas a 2 ó más alto, las 

configuraciones disponibles serán ligeramente diferentes: 

Pasadas = 1: 

 
 

Pasadas = 2 o mayor: 

 
 

• Antes de presentar la configuración individual, tenga en cuenta que no existe configuración de fuerza ni 
presión. Debido al control del eje z, la fuerza se consigue mediante una combinación de dos parámetros: 
Cutting Depth (profundidad de corte) o Ending Depth (profundidad finalizando) (véase sección 3.02.2) y la 
Blade Tension (tensión de la cuchilla) en el porta cuchilla mismo (ver sección 3.03). 

• También, por el control del eje Z, usted puede hacer progresivamente incrementos en la profundidad en 
aplicaciones de múltiples pasadas, así como controlar la velocidad a lo largo del eje Z. Por lo tanto, hay 
nuevos ajustes para aprender y el resto de esta sección cubre cada uno de ellos. Pero recuerde que usted 
querrá verificar la tabla de configuración antes de tratar cualquier corte para asegurarse de que lo que esté 
usando parece estar de acuerdo con los materiales que usted está planeando cortar. 

 
 
3.02.1 Pasadas (P) 

• El ajuste de Pasadas, el cual puede ser ajustado de 1 a 20, controla el número de repeticiones en 
cualquier trayectoria individual antes de la cuchilla o herramienta se mueva a la siguiente trayectoria 
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• Esta es una característica importante en muchas aplicaciones ya que teniendo la cuchilla o la herramienta 
de trabajo su vía o camino a través de un material se obtiene un producto de mayor calidad. La cuchilla o 
herramienta también permanecerán en la posición hacia abajo durante las repeticiones, lo cual es mejor 
que la cuchilla o herramienta tenga que empezar de nuevo después de haber completado un proyecto en 
su totalidad 

• Algunos ejemplos donde más de una pasada es recomendada: 

 Cortando materiales más densos, más gruesos, tales como madera prensada, donde múltiples 
pasadas permite a la cuchilla progresivamente “tallar” a través del material.  

 Cortando materiales fibrosos, tales como tela, donde dos o más pasadas asegura que todas las fibras 
han sido cortadas limpiamente.  

 Cortando figuras complicadas o detalladas (como letras de títulos) desde ciertos materiales, como 
cartulina de textura fuerte, donde una pasada sencilla puede dejar ciertos puntos no cortados 
limpiamente.  

 Cortando material de plantillas para imitaciones de diamantes donde una segunda pasada resulta en 
una mejor limpieza de los círculos del corte.  

 Cortando o gravando con la herramienta rotativa para evitar sobre-cargar un poco y para lograr 
resultados más limpios. 

 

3.02.2 Profundidad de Corte / Profundidad Finalizando 

• Los ajustes de Profundidad son blancos u objetivos de ubicaciones en el eje Z para la herramienta intentar 
llegar, basado en el origen del eje Z siendo establecido a 0.  

• La Profundidad Corte solo aparece cuando las Pasadas (Passes) están establecidas a 1: 

 

• Cuando las Pasadas (Passes) están a 2 o Más, este mismo ajuste es llamado Ending Depth(ED) 
(Profundidad Finalizando): 

 

• Este ajuste es importante porque este controla cuán profundo la cuchilla intentará penetrar el material. Si 
este es ajustado demasiado bajo, el material no será cortado completamente. Si este es ajustado 
demasiado alto, la cuchilla cortará a través del material y del tapete de corte o el forro de un material como 
el vinil. Esto también causará desgarre en materiales como el papel y la cartulina. 

• Mientras parecería lógico que este ajuste sea simplemente el espesor del material, la resistencia del 
material (densidad), combinado con el hecho de que la cuchilla está siendo empujada por un resorte 
interno dentro del porta cuchilla de la Force, significa que un valor más alto es requerido. 

 

• Cuando se utiliza la herramienta giratoria para el corte, el CD/ED está directamente relacionada con el 
grosor del material, así como la altura donde se encuentra el origen Z. Más información sobre cómo 
determinar el CD/ED es presentada en las secciones 7.04 - 7.05. 

• Cuando esté grabando o repujando, el CD/ED es la profundidad a la que desea que la herramienta 
penetre el material. 

 
3.02.3 Profundidad Iniciando (Starting Depth) 

• Cuando usted está usando más de una pasada, los ajustes de la Profundidad Iniciando 
(Starting Depth (SD)) también aparecen: 
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• Esta es la profundidad objetivo para sólo el primer paso. Esta configuración puede ser la misma que la 
Profundidad Finalizando (Ending Depth) o esta puede ser más pequeña, el cual a menudo haga 
sentido al cortar materiales más gruesos. Teniendo el control del eje Z, combinado con la Profundidad 
Inicial (Starting Depth) y los ajustes de Profundidad Finalizando (Ending Depth) , permite a la cuchilla 
trabajar su trayectoria o su camino a través de materiales de capas más gruesas contra la forma 
habitual que las cortadoras trabajan (tratando de cortar a través de todo el material desde el inicio). 

• Un buen estimado para una profundidad inicial es dividir Ending Depth (Profundidad Final) por el 
número de Pasadas. Por ejemplo, si usted determina que un ED de 100 es necesario y usted va a 
utilizar 3 pasadas, entonces establezca SD a unos 33. 

• Si tres o más pasadas son seleccionadas y usted ha entrado una Profundidad Iniciando (Starting Depth) y 
una Profundidad Finalizando (Ending Depth) separada, entonces, después de la primera pasada, cada 
pasada subsecuente tendrá un incremento progresivamente a la profundidad objetivo basado en un cálculo 
lineal. Consulte el Apéndice B3 para obtener detalles sobre cómo la profundidad objetivo de cada pasada 
es calculada. 

• Los ajustes recomendados de profundidad y de pasadas están disponibles para una amplia gama de 
materiales y aplicaciones. Estos parámetros serán actualizados periódicamente a medida que más pruebas 
se vayan haciendo. Consulte la tabla al final de este capítulo 

• ¡IMPORTANTE! Con cualquier configuración recomendada, todavía usted debe realizar cortes de prueba 
utilizando figuras pequeñas o una parte de su proyecto para asegurarse de que los ajustes son suficientes 
para un gran corte. Muchos factores juegan en la eficacia de cuan bien un material corta incluyendo el 
embotamiento de la cuchilla, la condición del tapete de corte, la exposición del material a la humedad, y 
pequeñas diferencias en el establecimiento de la tensión en el porta cuchilla 

 
3.02.4 Velocidad Cortando 

 

• La velocidad de corte (Cutting Speed (CS)) es qué tan rápido viaja la cuchilla o la herramienta cuando esté 
en la posición baja. En la Force, el ajuste varía de 1 a 40, donde un valor de 40 representa el máximo de 
750 mm / sec.  

• Note la palabra "Default" (predeterminado) en la captura de pantalla. En C3, usted puede establecer 
valores predeterminados para los ajustes de profundidad y velocidad. Por supuesto, todavía se puede 
cambiar antes de un corte, pero, si por lo general usted siempre corta los mismos tipos de materiales, es 
útil tener estos ajustes puestos en valores predeterminados. Más sobre predeterminado serán cubiertos 
más adelante en este post. 

• Para los diseños pequeños y/o complejos, las velocidades más lentas son mejores. Una velocidad lenta es 
10 – 15. Una velocidad realmente lenta es menos de 10. Pero cuando corte diseños más grandes o 
sencillos con la cuchilla, velocidades rápidas deben funcionar bien, como ~ 25 - 30. Una velocidad de más 
de 35 es generalmente demasiado rápida para cortar, pero es útil cuando se utiliza un marcador o un lápiz 

• ¡IMPORTANTE! Cuando se utiliza la herramienta rotativa opcional, un corte a demasiada alta velocidad 
puede dañar la cortadora y/o herramienta rotatoria. Por lo tanto, cuando corte la mayoría de los materiales, 
el CS debe ser 10 o menos. 

 

 
3.02.5 Velocidad de Subida (US) 

 

 

• La velocidad Subida (Up Speed (US)) es cuán rápido la cuchilla o herramienta se desplaza en la posición 
arriba, moviéndose de un lugar a otro para comenzar a cortar. La gama de ajustes es de 1 a 40. 

• Para la mayoría de aplicaciones de corte, este ajuste puede ser muy alto, ~ 35 - 40. Sin embargo, para 
algunas aplicaciones, como una impresión y corte (PNC), el ajuste debe ser inferior, ~ 15 - 20, para obtener 
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la máxima precisión. Además, al utilizar la herramienta giratoria, que es un dispositivo mucho más pesado 
que el porta cuchilla, es conveniente mantener la velocidad arriba (Up Speed) en un ajuste más 
conservador. 

 

 
3.02.6 Velocidad de Inmersión (Plunge Speed (PS)) 

 

• La velocidad de Inmersión (Plunge Speed (PS)) es la rapidez con la que la cuchilla o herramienta baja 
desde la posición de arriba hasta la posición hacia abajo. La gama de ajustes es de 1 a 40 

• Cuando usted corte materiales suaves con una cuchilla, la velocidad de la inmersión (Plunge Speed) 
puede ser configurada bastante alto, por ejemplo 40. Si usted está cortando un material denso, como 
cartón grueso, utilizando una velocidad más baja de sumergirse, por ejemplo 20, puede ayudar a proteger 
la cuchilla de un impacto inicial demasiado fuerte con el material. 

• ¡IMPORTANTE! Cuando se utiliza la herramienta rotatoria, mantenga la velocidad de inmersión (Plunge 
Speed) aún más baja (- 5-10) para evitar dañar la herramienta al entrar en contacto con el material. Esto 
también permite tiempo para la herramienta cortar hacia abajo a una profundidad deseada antes de 
comenzar a lo largo de un camino. Consulte el Capítulo 7.03. 

 

 
3.02.7 Velocidad de Elevación (Lift Speed (LS)) 

 

• La velocidad de elevación (Lift Speed (LS)) es la rapidez con la cuchilla o herramienta se eleva desde la 
posición de abajo a la posición hacia arriba. Al igual que con los demás ajustes de la velocidad de corte, el 
rango es de 1 a 40. 

• Para las herramientas de peso ligero, como el soporte de la cuchilla, herramienta de repujado, bolígrafos, 
etc., esta velocidad se puede ajustar alto (~ 35 - 40). Cuando se utiliza una herramienta pesada, como la 
herramienta rotativa, es importante utilizar una velocidad lenta. Una vez más, consulte el Capítulo 7.03. 

 
3.02.8 Herramienta para Cortar (CT) 

• El ajuste de la Herramienta de Corte (CT) controla cuál de las dos cabezas se utiliza para la ejecución 
de esa capa. El valor predeterminado es el izquierdo, pero cuando el lado derecho es necesario, 
entonces presionando sobre la palabra Left cambiará la herramienta a Derecha: 

 

    

• Dado que el origen X, Y siempre se establece basado en la ubicación de la herramienta del lado 
izquierdo, es lógico utilizar la parte derecha sólo cuando ambas partes están en uso.  

 

 
3.02.9 Desviación de la Cuchilla (Blade Offset (BO)) 

 

 

• Comenzando con C3 0.5.8, el ajuste de desviación de la cuchilla (Offset) se convirtió en un menú 
desplegable donde usted selecciona el tipo de cuchilla o herramienta que se está utilizando. Este menú 
tiene cinco opciones: 

Haga clic aquí para cambiar a la derecha también 

http://cutterpunk.com/blade-offset/
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 None: cuando se utiliza un bolígrafo, herramienta para repujar, grabar, herramienta de 
perforación / punzón, herramienta rotativa, bolígrafo de pegamento. 

 Cuchilla de capa Roja, Azul, o Amarillo: seleccione basado en el color de la tapa de la 
cuchilla que está puesta en la Force. 

 Custome blade: para futuras cuchillas o herramientas que requieren un valor de 
desplazamiento de cuchilla especial. 

• Esta opción del menú está ligada a los valores numéricos que se introducen y se guardan en 
Settings>Machine Settings. Tenga en cuenta que los valores que se muestran a continuación se 
introdujeron en pulgadas porque era las unidades seleccionadas en bajo Basic Settings. 

 

• Antes de presentar los números a introducir para cada tipo de cuchilla, lea lo siguiente con el fin de 
entender lo que el ajuste de la Desviación de la Cuchilla (Blade Offset) representa. 

• Desviación de la cuchilla (Blade Offset (BO)) es la distancia horizontal desde el centro del eje de la cuchilla 
a la punta de la hoja. Una pluma, repujador, grabador, y una herramienta rotatoria todos tienen un 
desplazamiento de 0 debido a que la punta está centrada con el centro del eje de la 
pluma/grabador/herramienta. Pero una cuchilla es diferente:  

 

 

  

 

 

  

 

 

 

• Si usted establece el Desplazamiento de la Cuchilla a 0 al cortar con una cuchilla, las esquinas se 
redondearán. Si este es establecido demasiado alto, burbujas serán cortadas en las esquinas afiladas: 

 

  

 

 

 

 

• A continuación, se presentan las desviaciones de cuchilla (Blade Offsets) actuales a utilizar para cada uno 
de los tres tipos de cuchillas. Una vez más, introduzca este valor en Settings>Machine Settings y haga 
clic en Apply Changes. 

 Cuchilla tapa Roja: use 0.01 in (or 0.25 mm) (or 0.025 cm) 

Imagine una línea 

que pasa por el 

centro del 

bolígrafo de 

prueba o la 

cuchilla 

En una hoja, el desplazamiento es la 

distancia entre el centro del porta 

cuchilla y la punta de la cuchilla. 

Offset está demasiado bajo: 

esquinas están redondeadas 

Offset está muy alto: 

Burbujas aparecen en las esquinas 

No hay 

Desplazamiento en 

un bolígrafo. 
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 Cuchilla tapa Azul: use 0.014 in (or 0.35 mm) (or 0.035 cm) 

 Cuchilla tapa Amarilla: use 0.03 in (or 0.75 mm) (or 0.075 cm) 

• Cada vez que haya ordenado nuevas cuchillas, refiérase al empaque para el Blade Offset sugerido para 
esa cuchilla en particular. 

• No es inusual para una cuchilla ocasionalmente estar un poco fuera de especificación. Si usted necesita 
ajustar la desviación de la cuchilla (Blade Offset), intente aumentar o disminuir en incrementos de 0,02" (o 
0.5 mm o 0.05 cm). 

 
3.02.10 Dirección del Trazado (Path Direction) 

 
• Para cualquier capa dada, las direcciones de corte de todas las figuras de esa capa pueden ser revertidas.  

Por ejemplo: 
 Si una figura cerrada, tal como un círculo o un rectángulo, originalmente fue a cortar en sentido a las 

manecillas del reloj, entonces, invertir (Path Direction) la dirección de trazado dará lugar a un corte en 
sentido contrario a las manecillas del reloj. 
 

 Si una figura abierta, tal como una línea recta, originalmente iba a cortar de izquierda a derecha, 
entonces revertir la dirección (Path Direction) de trazado resultará en un corte de derecha a izquierda 

 
• Al hacer clic en la palabra normal invertirá la dirección de corte 

 

     
 

• Las secciones 4.02.1- 4.02.5, cada una cubre cómo identificar la dirección del trazado de figuras en los 
programas de vectores más comunes utilizados para diseñar archivos SVG. Con la excepción de Make the 
Cut, la dirección de la trayectoria puede programarse dentro de esos programas, si es preferido. 

 
 
3.02.11 Ruta Cerrada Sobre-corte (Closed-Path Overcut (CPO)) 

• Closed-Path Overcut (CPO) se encuentra bajo Advanced Settings: 

 

 

 

 

 

Haga Clic para revertir la dirección de corte 

Presione aquí para abrir 

Advanced Settings 
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• Trayectoria Cerrada Sobrecorte (Closed Path Overcut) está relacionada con la desviación de la 
cuchilla (Blade Offset) en que no es necesaria cuando se utiliza un bolígrafo, repujador, herramienta 
rotativa, y así sucesivamente, como la punta de esas herramientas están alineados con el centro de las 
propias herramientas. Sin embargo, si Camino Cerrado Sobrecorte (Closed Path Overcut) es dejado 
en 0 para un porta cuchilla, entonces trayectorias cerradas no serán cortadas completamente: 

 

 

 

 

• En general, el tipo de hoja no afectará el CPO requerido. Configúrelo a 0.04 pulgadas (o 1.0 mm o 0.1 cm). 
Para las figuras grandes redondas (como un círculo de 6"), aumente el CPO, según sea necesario, para 
asegurarse de que la figura cierre. Por ejemplo, trate 0.08" (o 2.0 mm o 0.2 cm) en su lugar. 
 

3.02.12 Optimizar el Orden de Corte (OCO) 

 
• Optimize Cut Order (Optimizar orden de corte) también se encuentra en Advanced settings 

(Configuración avanzada). Esta tiene dos opciones: 
 

 OFF: Las figuras se cortarán en el orden en que aparecen en el archivo SVG original 
 

 ON: Las figuras de una capa se clasificarán de acuerdo con lo cerca que esté el "punto de partida" de 
cada figura en la esquina inferior derecha (donde empieza el cabezal de corte). Esto no siempre será el 
orden más óptimo, y a menudo no será el punto más óptimo en la figura desde la cual empezar a 
cortar, pero este debería ser razonablemente óptimo, y hace una *gran* diferencia en los tiempos de 
corte para Trabajos complejos. 
 

• Si el archivo tiene figuras internas que deben cortarse antes de que las figuras que las rodean, establezca 
OCO en OFF. Si no hay figuras internas, se recomienda que el OCO esté en ON. 

 

 
3.02.13 Predeterminados 

• Valores predeterminados pueden establecerse en Settings>Machine Settings. Estos predeterminados 
entonces serán cargados automáticamente cada vez que un archivo nuevo es abierto. Por ahora, sólo haga 
cambios a los ajustes de profundidad y velocidad: 

 

Entre Closed-Path 

Overcut aquí 

Deje esta configuración Off. 

Todavía no está funcionando 

correctamente 

 

Para aplicaciones PNC, elija registro de capas 

aquí (Reg marks). Refiérase al Capítulo 6. 

Offset es muy bajo: trayectoria 

no cierra 
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• Después de entrar nuevos valores, presione Apply Changes (aplicar cambios) en la parte inferior. Cada 
vez que un nuevo archivo SVG es abierto, estos valores predeterminados son entonces cargados en Layer 

settings. 

 
3.02.14 Descargar un SVG Pre-establecido (Guardando un Archivo) 

 
• Si usted desea guardar las configuraciones usadas por un archivo en particular entonces, en la parte 

inferior de la pantalla principal, haga clic en Download an SVG Preset (Descargar un SVG preset). Usted 
entonces podrá guardar su SVG actual, junto con sus ajustes de corte, como un archivo Nuevo .SVG. 

Asegúrese de darle un nuevo nombre antes de guardarlo. 

 

 
 

 

 

 

 
3.03 Tensión de la Cuchilla (Blade Tension (BT)) 

• El interior del porta cuchilla KNK Force es un muelle largo que es comprimido a medida que usted gira la 
parte superior del porta cuchilla hacia la derecha y es aflojado a medida que gire la parte superior hacia la 
izquierda. Para materiales muy finos, como el vinil y papel fino, es necesario que la cuchilla esté "flotando" 
al cortar estos materiales, por lo tanto, se requiere una tensión muy baja. Para materiales densos más 
gruesos, como cartón madera, usted quiere una alta tensión para que se aplique más fuerza y la cuchilla se 
mantenga más rígidamente 

• Como cubierto en la Sección 1.08.2, hay una escala medible a lo largo del cilindro. La escala va de 1 a 6, 
donde 1 es la tensión más baja. En la tabla de ajustes recomendados, hay ajustes de tensión de cuchilla 
(Blade Tension) para utilizar con diversos materiales. 

• Las cuchillas sin filo necesitarán más fuerza que las cuchillas nuevas, por tanto, debes anticipar que 
necesitarás mayor tensión según vaya pasando la vida de la cuchilla.  

• Al cortar materiales puedan utilizar cualquier cuchilla, la cuchilla de 45 grados necesitará una tensión de 
cuchilla (Blade Tension) ligeramente superior a la cuchilla de 60 grados, debido al contacto adicional con 
el material a ser cortado. 

• Los materiales que absorben la humedad (como cartulina, papel, tela y madera aglomerada) pueden 
necesitar más tensión en la Cuchilla (Blade Tension) (y posiblemente más de una pasada) si han estado 
expuestos a la humedad. Un consejo es secar estos materiales con el soplador de pelo antes de cortar o 
ponerlos dentro de un horno caliente durante unos 15 minutos (precalentar el horno a la temperatura más 
baja y luego se apagará antes de poner los materiales de papel en el interior) 

 

 

Haga clic aquí para guardar el archive corriente con los ajustes de corte establecidos. 
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3.04 Controlando Donde las Imágenes Serán Cortadas 

 
3.04.1 Cortando Modo Retrato contra Paisaje  

• Por lo general hay dos orientaciones en un programa de corte: Retrato y Paisaje (Portrait and Landscape), 
Actualmente, C3 sólo corta en modo retrato (Portrait). Por lo tanto, la forma que usted ve en la pantalla en 
el programa de diseño, de izquierda a derecha, es la forma en que se va a cortar en C3 - de izquierda a 
derecha, cuando se para de frente a la Force. Tenga en cuenta que no importa si el programa de diseño 
original tiene un ajuste retrato o paisaje (Portrait or Landscape). Por lo tanto, si usted tiene un diseño que 
es más anch0 de 15", es necesario asegurarse de que está girado antes de exportar como SVG.  

• Por ejemplo, digamos que usted tiene una frase larga para la pared que será cortado en vinil y es 23" de 
ancho: 

 

 
 

 Si exportados en esta forma e importados en C3, el resultado es un archivo que será demasiado ancho 
para cortar en la 15" KNK Force:  

 

 
 

 

 Este archivo no se puede cortar en esta dirección. Hay que girarlo de manera que el lado 23" esté 
corriendo de arriba hacia abajo en la pantalla. Entonces, el archivo puede ser cortado: 

Figura es muy grande para 

cortarla en una 15” KNK 

Force 
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• Tenga en cuenta que la posibilidad de rotar las figuras antes de corte está en la Lista de Tareas Pendientes 
para C3, pero aún no está disponible.  

 
3.04.2 Modos de Corte (o Grabado, Repujado, etc) 

• Hay tres modos los cuales determinan donde la figura será cortada, dibujada, repujada, etc. 

 
Tool Modo:   

• En el modo de herramientas, no importa donde se encuentren las figuras en la pantalla; ellas cortarán 
donde usted configure el origen, es decir, donde se encuentra la punta de la herramienta exactamente 
antes de iniciar el corte. En otros programas de corte, este modo se llama Knife Point (Make The Cut), 
Origin Point (Sure Cuts A Lot) y Page mode (KNK Estudio). 

• Este modo es utilizado para la mayoría de corte regular y es especialmente útil cuando corte trozos. 

 
Modo Layout  

• En el modo de diseño (Layout), las figuras cortarán dónde se encuentren en la pantalla con respecto a un 
tapete de corte o área del documento. En otros programas de corte, este modo se llama modo WYSIWYG 
(Make the Cut y Sure Cuts A Lot) y Sign Blank (KNK Estudio). 

• Para utilizar este modo, los usuarios establecen un tapete de corte virtual y organizan figuras para que se 
corte a partir de material que se colocará en el mismo lugar en el tapete de corte real. Alternativamente, 
pueden establecer un área del documento que es idéntico o similar a las dimensiones del material que se 
cortará y luego acomodar sus figuras de acuerdo a eso. 

• Este modo es utilizado cuando usted necesita cortar figuras en lugares muy específicos (por ejemplo, en el 
centro de una hoja de papel 12 x 12 o centrada en el frente de una tarjeta de felicitación pre-cortada) 

Print and Cut mode: 

• En el modo de impresión y corte (PNC), un diseño es impreso con marcas de registro del programa de 
diseño. La impresión se coloca sobre el tapete de corte y la cámara de la Force es utilizada en la búsqueda 
de las marcas de registro para que las figuras sean cortadas de la hoja impresa. El Capítulo 6 es dedicado 
a PNC. 

Configurando los Modos: 

Ahora el ancho es menor de15” y el 

archivo puede ser cortado 

Rote la figura antes de exportarla. 

No hay necesidad de alterar el Tapete de Corte. 
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• En la actualidad, controlar si el corte será en modo de Diseño (Layout Mode) o en el modo de la 
Herramienta (Tool Mode) se realiza en un programa de diseño vectorial. Por lo tanto, si usted compra un 
archivo SVG o encuentra uno gratis, impórtelo al programa vector que usted estará utilizando para sus 
propios archivos para asegurarse de que las figuras están configuradas en el modo que prefiera para el 
corte. Luego, exporte el archivo como SVG para C3 para abrir y cortar. En la Sección 4.02, instrucciones 
para configurar los modos de corte son proporcionados para los más populares programas de diseño 
vectorial. 

 

 
3.04.3 Donde las Figuras Serán Cortadas 

 
Tool Mode 

• El material a cortar puede estar ubicado en cualquier parte en el tapete de corte: 

 

           

• Usted siempre establezca un origen XY antes de cortar. Este origen se encuentra normalmente en la 
esquina inferior/derecha frontal del material, sólo una pequeña distancia de los bordes exteriores. La punta 
del lado izquierdo de la herramienta es utilizada para la configuración de este origen. 

                

 

• La imagen miniatura en C3 indica donde la imagen será cortada respecto al origen que usted estableció en 
la Force. Por ejemplo:  

Configure el origen aquí 
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• Si usted tiene varias figuras, entonces esas figuras mantienen la misma distancia relativa aparte: 

     

 

• Si usted establece el origen en un área diferente, tal como en la “X” abajo, entonces las figuras serán 
alineadas con el nuevo origen. Por ejemplo: 

             

 

 

• Para ayudar a aclarar esto, observe el cuadro que rodea la imagen en miniatura. La esquina inferior 
derecha del cuadro aproxima a la posición del origen establecido: 

Configure el 

Nuevo origen 

aquí 

Las figuras cortarán en 

el área del nuevo 

origen. 

Las Figuras se cortarán en 

alineación con el origen. 
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Layout Mode 

• Dependiendo del programa que exporte el archivo SVG, usted puede encontrar una situación donde la 
figura del cuadro alrededor de la vista en miniatura es mucho más grande. 

• Por ejemplo, el archivo que se muestra en Tool mode fue exportado desde MTC. Pero si el mismo archivo 
fuese exportado de, por ejemplo, Sure Cuts a Lot, entonces el archivo podría verse así en C3 

 

• En este caso, el cuadro de vista en miniatura indica que el programa original tenía la capacidad para 
almacenar más información en el archivo SVG: específicamente, el tamaño del área del documento que se 
usó en el programa y donde las figuras fueron ubicadas en esa área del documento. La misma alineación 
ocurre en la que la esquina inferior derecha del cuadro de imágenes en miniatura alineará con el origen que 
es establecido. 

• El origen es nuevamente establecido en la esquina inferior derecha del material y las figuras serán cortadas 
en la ubicación indicada por la imagen miniatura:  

Esquina inferior derecha del 

cuadro de vista en miniatura  

Si este cuadro fuera 

dibujado, entonces la 

esquina inferior derecha 

alinearía con el origen que 

usted estableció. 

Esquina inferior derecho 

del cuadro de vista en 

miniatura 

Las Figuras no están ubicadas 

en la esquina inferior derecha. 
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• Si el programa original tiene el área del documento establecido como tamaño carta, entonces las 
dimensiones de los archivos SVG importados indicarán esto:  

 
 

• Lo mismo con A4: 

 
 

 

• Si el programa original tenía el área del documento creado para que coincida con las dimensiones del 
Tapete de Corte NKN Force, entonces el ancho y alto del patrón sería de 15" x 15" (ó 1'3" x 1'3"): 

 

Origen establecido 

aquí 

Las figuras son cortadas 

en la misma ubicación 

relativa a la esquina del 

cuadro delimitador en la 

imagen en miniatura.  

Dimensiones Carta 

Dimensiones A4 
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3.04.4 Cambiando Donde las Imágenes Serán Cortadas 

• Algunos programas vectores le permiten elegir, durante la exportación, cómo las figuras serán ubicadas en 
relación con el cuadro delimitador. En otras palabras, usted puede decidir si desea que el cuadro 
delimitador alrededor de las propias figuras o alrededor del área del documento que fue creado en el 
programa original. Esto será cubierto en la Sección 4.02 para diversos programas de vectores comunes, 
tales como Adobe Illustrator y Inkscape. 

• Para programas que no pueden exportar un SVG con información acerca de la ubicación de la figura (p. ej. 
Make The Cut), una rápida forma es agregar una pequeña figura, tal como una pequeña línea, en la 
esquina inferior derecha del tapete de corte virtual o al área del documento: 

 
 

• Incluyendo esa línea pequeña en la en la esquina inferior derecha (que coincide con la ubicación del origen 
de la Force), el cuadro delimitador se extiende ahora para incluir esa línea en el origen. El resultado es que 
las figuras se cortarán en el material en la misma ubicación que están colocados en el tapete de corte o 
plantilla en el programa MTC: 

 

Una pequeña línea es 

añadida en el origen 

Dimensiones Tapete Force 
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• Tenga en cuenta que la pequeña figura puede ser colocada en una capa separada en MTC y asignada a la 
derecha, de modo que no será cortada. Esto se explica en detalle en la Sección 4.02.1 

• Un método alternativo para lograr este mismo resultado es agregar un rectángulo o un cuadrado en MTC 
para que coincida con las dimensiones del material o las dimensiones del tapete de corte en sí. 

 Las figuras dentro de esta figura grande serán entonces cortadas basado en su ubicación relativa con 
la esquina inferior derecha de la figura grande.  

 Si usted utiliza las dimensiones del material para hacer tamaño del rectángulo, entonces establezca el 
origen el origen en la esquina inferior derecha del propio material. 

 Si usted utiliza las dimensiones del tapete de corte 15" x 15" de la Force para el tamaño del rectángulo, 
entonces establezca el origen en la esquina inferior derecha del tapete de corte cuadriculado. 

 Como con la pequeña línea o figura, el rectángulo o cuadrado añadido puede ser colocado en una capa 
separada y asignado al lado derecho para evitar que se corte. 

 
 
 
3.05 Realizando un Corte con el Porta Cuchilla 

(1) Presione el material en un tapete limpio y pegajoso (a no ser un material de rollo sea usado). 
 
 Más o menos centralice el material en el tapete (de izquierda a derecha) y use sólo dos ruedas 

externas. Un corte incoherente puede ocurrir si el portacuchillas corta demasiado cerca de una rueda 
de presión debido a que la rueda presiona el tapete y provoca un cambio en la profundidad del eje Z en 
esa ubicación 
 

 Mientras que utilizar sus manos debería trabajar bien, un rodillo ayuda a proveer una presión completa 
y uniforme. 
 

 Algunos materiales pueden requerir más o menos pegajosidad que otros. Refiérase devuelta a la 
Sección 1.10. 

 

 Algunos materiales pueden requerir cinta adhesiva a lo largo de los bordes exteriores para prevenir 
deslizamientos. Este seguro aun presionar la superficie completamente para estabilizarla 
completamente. 
 

Sin la pequeña línea o 
figura 

Con la pequeña línea o figura 
ubicada en la esquina inferior 
derecha 
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(2) Inserte el tapete (o el rollo de material) en la Force de manera que la mayoría del material (o el rollo de 
material) esté detrás de la cortadora. 

 
(3) Arregle el tapete de tal manera que las dos ruedas de presión exteriores ambas queden encima del mismo. 

 

 

 

 

(4) Verifique que las ruedas de presión estén alineadas bajo los rectángulos grises. 

 

(5) Ajuste la tensión de cuchilla (Blade Tension) en el porta cuchilla basado en el material a ser cortado. 
Refiérase a la tabla al final de este capítulo para recomendaciones de Ajustes de Tensión de Cuchilla 
(Blade Tension). 

Solo la parte baja del tapete 

debería estar en el frente de 

la cortadora. 

Siempre utilice la última rueda de presión de la izquierda y la 

última de la derecha con el tapete de corte. 

Las ruedas deberían estar 

centralizadas bajo los 

rectángulos grises. 
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(6) Haga clic sobre Replace left tool y siga las instrucciones en la pantalla. Ajuste el Origen Z con la punta de 
la cuchilla tocando el tope del tapete (o el tope del rollo de material). Refiérase devuelta, si es necesario, a 
la Sección 2.06.3. 

 

 

(7) Siempre es bueno hacer una prueba pequeña, pero asegurese que los ajustes son óptimos para el 
material. Así que abra una pequeña figura en C3. 
 

(8) Introduzca todos los ajustes de corte. Consulte la configuración recomendada al final de este capítulo. 

 
(9) Haga clic en Prepare the Cutting Job (Preparar el trabajo de corte). Establezca el origen XY en la esquina 

inferior derecha del material (o donde usted necesite el origen). 

        

 

(10)   Ejecute el corte. Retire la figura cortada. 
 

(11)   Utilice el diagrama de flujo en el Apéndice B5 para ajustar la configuración. 

(12)  Repita los cortes de prueba hasta que estén satisfechos con los ajustes de corte. Anote los ajustes 
antes de abrir el archivo del proyecto real a cortar. 

El Origen Z está establecido 

con la punta de cuchilla 

tocando el tapete. 

Establezca el origen XY 
en el material donde 
usted desea que la 
esquina inferior derecha 
de la imagen en 
miniatura se alinee. La esquina inferior 

derecha del cuadro de 
miniaturas se alineará 
con el origen XY 
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3.06 Calibrando el tamaño de Resolución de la Force 
 

• Cortadoras digitales pueden cortar figuras ligeramente fuera del tamaño de la figura en el programa. Por 
ejemplo, un cuadrado 8" x 8" podría cortarse 7-15/16" x 8-1/32". Ahora esto podría ser perfectamente 
aceptable para el tipo de corte que hagas. Por lo tanto, puede incluso no ser necesario realizar esta 
calibración. Sin embargo, si usted desea asegurarse de que sus figuras son cortadas, más precisamente, el 
siguiente procedimiento le permitirá calibrar su Force. 

• Vaya a Settings>Basic Settings. Los números actuales de calibración se enumeran bajo Wheel 
Resolution y Belt Resolution: 

 

 

• En la Sección 2.06.1, un enlace a un archivo comprimido de figuras básicas fue proporcionada. Dentro de 
esa carpeta de figuras hay uno llamado SizingCalibration. Abra este cuadrado de 10 pulgadas en C3 para 
usarlo para calibrar el tamaño. También puedes crear tu propio cuadrado a usar, pero asegúrese de que el 
tamaño sea al menos de 10 pulgadas para un resultado más exacto. 

• Use el bolígrafo de prueba o inserte un bolígrafo regular para dibujar el cuadrado. Después de dibujar, no 
retire el papel del tapete de corte porque es muy importante saber qué lado medir para la Resolución 
Rueda versus medir la Resolución Correa: 

 

 

• Mida el lado del cuadrado en la dirección arriba/abajo (usted de frente a la Force). En el ejemplo 
mostrado, el cuadrado fue 10-1/32" ó 10.031". Para ajustar la Resolución Rueda (Wheel Resolution), 
usted multiplica el valor actual (1.0) por el valor deseado (10,0") y lo divide por el valor real (10.031"): 

Wheel Resolution = 1.0 x 10.0 / 10.031 = 0.997 

• Introduzca el valor calculado en el campo de la Resolución Rueda (Wheel Resolution) en la ventana 
de Configuraciones Básicas (Basic Settings). 

• Luego, mida el lado del cuadrado en la dirección izquierda/derecha (usted de frente a la Force). En este 
ejemplo, el cuadrado fue de 9-7/8" o 9.875". Para ajustar la Resolución Correa (Belt Resolution), 
multiplique el valor actual (1.0) por el valor deseado (10,0") y divida por el valor real (9.875"): 

Resolución izquierda y 

derecha 

Resolución Arriba y 

Abajo 

Resolución Rueda 

Resolución Correa 
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Belt Resolution = 1.0 x 10.0 / 9.875 = 1.0127 

• Introduzca el valor calculado en el campo de la Resolución Correa (Belt Resolution) en la ventana 
Configuraciones Básicas (Basic Settings). 

Antes de salir de la ventana Configuraciones Básicas (Basic Settings), presione en Aplicar cambios (Apply 
Changes): 

 

 

• Ahora, repita el dibujo del cuadrado de 10" y vuelva a medir. Digamos que la medida arriba/abajo ya es 
perfecta. Esto significa que la Resolución Rueda (Wheel Resolution) puede ser dejada en 0,997. Pero 
luego, digamos que la medida de izquierda/derecha es ahora 10-3/32" o 10.094". Se aplica la misma 
fórmula aplicada: Resolución Correa (Belt Resolution) = valor actual (1.0127) por el valor deseado 
(10,0") dividido por el valor real (10.094"): 

Belt Resolution = 1.0127 x 10.0 / 10.094 = 1.003 

• Introduzca el nuevo valor en el campo de Resolución Correa (Belt Resolution) en Configuraciónes 
Básicas (Basic Settings) (junto con un nuevo valor Resolución Rueda si es necesario) y haga clic en 
Aplicar cambios (Apply Changes). Luego, prueba de nuevo. Usted podría necesitar un tercer ajuste, 
pero en la mayoría de los casos, el cuadrado se dibujará en 10" en ambos lados. 

 

 

 
3.07.2 Cosas a Tener en Cuenta 

 
• Usted tienes que cometer errores para aprender a cortar. 
 
• Comience con materiales sencillos y figuras fáciles. 
 
• Utilice la cuchilla correcta para el material que está cortando 
 
 Cuchilla Roja: materiales delgados, como papel, cartulina, vinilo, materiales de plástico fino e imán, HTV, 

pergamino, plástico mágico. 
 

 Cuchilla Azul: materiales gruesos, tales como tableros de aglomerado, goma para rhinestone, Goma eva, 
plástico más grueso y materiales de imán. ¡Utilice una velocidad de hundimiento inferior (20 o inferior) 
con la cuchilla azul! 

 
 

 Cuchilla amarilla: tela y fieltro 

 

• Ajuste el Origen Z cuando sea necesario.   

 

• Entienda los ajustes de corte - Consulte la Sección 3.02. 

Presione sobre Apply Changes 

Introduzca los valores nuevos 

(Summary of Section 3.01) 

https://www.youtube.com/watch?v=yxbLhgQ_a0I
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• Realice cortes de prueba! 
 
• Registre sus éxitos 
 

 Utilice el formulario al final de esta sección para registrar su propia configuración. 
 

 Usted puede enviar su configuración exitosa a este enlace: 

http://cutterpunk.com/knk-support/knk-force/knk-force-material-cut-settings/ 

 
 Usted puede ver la configuración de varios materiales y accesorios en este enlace: 

http://cutterpunk.com/knk-support/knk-force/user-submitted-cut-settings/ 
 

• Mantenga el tapete de corte limpio y pegajoso. Consulte la Sección 1.10. 
 

• Sepa dónde sus imágenes serán cortadas. Consulte la Sección 3.04. 
 

 Observe donde las figuras están localizadas en el cuadro delimitador alrededor de ellas. 
 

 La esquina inferior derecha de la imagen del patrón corresponde al lugar donde se ha configurado el 
origen XY: 
 

            
 
 
 

 
 

                             
 

 

 
 Controlar el lugar donde se cortarán las imágenes debe realizarse en el software de diseño antes de 

exportar. Consulte el Capítulo 4. 
 

Si esa caja fue 

dibujada, entonces la 

esquina inferior 

derecha ~ se alinearía 

con el origen que 

usted estableció. Esquina inferior 

derecho de la caja 

miniatura 

Las figuras son cortadas 

en la misma ubicación 

relativa a la esquina de la 

caja delimitadora en la 

imagen en miniatura.  

Esquina inferior 

derecho de la caja 

miniatura 

 

Si el origen es 

configurado aquí 

http://cutterpunk.com/knk-support/knk-force/knk-force-material-cut-settings/
http://cutterpunk.com/knk-support/knk-force/user-submitted-cut-settings/
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• ¡No te sientas frustrado, busca ayuda! Consulte la Sección 1.04  

 
3.07.3 Guía rápida: Realización de un corte con el soporte de la cuchilla 

 
(1) Presione el material a un tapete de corte limpio y pegajoso (a menos que un material enrollado sea 

utilizado). 
 

(2) Inserte el tapete (o material enrollado) a la Force que la mayor parte del tapete (o material enrollado) 
esté detrás de la cortadora. 
 

(3) Coloque el tapete de modo que las dos ruedas de presión externas estén sobre ella. 
 

(4) Verifique que las ruedas de presión estén alineadas bajo los rectángulos grises. 
 

(5) Ajuste Blade Tension (la tensión de la cuchilla) en el portacuchillas basado en el material a cortar. 

 
(6) Haga clic en Replace left tool (Reemplazar la herramienta de la izquierda) y siga las instrucciones de 

la pantalla. Ajuste Z Origin (Origen Z) con la punta de la cuchilla tocando la parte superior del tapete (o 
la parte superior del material enrollado). 
 

(7) Abra un archivo con una pequeña figura de prueba adecuada. 
 

(8) Introduzca todos los ajustes de corte. 
 

(9) Haga clic en Prepare the cutting job (Preparar el trabajo de corte). Establezca el Origen XY en la 
esquina inferior derecha del material (o donde necesite el origen). 
 

(10) Ejecute el corte. 
 

(11) Utilice el diagrama de flujo en el Apéndice B5 para ajustar la configuración. 
 

(12) Repita los cortes de prueba hasta que esté satisfecho con los ajustes de corte. Anote los ajustes antes 
de abrir el archivo del proyecto. 

 

 

 

  

(Summary of Section 3.05) 
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Formulario de configuración para el corte de materiales en la KNK Force1 

 

 

 

 

 

Formulario de Configuraciones Para Cortar Materiales con una Cuchilla en la 

KNK Force
Tipo Material y 

Grosor

Marca Material, 

Recurso, Color, etc
Cuchilla BT P SD CD/ED CS Otras Configuraciones y Comentarios

 
1 © 2009- 2016 Sandy McCauley, All Rights Reserved 

     

 

BT – Blade Tension; P – Passes; SD – Start Depth; CD/ED: Cut Depth/End Depth; CS – Cut Speed 

 

 



65 

 

 
Ajustes Sugeridos para el Corte de Varios Tipos de Materiales en KNK Force1 

 

 

 

 
        

      

 
 

Materiales Color(s) Probado
Tipo de 

Cuchilla
BT P SD

CD / 

ED
CS Otros Comentarios

Acetato - 5 mil Grafix Transparente R 2 1 40 25

Aluminio 36 gauge Aluminio R 2.5 3 15 35 15
PS = 25; Si no está bien adherido al tapete de 

corte, se recogerá el aluminio en las esquinas

Papel Arte - Borden & Riley #234 Papel 

Paris para Bolígrafos
Blanco R 2.5 1 90 25 Excelente papel para Imprimir y  cortar

Cera de Velas Plateado R 1 1 12 15
Hojas de cera de la marca Stockmar, distribuidor 

U.S. aToy Garden.com

Cartulina ~ 90 lb

Marca X; azul, negra, 

ambas con forro trasero 

blanco; 

R 2.5 2 90 25

Este papel tiene uns tex tura w affle en la parte 

superior, similar a CutMates, pero lev emente 

más gruesa y  nítida. Ex celente para tarjetas 

desplegables, etc. cualquier proy ecto que 

necesita resaltar.

Cartulina - Texturada AC 80lb Rosado Subido R 2 2 70 25

Tiende a desgarrarse en las esquinas, por lo que 

2 pasadas en ED 70 limpio que 1 pasada en 

may ores CD

Cartulina - Bazzill Linen Roja R 1.5 1 70 40

Cartulina - Core'dinations Black Magic Amarilla B 3.5 1 55 25

Lo pintado hacia abajo en el Tapete. Esto ev ita la 

descamación en las esquinas, ya que es una 

capa muy delgada.

Cartulina - DCWV Metalica Violeta R 3 1 90 25

Cartulina - Georgia Pacific - 110lb Blanca R 1.5-2 1 60 - 70 25-30

Cartulina- Georgia Pacific - 

110lb/199gm2
Blanca R 2 1 70 25

Cartulina -  Georgia Pacific- Image Plus 

110lb
Blanca R 2 1 90 25

Cartulina - K&Company Designer Paper Ancestry .com R 2.5 2 80 30

Cartulina - My Mind's Eye Designer My Girl R 2.5 1 90 25

Cartulina - Neenah 65lb Blanco R 2 1 60 25

Cartulina - Neenah 80lb Solar White; suave R 2 2 50 25
2 pasadas a baja CD da un corte más limpio 

que 1 pasada a CD más alto.

Cartulina - Neenah Classic Linen 80 lb 

Cover 216 g/m2
Solar White R 2 1 90 25

Papel favorito en todos los tiempos, siendo 

usado y cortado desde principios de 1998 (a 

mano primero)  

Estos ajustes sugeridos son para propósitos de corte inicial de prueba. Otros factores pueden influir en los ajustes tales 

como el embotamiento de la cuchilla, la condición del tapete de corte, la exposición a la humedad, el tinte de color, etc. 

ajuste la configuración, según sea necesario. 

 

BT –Tensión Cuchilla; P – Pasadas; SD – Profundidad Inicial; CD/ED: Profundidad Corte/Profundidad Final; CS – 

Velocidad Corte 

 

A menos que se indique lo contrario en Comentarios - Up Speed = 40, Lift Speed = 40; Plunge Speed = 40; Blade 

Offset y Closed Path Overcut = recomendaciones en las Secciones 3.02.9 and 3.02.10 
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Materiales Color(es) Probados
Tipo 

Cuchilla
BT P SD

CD / 

ED
CS Otros Comentarios

Cartulina - Prismatics 85lb Luz azul náutica bazzil R 2 1 90 25

Cartulina - Recollections 65 lb Negro R 2 1 60 25

Cartulina - Recollections Printed 

Cardstock
Cupcake Cuties R 2.5 1 90 25

Cartulina - Stampin Up Rojo Real R 2.5 2 70 30

Cartulina - Worldwin Cutmates Candied Violets R 2 1 60 25

Cartulina - Worldwin Doublemates 90lb Marrón, Roja R 2 1 70 40

Cartulina - Worldwin Doublemates 90lb Oro R 3 1 90 25

Cardstock - Worldwin Smooth & Silky Pistachio R 2 2 50 25
2 pasadas a un CD bajito corta más limpio que 

una pasada a un CD más alto.

Cartulina - Worldwin Smooth & Silky Light Pretty  Pink R 2.5 1 90 25

Inicia y  detiene puntos v isibles con la inmersión 

en 40, la velocidad y la profundidad de corte en 

80. Disminuyó la velocidad de inmersión a 30, e 

incrementó profundidad a 90 hizo un corte 

perfecto

Cardstock - Worldwin Treasures Heirloom Dark 90# R 3 1 70 25

Cartón - 0.02" Caja Cereal
Caja Cereal Corn 

Chex 
R 3 2 100 110 15

Lado impreso hacia abajo: pegado al tapete con 

cinta azul de pintor; configuración del origen del 

eje Z  basa en el tapete

Cartón  - 0.02" Caja Cereal Caja de Galletas B 2 1 120 15 Lado impreso hacia abajo

Cartón  - 0.02" Caja Cereal
NesQuick Tamaño 

Familiar
B 4 1 125 25 Lado impreso hacia arriba

Cartón  - 0.02" Blanco B 3 2 130 170 20 Lado Blanco hacia abajo

Cartón - 0.03" B 2.5 1 120 140 25

Traté con la cuchilla capa roja- requirió dos 

pasadas y BT 4; tuvo esquinas exteriores 

ásperas. La cuchilla azul cortó bello.

Cartón  - 0.055" - negro Negro B 4 4 25 120 15

Capaz de cortar figuras simples con estos 

ajustes. El Material quiere "dictar" la dirección 

de la cuchilla al cortar objetos con mayor detalle.

Papel Contacto Blanco R 1 1 12 25 PS = 25 

Papel - Copia/Impresor Georgia Pacific 

20lb
Rojo R 1 1 70 40
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Materiales Color(es) Probados
Tipo 

Cuchilla
BT P SD

CD / 

ED
CS Otros Comentarios

Foamy - 0.07" Anaranjado B 1 1 40 25
Usó un BO 0f 0.002 debido al grosor del 

material.

Plastico Artesanal 0.040" PET-G Transparente B 4.5 5 85 125 25

Hojas adhesivas de doble cara - 

Sookwang
R 2 2 5 25

Atravesó la hoja de respaldo blanco y el 

adhesivo, dejando intacta la lámina protectora de 

color marrón.

Hojas adhesivas de doble cara - 

Sookwang
R 2 2 5 25 25

Cortó atraves de ambas hojas superior e inferior 

y  el adhesivo.

Duck Tape Mustache R 2 1 70 25

Tela - Algodón (quilting) Blanco (Kona) F 2.5 2 10 25

Tela - Denim F 3 2 15 25 Stonewash, Peso medio, Tapete bien pegajoso

Tela - Twill F 2.5 2 15 25

Hoja de espuma - 1mm CraftersSquare - azul R 2 2 50 70 25

Papel de aluminio Your Story R 2 1 20 25 Lado de color hacia abajo

Tablero de aluminio, Grafix  Brand
Rojo, Azul, Verde, Oro, 

Plata
R 2 1 90 30 Lado de color hacia arriba

Papel brilloso (chipboard wt) American Crafts R 5 2 70 90 20 PS = 20

Grungepaper, Tim Holtz Brand R 2.5 2 40 50 25
Con estas configuraciones - marcó un poco el 

tapete pero no lo cortó

HTV-DecoSparkle Spectrum R 1 2 40 30

HTV-Glitterflex Ultra- on the mat Plateado R 1.75 1 70 25 Cortó bello!

Iron-On Foil Sheets, Jean Trix ; June 

Tailor Brand
Plateado R 3 1 60 25

Similar al estilo de HTV pero está supuesto 

"cortar" con tijeras y  luego adherirlo; estos 

valores "cortrán através"

Iron-On Glitter Sheets, Jean Trix ; June 

Tailor Brand
Teal, Oro R 4 2 160 180 30

Similar al estilo de HTV pero está supuesto 

"cortar" con tijeras y  luego adherirlo; estos 

valores "cortrán através"

Iron-On Hologram Sheets, Jean Trix ; 

June Tailor Brand
Rojo, Plateado R 2.5 1 115 30

Similar al estilo de HTV pero está supuesto 

"cortar" con tijeras y  luego adherirlo; estos 

valores "cortrán através"

Bolsa Laminadora Your Story R 2 1 20 25 No Calentada

Cuero - Artificial Blanco F 2.5 2 15 25 corta como mantequilla!
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Materiales Color(es) Probados
Tipo 

Cuchilla
BT P SD

CD / 

ED
CS Otros Comentarios

Magneto - 0.035" Respaldo Pegajoso B 4 2 130 140 25 Magneto para arriba

Cubierta Magnética Respiradero 

(Magnetic Vent Cover) - 0.22mm
Home Depot R 3 2 70 120 20

Cubierta Magnética Respiradero con 

cartón - 0.66mm

Dollar Tree ("as seen 

on TV")
R 5 4 70 110 20 Lado Negro (magnetico) hacia abajo PS = 20

Lamina Metálica, Peso liv iano, Respaldo 

Pegajoso - Grafix  Brand
Oro, Plateado R 1 1 50 15

Película metálica muy fina con respaldo de 

tarjeta; esto corta la lamina pero no el respaldo

Mylar - 0.010" transparente Transparente R 4.5 3 50 65 25

Oil Board Beige R 2.5 2 90 25
No cortó através en una sola pasada, corté 

nuevamente y  cortó perfecto! 

Papel - Estampado - heavy wt Pads de Michaels R 2 1 70 25

Hojas Plasticas, Clear-Lay Colores 

Translúcidos; Grafix  Brand

Rojo, Azul, Verde, 

Amarillo
R 2 1 80 30

Paquete con v idrieras de colores y  hojas de 

plástico Transluecent Clear-Lay

Cartulina Gruesa Anaranjado B 2 1 95 25

Poster board puede v ariar en grosor por poca 

cosa. Espere v ariaciones en Configuraciones y  

2 pasadas a menudo serán recomendables.

Rhinestone-Hartco 425-sobre el Tapete Verde B 3 2 50 25

Remov í hoja antes de cortarlo-presionado el lado 

pegajoso con el lado pegajoso del tapete. Limpió 

fácilmente.

Rhinestone- Hartco 425 - sin Tapete Verde B 3 2 80 25

Corte Limpio; ligeras líneas en la hoja, deshecho 

removieron bien cuando se presionó al Tapete 

Pegajoso.

Rhinestone-Rock It- sobre el Tapete Azul B 2 2 50 25
Removed sheet before cutting - pressed sticky 

side to sticky mat. Weeded easily

Rhinestone-Rock It- sin Tapete Azul B 3 2 60 25
Tiny lines in the backing sheet but circles were 

perfectly  round and pattern weeded easily

Shrinky Dink - Frost Escarcha R 2 2 45 55 40

Stained Glass Plastic Sheets, Grafix  

.010" thick
Vidrio de Colores R 2 2 90 30

Paquete con Vidrio de Colores y  Clear-Lay 

Hojas Plásticas Colores Translucentes

Stencil Board B 3.5 1 60 30

Sticky Flock - sobre el Tapete de Corte B 2 2 40 25 Quitar el papel forro; presionar sobre el Tapete

Estireno - 0.03" sign blank Verde y Rosado R 3.5 3 120 160 30

Este corta a trav es de los medios y  le permiten 

entonces "Pulsar y  Lev antar" lo cortado. Es del 

grupo Hillman y  lo v enden en Low es en letreros 

en blancos.

Tyvek mailer Blanco R 2 1 80 25

Papel Albanene Translucente R 2 1 20 25

Papel Albanene - Core'dinations 0.005" Translucente R 2 1 20 30
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Materiales Color(s) Probado
Tipo de 

Cuchilla
BT P SD

CD / 

ED
CS Otros Comentarios

Papel Albanene - 0.003"- Worldwind Grape (Violeta) R 2 1 20 25

Papel Albanene - 0.0035 Lt. Yellow R 2 1 20 30

Papel Albanene - 0.004" Verde Azulado R 2 1 25 25

Papel Albanene  - 0.004" - The Paper 

Company
Translucente R 2 1 25 25

Papel Albanene - 0.006" Translucente R 3 1 45 25

Vinil - Decal - sobre el Tapete Genérico - Negro R 2 1 30 25

Vinil - Decal - sobre el Tapete Mactac red R 1 1 20 25

Vinil - Decal - sin tapete de corte Mactac rojo R 1 1 15 25

Vinil - Grafix  Cling Viny l Transparente R 1 2 10 25 PS = 30

Vinil - Intermedio Pared sin Tapete - 

directo desde el rollo

Oracal 651 - v er 

comentarios para 

colores

R 1 1 15 25

Retazos sobre el Tapete de Corte KNK. Colores 

probados: Blanco, Anaranjado, Verde claro, 

Verde Obscuro, Azul Real, Negro

Vinil - Intermedio Cal Pared con el 

Tapete

Oracal 651 - v er 

comentarios para 

colores

R 1 1 10 25

Directo desde un rollo. Colores probados: 

Blanco, Anaranjado, Verde claro, Azul real, 

Negro

Vinil - Imprimible - sobre el Tapete blanco, imprimible R 1 1 25 25

Vinil - Imprimible - sin el Tapete blanco, imprimible R 1 1 25 25

Vinil - Pared - sobre el Tapete Oracal 631 - azul R 1 1 15 25

Vinil - Pared - sobre el Tapete Oracal 631 - Marrón R 2 1 20 25

Vinil - Pared - Sobre el Tapete Oracal 631 - Verde R 1 1 15 25

Vinil - Pared - Sin Tapete de Corte Oracal 631 - Marrón R 2 1 18 25

Vinil - Pared - sin el Tapete de Corte amarillo R 1 1 25 25 Cortó diseño complicado bien limpio 

 
 

 

 

  



70 

 

Capítulo 4  Más Acerca C3 
 
 
 
 
4.01 Importando Archivos .SVG 

 
 

• Como se ha mencionado en la sección 2.01, C3 abre archivos .SVG desde programas de diseño vectorial. 
Adobe Illustrator, Corel Draw, e Inkscape son generalmente usados para crear gráficos para impresión o en 
pantalla. Make The Cut y Sure Cuts A Lot son programas Vectoriales que crean archivos simples para 
propósitos de corte. Ellos se deshacen de "cosas extrañas" que a menudo se presentan en archivos SVG, 
dejando así, únicamente las rutas de corte. De esa manera, los programas visuales a veces necesitan 
algún trabajo adicional para asegurarse de que tienen rutas cortables para el uso de una 
cortadora/trazador. Un gran ejemplo es cómo uno debe, en ocasiones, convertir el texto en un trazado 
antes de guardarlo o exportarlo a un formato SVG porque el texto se maneja de forma diferente en los 
programas de corte. Una vez que lo hagas, la imagen se convierte en un trazado vectorial y ya no se puede 
editar como texto. 

• Este capítulo cubre el proceso de abrir archivos en C3, donde las formas se cortarán en relación con el 
origen, y algunos posibles pasos correctivos como se mencionó anteriormente. 

• Si usted es un propietario de PC y desea pre-visualizar miniaturas de sus archivos .SVG, a continuación es 
una aplicación gratuita que usted puede utilizar. Alternativamente, usted puede buscar en google 
espectador SVG gratis y encontrar otras opciones. 

https://svgextension.codeplex.com/releases/view/118790 

• Si Usted es dueño de una Mac y deseas ver miniaturas de sus archivos .SVG, Mac’s Finder debería 
trabajar. 

 

 
4.01.1 Importando Capa Sencilla de Archivos SVG 

 
• Primero, presione sobre el botón Choose File: 

 
 

 

• En la siguiente ventana, navegue por su ordenador o memoria instantánea para localizar el archivo que 
desea importar. Haga clic en el nombre del archivo para resaltarlo. Luego, haga clic en Open: 

IMPORTANTE: En este momento, cualquier archivo SVG que 
usted compre o descargue gratuitamente desde Internet debe 
importarse en SCAL, MTC, AI, Inkscape o Corel Draw y volver a 
exportarse como SVG. 

Presione Choose File 

https://svgextension.codeplex.com/releases/view/118790
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• La siguiente ventana abrirá y C3 comenzará a importar el archive .SVG:  

 

 
 

• Una vez importado, se le darán las instrucciones para volver a la pantalla principal: 
 

 

• En el lado izquierdo de la pantalla ahora verá una imagen en miniatura para el archive importado: 

 

 
 
 

 
4.01.2 Importando Archivos SVG Multi-capas 

 
• Si el archivo .SVG importado se exportó originalmente de un programa que soporta capas, la misma 

"asignación de formas de capas" será retenido. Por ejemplo, una captura de pantalla de un archivo de 
MTC con formas organizado en dos capas. 

 

Busque la ubicación del archivo 

Selecciones el archivo a abrir 
Presione Open 

Clic sobre este botón si usted 

necesita cancelar la carga. 

Clic aquí para regresar a 

la pantalla principal. 

Miniatura del archivo importado, más dimensiones generales 
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• Una vez importadas a C3, las capas aparecen en la parte superior derecha y la miniatura de la capa 
superior se muestran a la izquierda. Dependiendo de la fuente original del archivo .SVG, el orden de las 
capas puede cambiar, como ocurrió en este ejemplo. Para cambiar el orden, haga clic en el botón 
correspondiente, como se muestra: 

 
 

  

• Las líneas de la miniatura de la capa seleccionada actualmente serán más oscuras que las líneas de otras 
capas 

• Los Ajustes Cut this layer son usados para esconder una capa (apagar esta de ser cortada). Tenga en 
cuenta que al desactivar las capas no cambia donde otras capas se cortarán. Permanecerán alineados en 
la misma posición con respecto al origen. 

Las dos capas en 

MTC 

Use estos botones 

para cambiar el 

orden de las capas. 

Las capas de arriba 

serán cortadas antes 

de las capas de abajo 

Miniatura de la capa corriente 

Nombre de la capa corriente 

Activar o desacticar una 

capa para cortar 

Name of file 
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• Para ver las figuras en otra capa, presione sobre el nombre de esa capa: Observe cómo las líneas para esa 
capa son ahora más oscuras y las líneas de la capa anterior ahora se desvanecen:

 
 
 Ajuste para cortar configuraciones de archivos de múltiples capas es cubierto en el Capítulo 5. 

 
 
4.02 Preparando Archivos .SVG desde Otras Aplicaciones  

• No todos los archivos SVG son creados iguales. Por lo tanto, se recomienda que cualquier archivo SVG 
que usted compre o encuentre gratis en el Internet sea abierto en su propio programa de vector. Las 
ventajas de hacer esto son: 
 

 Verificación del tamaño y la localización de la figura 
 

 Oportunidad de organizar las figuras en capas según sea necesario. 
 

 Re-exportar el archivo para evitar ciertos problemas que pueden surgir con archivos SVG creados 
en otros programas 

 
 

• En este momento, C3 no tiene todavía ciertas funciones planificadas para la manipulación de figuras antes 
de cortarlas. Por lo tanto, antes de exportar el archivo desde el software de diseño, asegúrese que haya 
realizado los siguientes cambios para que el archivo esté "listo para cortar": 
 

 Cambie el tamaño si es necesario 

 Reubique las figuras y cambie las dimensiones del documento, según sea necesario para el modo de 
diseño (Layout mode) o modo de herramientas (Tool mode). 

 Organice las figuras en diferentes capas si utiliza la funcionalidad de doble cabeza. Nombre esas capas 
apropiadamente. 

 Duplique las figuras de ser necesario para cortar múltiples de ellas. 

 Rote la figura si es necesario para el corte paisaje. 

 Ponga la figura en forma espejo si es necesario para el vinil de transferencia de calor (HTV) o 
aplicaciones similares. 

 Una las figuras para que las trayectorias o la partes interiores de la figura corte antes de la trayectoria o 
parte de afuera de la misma. 

 Añada un rectángulo u otro corte deshierbe si es necesario. 
 

• Recuerde que con algunos programas, como MTC, las figuras deben ser seleccionados antes de 

exportarse. Asegúrese de que no haya capas bloqueadas u escondidas si ellas serán necesarias en C3 

para ser cortadas. 

 

Miniatura de la capa corriente 

Nombre de la capa 

corrientecorrientecorrientecorrie

ntecurrent layer 
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• Como se ha mencionado en la Sección 3.04, algunos programas almacenarán más información al exportar 

un archivo SVG que otros. Por ejemplo, el área del documento utilizado para esas figuras y la ubicación de 

las figuras en el área del documento se cargará en C3. Otro de SVG importará sin un área del documento. 

 

• En los cinco programas presentados en las secciones 4.02.1 - 4.02.5, las capas se importarán en C3 en 

orden inverso. Sin embargo, es fácil cambiar el orden de la capa en C3 haciendo clic en los botones 

denominados Cut this layer sooner (Cortar esta capa antes) o Cut this layer later (Cortar esta capa más 

tarde). 

 

• Debido a problemas conocidos, lo mejor es probar dibujando los archivos nuevos. Si usted descubre un 

archivo SVG que no está funcionando después de haber sido exportado desde el software de vector de su 

preferencia, favor iniciar un ticket de ayuda usando este enlace: http://knkusa.com/support-ticket-request/. 

Proporcione detalles sobre el origen del archivo y el programa que está utilizando. 

 

• Si usted utiliza uno de los siguientes programas: Make The Cut, Sure Cuts A Lot, Adobe Illustrator, 
Inkscape, o Corel Draw, lea la sección que sigue. Este cubrirá los problemas conocidos y cómo configurar 
el área del documento preferido para cortar. 

 
4.02.1 Archivos SVG desde Make The Cut (MTC) 

 
Issues with SVG Files from MTC 

• En general, los archivos SVG exportados desde MTC tienen muy pocos problemas en C3. Una excepción 
ha sido SVG importado en MTC de PCS (Popup Card Studio). Por favor refiérase a la Sección 4.02.7 con 
relación a estos. 

• Si usted tiene figuras con rutas internas, usted puede aplicar la función Join (Unión) para que las figuras 
internas se corten antes que las figuras externas. Alternativamente, usted también puede tener rutas 
internas en su propia capa separada y luego mover esa capa por encima de la capa con el camino exterior 
antes de cortar en C3. 

• En algunas otras instancias, los archivos SVG de MTC han tenido tiempos de reproducción 
extraordinariamente largos o se detuvieron a mitad de camino durante el corte. Si usted experimenta este 
problema, vuelva a MTC, seleccione las figuras y vaya a Edit>Shape Magic>Advanced>Flatten Paths (o 
haga clic en el icono "wrench" (llave inglesa) en la parte inferior de la pantalla MTC y seleccione Flatten 
Paths. Luego Exporte como SVG. Esto debería corregir el problema. 

 
Exportar Archivos Como SVG: 

 
 Las figuras deben ser seleccionadas para ser exportadas en MTC. Usted puede ocultar cualquiera de las 

capas que no sean necesarias y, luego, utilizar Ctrl+A para seleccionar el resto de las capas en el 
proyecto. 

  

 Para acceder a la función Exportar, vaya a File>Export>Sel. as SVG (Archivo> Exportar> Sel. Como SVG) 
o haga clic derecho en la selección y seleccione Export>Sel. to SVG File (Exportar> Sel. Al archivo SVG) 
en el menú desplegable. 

 

Layout Mode: 

 En el documento MTC (Tapete virtual) las dimensiones no se guardan cuando el archivo se exporta como 

SVG. Por lo tanto, puede que no tenga las figuras cortando en un lugar en particular deseado. Si usted 

prefiere el modo WYSIWYG en MTC donde las figuras cortarán basado en el lugar que fueron puestas en 

el Tapete virtual, usted puede configurar esto con bastante facilidad. Esto fue cubierto en el ejemplo de la 

Sección 3.04.4, pero se muestra un ejemplo más relevante aquí: 

http://knkusa.com/support-ticket-request/
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 En MTC, mueva las figuras a un tapete virtual de acuerdo a donde usted quiere que corten en la 

Force. 

 

 Por ejemplo, digamos que usted tiene una tarjeta de base existente ya cortada, pero usted desea cortar 

un corazón en el frente de la tarjeta. En MTC, usted ha recreado el diseño para asegurarse de que el 

corazón se encuentra en el lugar necesario, de acuerdo con la tarjeta, pero no es necesario cortar la 

tarjeta nuevamente. 

 

 

 Una pequeña figura, tal como una pequeña línea, puede añadirse al tapete virtual en la ubicación del 
origen (esquina inferior derecha del Tapete virtual): 

 

 Ubique el corazón y la línea en capas separadas. Luego, seleccione las figuras antes de exportarlas. 
Ya que la base de la tarjeta está cortada, esa capa debe ser bloqueada o escondida para que no sea 
exportada: 

 

Tenga en cuenta la ubicación del corazón 

con respecto a la tarjeta y al Tapete Virtual 

. 

La tarjeta no será cortada. En su lugar, se 

posicionará sobre el tapete actual en este 

lugar (1 pulgada desde la derecha y 1 

pulgada partir de la parte inferior) 

. 

La línea de 0.25", localizada en el 

origen, asegurará que el corazón se 

cortará en la misma ubicación como 

mostrado en el tapete virtual. 

. 

Esconda la capa donde se 

encuentra la base de la tarjeta. 

La pequeña línea debe estar 

en una capa separada de la 

imagen a ser cortada. 
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 En C3, después de la importación, asegúrese de que la capa con la pequeña línea está desactivada ya 
que no es necesaria para cortarla. La capa del corazón aún será cortada en la ubicación relativa a esa 
pequeña línea: 

 

 La base pre cortada de la tarjeta está ubicada en el tapete de corte, 1” de la derecha y 1” de la parte 
inferior, como fue posicionado en el Tapete Virtual en MTC. El origen XY es entonces configurado en la 
esquina baja derecha del tapete actual de la Force. El proyecto es enviado a cortar: 

 
 

Tool Mode: 

• Si usted prefiere cortar en MTC en el modo Knife Point, entonces ya está todo listo. Eso es básicamente 
como C3 cortará los archivos que usted exporta desde MTC. Regrese a la Sección 3.04.3. 

Cambio de dirección de corte: 

 
 En MTC, se puede comprobar la dirección de corte (a la derecha o la izquierda) con la Measure Tool 

(último icono en la barra de herramientas Node Mode (Modo Nodo): 

Desactive esta capa 

Seleccione esta capa 

El corazón será cortado de la 

tarjeta en el lugar deseado. 

Configure el origen en la 

esquina del cuadriculado 

La base pre cortada de la tarjeta s ubicada 1” 

de la derecha y  1” de la parte inferior 



77 

 

  
 

 Mientras se puede cambiar una dirección de trayecto en MTC usando la opción Reverse Paths (Rutas 
inversas) en las funciones Advanced (avanzadas), este cambio no se exportará en el archivo SVG 
para C3. Sin embargo, se puede invertir una dirección de trayectoria una vez que el archivo está en C3. 
Asegúrese de que las figuras que necesitan ser reversas están en su propia capa separada de aquellas 
que cortan en la dirección deseada. Consulte la Sección 3.02.10. 

 

 
4.02.2 Archivos SVG desde Sure Cuts a Lot (SCAL) 

 

 

• SCAL tiene la capacidad de cortar directamente a la Force. Si usted necesita usar C3 para cortar archivos 
SVG creados en SCAL, entonces utilice la siguiente información para preparar archivos para cortar. 

 
 

Issues with SVG Files from SCAL: 

• Si usted tiene figuras con rutas internas, usted podría aplicar la función Object>Merge (Objeto> Combinar) 
para que las figuras internas se corten antes que las figuras externas. Alternativamente, usted también 
puede tener rutas internas en su propia capa separada y luego mover esa capa por encima de la capa con 
el camino exterior antes de cortar en C3 

 
• Si usted tiene figuras con Partes blancas en el proyecto, se recomienda asignar un color de trazo para que 

usted pueda verlas en C3. Esto se puede establecer abriendo la ventana Fill and Stroke (Relleno y trazo) 

. 
 

• En el panel Capas SCAL, cualquier figura a ser exportada deben estar dentro de una carpeta. Los iconos 

de figura aparecen así:  o .  Un icono de carpeta se ve así:  o .  Las figuras se pueden 

arrastrar a carpetas, según sea necesario, antes de exportarse. 

 
Exportar Archivos como SVG: 

 
• Todas las capas serán seleccionadas para exportar automáticamente. Usted puede ocultar capas que 

usted no desea exportar haciendo clic en el icono Hide (Ocultar) en la barra de capas  . Luego, vaya a 
Archivo> Exportar (File>Export), seleccione Scalable Vector File (*.svg) (Archivo vectorial escalable 
(*.svg)) como tipo de archivo, proporcione un nombre para el archivo y luego acepte los valores 
predeterminados. 
 

• Si usted sólo desea algunas figuras en el proyecto (o en ciertas capas), pero no todas: 
 

 Seleccione las figuras que desea exportar 

Haga clic en este 

icono. 

Mueva el ratón sobre una figura y el 

triángulo verde indica la dirección que 

cortará el camino. 

https://www.youtube.com/watch?v=ZcJj5l7TY34
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 Vaya a File>Export (Archivo> Exportar) y proporcione un nombre para el archivo. Seleccione *.svg en 
el menú desplegable en Save as type (Guardar como tipo). Luego, haga clic en Save (Guardar). 

 

 

 

 

 

 En la próxima ventana, marque la cajita Selection only y luego presione OK: 

 

 

Layout Mode: 

• Archivos SVG desde SCAL automáticamente retienen la información del documento y cortarán la figura 
de acuerdo a su ubicación dentro de esa área del (modo WYSIWYG). 
  

• Para simular el tapete de corte 15" x 15" de la Force o las dimensiones del material que se va a cortar, 
haga clic en el icono Document y, luego, seleccione en el menú o haga clic en Custom Size: 

 

• Si selecciona Custom Size, la siguiente ventana se abre. Introduzca las dimensiones que desee utilizar 
y complete los otros elementos que se muestran. Por ejemplo, si desea crear una dimensión de 
documento para que coincida con el tapete de corte de la KNK Force: 

 

• Ahora, usted encontrará el Nuevo tapete de corte situado en la lista desplegable: 

Localice Scalable Vector File en el menú 

Nombre del archivo 

Luego clic sobre Save 

Clic sobre este icono 

O seleccione Custom Size 

Seleccione del menú 

Entre W (ancho)  

and H (alto) 

Marque este cuadrito 

Clic sobre OK 

Entre un nombre 
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Tool Mode – Manera Rápida 

• La manera más rápida de tener figuras cortadas en el modo de herramienta, Tool Mode, (alineado con 
el origen XY) es moverlas a la esquina inferior derecha del área de la cuadrícula en SCAL : 

 

 

 

• Exportar como SVG. Cuando usted abre y corte en C3, las figuras se cortarán en alineación con la 
ubicación del origen XY como se muestra arriba. Note que el área grande vacía que se muestra a 
continuación corresponde al área del documento que se creó en SCAL en el momento en que el SVG 
fue exportado: 

 

 

 

Tool Mode – Sin el Area Grande del Documento  

• Si usted desea cortar en Modo herramienta (Tool Mode) donde las dimensiones del documento coinciden 
con la caja alrededor de las figuras, entonces: 

 
 Note el Ancho (Width) y el Alto (Height)de la caja alrededor de la figuras 

seleccionadas.  

 

 

1. Alinee la figura seleccionada 

a lo largo del lado derecho del 

cuadriculado 

2. y a lo largo de la línea de la 

parte inferior del cuadriculado 

3. Esta esquina entonces corresponde 

a la ubicación de la punta de la 

cuchilla cuando configure el origen 

XY en C3. 

Las figuras alinearán y cortarán 

relativas a esta esquina. 
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       
 

 Mueva las figuras a la esquina superior izquierda del tapete virtual corriente.  
 

 Cambie a la pestaña Document, luego seleccione Custom Size del menú desplegable del Mat Size: 

 

 Redondee el Ancho (Width) y Alto (Height) de las figuras seleccionadas. Entre valores ligeramente 
más grande como el Nuevo Tamaño del tapete de corte y presione OK: 

 

 El área del Nuevo documento encaja las figuras: 

 

 Use File>Export para exportar como archivo SVG. Una vez importado a C3, la caja miniatura encajará 
cercanamente las figuras: 

 
 
 

Cambio de Dirección de Corte: 

 
• En SCAL, se puede comprobar la dirección de corte (sentido horario versus sentido antihorario) siguiendo 

los pasos siguientes: 

Width (Ancho) y 

Height (Alto) de 

figuras seleccionadas 

Figuras Seleccionadas 

Seleccione 

Seleccione Custom Size 

Seleccione 

Entre W (ancho) y  H 

(alto) 

Clic sobre OK 
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 Seleccione la figura, haga clic derecho y seleccione Path> Path Details 
 

 Se abrirá una ventana. En el lado izquierdo hay una lista de los caminos en el orden en que se 
cortarán. Haga clic en cualquier ruta de la lista y esa ruta se volverá roja: 
 

•  
 

 Seleccione la siguiente ruta en la lista y entonces podrá determinar la dirección del corte 

•  

 
 Para invertir la dirección, haga clic derecho y seleccione Path>Reverse Path. Esta información se 

almacenará si el archivo se exporta como SVG y se abre en C3. 
 

 Usted también tiene la opción de colocar figuras que necesiten un cambio de dirección de trayectoria 
en su propia capa y luego usar la configuración de dirección de trayectoria en C3 para invertir la 
dirección del corte. 

 
 

 
4.02.3 Archivos SVG desde Adobe Illustrator 

 

Problemas con Archivos SVG de AI: 

• De forma predeterminada, Adobe Illustrator añade informaciones extrañas a los archivos SVG en un 
esfuerzo por preservar detalles específicos AI. Esta información adicional puede causar problemas cuando 
los archivos son sometidos a C3 para ser cortados. Al mismo tiempo, también es importante llevar a cabo 
otras tareas relacionadas con cómo se manejan los estilos de letras e imágenes.   
 

• Si usted crea un archivo SVG en AI que no está cortando correctamente desde C3, utilice este vínculo para 
informar y enviar el archivo: http://knkusa.com/ai-svg-files/. 

 

• Tenga en cuenta que Adobe Illustrator tiende a cambiar los diseños de la pantalla e incluso los nombres y la 
ubicación de la configuración de una versión a otra. Por lo tanto, lo que se muestra en esta sección puede o 
no coincidir exactamente con su propia versión actual. 

La ruta seleccionada en la lista 

se volverá roja. 
Sombrear una ruta 

Esta ruta se cortará a 

continuación, por lo que la 

dirección del camino es en 

el sentido de las agujas del 

reloj. 

Seleccione la siguiente 

ruta en la lista. 

http://knkusa.com/ai-svg-files/
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• Para evitar el doble corte, asegúrese que las figuras creadas en AI solo tenga el “Stroke Setting” y no incluya 
relleno.  

 

• Actualmente, la herramienta Ellipse producirá óvalos que no se reproducirán correctamente en C3 sin 
convertirse primero en una ruta compuesta. Esto no se aplica, sin embargo, a los círculos creados con la 
misma herramienta. Por lo tanto, antes de exportar como SVG, seleccione cualquier óvalo, haga clic con el 
botón derecho y seleccione Hacer ruta compuesta (Make Compound Path) en el menú. 

 

• Si usted sólo tiene una sola capa en su proyecto, el nombre de esa capa no aparecerá en C3. En su lugar, 
se llamará "capa predeterminada" (“Default layer”). 

 
 

Exportar Archivos como SVG 

• Los siguientes pasos son recomendados cuando guarde como SVG: Aunque hay una función de 
exportación en las versiones más recientes de AI, actualmente se recomienda que no se utilice la opción. 
 

 Vaya a File>Save As y seleccione SVG como formato de archive. (Nota: en nuevas versiones AI, use 
File>Export>SVG (svg)). Provea un nombre para el archivo y presione Save. 

  

 
 

 Una nueva ventana se abrirá dónde usted puede seleccionar Convert to outline (Convertir a contorno) 
para estilos de letras y Embed (Incrustar) para imágenes. Asegúrese de que la opción de preservar no 
está habilitada. Luego haga clic en OK: 

 

 

 
 En CSS Properties (Propiedades CSS), cambie a Presentation Attributes (Atributos de presentación) 

y, luego, haga clic en OK: 

Haga Clic en Save. 

Nombre del Archivo 

Seleccione SVG 

Marque esta 

opción 

Seleccione Embed 

Seleccione Convert to outline 

Asegúrese esta cajita 

NO está Marcada 

Haga Clic en  More Options 
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  

 
 
Layout Mode: 

• Los archivos SVG exportados desde Adobe Illustrator, por defecto (predeterminación), retendrá la 
información del documento y las figuras serán entonces cortadas de acuerdo a su colocación dentro de esa 
área del documento. Para cambiar esas dimensiones: 

•  

 Vaya a File>Document Setup y presione Edit Artboards y cambie el “tamaño” de ancho y alto del 
“cartel” para que coincida el tamaño deseado: 

 

 

 

 

 Si usted quiere que el área del documento coincide con el tapete de corte de la Force, use 15” y 15”.  Si 
usted quiere que coincida con la dimensión de su material, entonces entre esas dimensiones. 

 

Tool Mode – Forma Rápida  

• La forma más rápida de tener figuras recortadas en el modo de herramienta, Tool Mode (alineado con el 
origen XY) es moverlos a la esquina inferior derecha del área del documento de AI. 
 

• Exportar como SVG. Al abrir y cortar en C3, las figuras cortarán en alineación con la ubicación del origen 
XY como mostrado en la Sección 3.04.3.   

 

Tool Mode – Sin el Area Grande del Documento  

• Para hacer las dimensiones del documento iguales a la caja alrededor de las figuras: 
 

 Vaya a File>Document Setup y presione sobre Edit Artboards: 

 En la parte superior izquierda, escoja Presets. 

 Seleccione Fit to Selected Art: 

 

 

Seleccione Presentation 

Attributes 

Haga Clic en  OK 

 

Seleccione desde el menú Preset  O ingrese W y H personalizado 
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• Esto pondrá un “cuadro delimitador” justo alrededor de la figura seleccionada cuando usted exporta a un 
archivo SVG.  

 
Changing Cut Direction: 

• En las figuras cerradas, se puede cambiar el sentido de corte (en el sentido de las agujas del reloj o en 

el sentido contrario a las agujas del reloj) siguiendo los pasos siguientes: 
 
 Seleccione la figura, haga clic con el botón derecho del ratón y seleccione Make Compound Path (Hacer 

ruta compuesta). 
 

 Vaya a Ventana> Atributos (Window>Attributes) para abrir la siguiente ventana que le permite cambiar 
la dirección de la trayectoria, según lo desee: 

 

 

 

 

• En las figuras abiertas, como las líneas, se puede cambiar la dirección de corte (en sentido horario versus en 
sentido contrario a las agujas del reloj) siguiendo los pasos siguientes: 
 

 Los caminos no deben estar compuestos. Si es necesario, seleccione la figura, haga clic con el botón 

derecho del ratón y seleccione Liberar ruta compuesta (Release Compound Path). 
 

 Seleccione la Herramienta Bolígrafo (Pen Tool)  y haga clic una vez en el final de la ruta donde 
usted desea que el corte termine. 

•  

 Después de hacer clic en el nodo final deseado, haga clic con el botón derecho del ratón para abrir el menú 
y luego haga clic con el botón izquierdo en Undo Pen. Repita en otra figura abierta, según sea necesario. 
 

Clic aquí 

here 

Cambiar la ruta de acceso aquí 

Haga clic izquierdo aquí y esta 

línea se cortará de derecha a 

izquierda. 

Haga clic izquierdo aquí y 

esta línea se cortará de 

izquierda a derecha. 
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 Usted también tiene la opción de colocar figuras que necesitan un cambio de dirección de trayectoria en su 
propia capa y luego usar el ajuste de Dirección de Trayectoria (Path Direction) en C3 para invertir la 
dirección del corte. 

 
4.02.4 Archivos SVG Files Desde Inkscape 

 
Problemas con Archivos SVG de Inkscape: 

• Inkscape automáticamente no convierte el texto o algunas de las figuras básicas en trayectoria de corte antes 
de guardar el archivo. Así pues, ciertas figuras no serán reconocidos cuando se importen a C3. 
 

• Para todos los círculos y óvalos, selecciónelos primero. Luego, vaya a Path>Simplify. Si usted se olvida de 

hacer este paso, estas figuras cortarán patrones al azar . No utilice este paso en figuras con líneas rectas. 

 

• Para texto, seleccione Path>Union. Incluso si sus letras no se sobreponen, aplicando una Unión se asegurará 

de que el texto sea cortado correctamente. 

 

• Para todas las demás figuras, antes de guardarlas como un archivo SVG, seleccione una capa a la vez y vaya 

a Path>Combine. Tenga en cuenta que si usted tiene círculos y óvalos en capas que contienen figuras de 

líneas rectas, ellas pueden ser una parte del paso Path>Combine, siempre y cuando usted haya realizado 

primero el Path>Simplify (Trazado>Simplificar) en ellos. Lo mismo es cierto con el texto - después de aplicar el 

Path>Union (trazado> Unión), usted puede incluir ese texto con otras figuras cuando aplique Path>Combine 

(Ruta> Combinar). 

 
Exporting Files as SVG: 

• Al guardar un archivo en Inkscape, utilice siempre Inkscape SVG (*. svg) en Guardar como tipo (Save as 

type). Hay otras opciones de SVG en el menú, sin embargo, no se reproducirán correctamente en C3: 

      
 
 

Layout Mode: 
 

• Inkscape es otro programa que mantiene las dimensiones del documento cuando guardas archivos SVG. 
 

• Para establecer nuevas dimensiones del documento, vaya a File>Document Properties, seleccione la pestaña 
Pages y luego, utilice lo siguiente como guía para lo que necesites: 
 
 Bajo la sección Page Size, usted puede seleccionar uno de los formatos estándar como, por ejemplo, carta, 

A4, A6, etc. Esto establecerá un modo de diseño basado en las dimensiones del material. 
 

 Bajo Custom Size, usted puede introducir las dimensiones exactas del documento, como la introducción de 
12" x 12" para un modo de diseño que se base en las dimensiones de materiales o 15" x 15" para un modo 
de diseño basado en el Cuadriculado del tapete de corte de la Force. También, cambie las unidades si es 
necesario en el lado derecho. 

 
 

Always use Inkscape SVG 
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Tool Mode – Forma Rápida 

• La manera rápida de cortar figuras en el modo Tool (alineado con el origen XY) es moviéndolas a la esquina 
inferior derecha del área del documento en Inkscape. 
 

• Guárdelo como SVG. Cuando usted abre y corta en C3, las figuras cortan en alineación con la ubicación del 
origen XY como se mostrado en la Sección 3.04.3.   

 

Tool Mode – Without the Large Document Area  

• Para hacer el área del documento equivalente a la caja alrededor de las figuras: 

 

 Vaya a File>Document Properties, seleccione la pestaña Pages. 
 

 En Custom Size, haga clic en la casilla junto a to Resize page to content. 

 

 Clic sobre Resize page to drawing or selection. Esto entonces cambiará el tamaño del documento 
(Width (Ancho) y Height (Alto)) a ser el cuadro de límite alrededor de las figuras.  

 
 
 
 
 
 

Seleccione la pestaña Page. 

O… entre dimensiones 

personalizadas 

Seleccione una dimensión de página estándar. 

Seleccione Units para 

paginas personalizadas 

Seleccione la pestaña Page. 
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Cambio de Dirección de Corte: 

 
• En Inkscape, se puede comprobar la dirección de corte (a la derecha o la izquierda) mediante los siguientes 

pasos: 
 

 Vaya a: Edit>Preferences (Editar> Preferencias) y en el menú Tools (Herramientas) de la izquierda, 
haga clic en Node (Nodo). 
 

 Marque la casilla Always show outline (Mostrar siempre esquema) y la casilla Show path direction in 
outlines (Mostrar ruta de dirección en contornos). 
 

 
 

 Haga clic en el icono Edit paths by nodes (Editar rutas por nodos)  en la barra de herramientas de 
la izquierda (o pulse F2) para entrar en el modo de edición de nodo. 
  

 Haga clic en la figura y se mostrará la dirección de la ruta de corte: 

 

Clic aquí para hacer las dimensiones de 

la página iguales al cuadro de limite 

alrededor de las figuras.  

Clic para expandir la ventana. 

Seleccione Units para 

personalizar página. 

Haga Clic en Node. 

Marque esta opción…. 

Y marque esta opción 

Las pequeñas flechas rojas 

indican que el círculo se cortará 

en el sentido de las agujas del 

reloj. 
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 Para cambiar la dirección de la trayectoria, vaya a Path>Reverse (Trayectoria>Invertir) y las flechas 
cambiarán de dirección: 
 

 

 Usted también tiene la opción de colocar figuras que necesitan un cambio de dirección de trayectoria 
en su propia capa y luego usar el ajuste Path Direction (dirección de trayectoria) en C3 para invertir la 
dirección del corte. 

 
 
4.02.5 Archivos SVG desde Corel Draw 

 
Problemas con Archivos SVG Desde CD: 
 

• Algunas de las figuras básicas disponibles en Corel Draw, como elipses (óvalos), deben convertirse antes 
de exportar como SVG. De lo contrario, C3 no las reconocerá como imágenes vectoriales. Para ello, 
seleccione la figura o las figuras y vaya a Arrange>Convert to Curves (Organizar> Convertir a curvas). 
Esta misma función se puede encontrar en el menú emergente del botón derecho o se invoca con Ctrl+Q. 

 
Exportar archivos como SVG: 
 

• Los siguientes pasos son recomendados al guardar como SVG en Corel Draw: 
 

 Vaya a File>Export (Archivo> Exportar) y seleccione SVG como formato de archivo. Proporcione un 
nombre para el archivo y haga clic en Export (Exportar): 

  

 Se abrirá una nueva ventana donde deberán realizarse los siguientes ajustes y opciones antes de 
hacer clic en Aceptar. 

Haga clic en Export. 

Nombre el archivo 

Seleccione SVG 



89 

 

 

 
 

• Como alternativa, también se puede utilizar File>Save As (Archivo> Guardar como) con los mismos ajustes 
y opciones recomendadas. 

Layout Mode: 

• Corel Draw, como Inkscape y Adobe Illustrator, guardará automáticamente las dimensiones del documento 
y utiliza las mismas como el cuadro de límite alrededor de las figuras en la exportación SVG.  En otras 
palabras, este utilizará el modo de diseño (Layout mode). 

 
• En Corel Draw, para cambiar las dimensiones del área del documento, vaya a Layout>Page Setup y lo 

mismo seleccione en el menú desplegable bajo Size (Tamaño) o seleccione Custom (Personalizar) e 

introduzca las dimensiones deseadas. 

 

Haga clic en OK. 

Seleccione As Curves 

Seleccione Presentation Attributes 

 

Seleccione Embed Images 
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•  

 

 

Tool Mode – Forma Rápida 

• La forma más rápida de tener figuras cortadas en el modo de herramienta (Tool Mode) (alineado con el 

origen XY) es moverlas a la esquina inferior derecha del área de documento en Corel Draw. 

 

• Exporte como SVG. Cuando usted abra y corte en C3, las figuras cortaran en alineación con la ubicación 
del origen XY como mostrado en la Sección 3.04.3.   

 

Tool Mode – Sin el Area grande del Documento  

• Para forzar el cuadro delimitador a que sea las dimensiones de las formas en su lugar: 

 

 Seleccione las figuras 
 

 Vaya a File>Export y cambie Save as type a SVG.  Introduzca un Nuevo nombre para el archivo. 

 

 Marque el cuadrito de Selected only antes de hacer Clic en Export: 

 

 

 Las dimensiones del cuadro delimitador alrededor de las figuras se introducirán automáticamente en la 
ventana SVG Export (Exportar SVG): 

 

Haga clic en OK. 

O Personalice Width and Height. 

Seleccione un tamaño de página estándar o 

Custom 

Seleccione SVG 

Marque la cajita 

Selected only  
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Cambio de la Dirección de Corte 

 
• En Corel Draw, se puede comprobar la dirección de corte (sentido horario versus sentido antihorario) 

siguiendo los pasos siguientes: 
 

 Si el objeto es una figura básica, haga clic derecho en él y seleccione Convertir a curvas (Convert to 
Curves) en el menú desplegable. 
 

 En la barra de herramientas de la izquierda, haga clic en el icono de la Herramienta de Forma (Shape 

Tool) . 
 

 Clic izquierdo sobre la figura y un pequeño triángulo azul indicará la dirección del corte: 

 

 
 Haga clic con el botón derecho del ratón sobre el pequeño triángulo azul y seleccione Reverse 

Subpaths en el menú desplegable. El triángulo ahora señalará el camino opuesto: 

 

 

 

Width (ancho) y Height (alto) de la 

caja delimitadora alrededor de las 

figuras seleccionadas aparecerá aquí. 

Clic OK. 

Verifique estas tres 

configuraciones. 

El triángulo azul indica que el 

corte procederá según las 

manecillas del reloj. 

El triángulo azul indica que el corte 

avanzará ahora en sentido anti horario 
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 Usted también tiene la opción de colocar figuras que necesitan un cambio de dirección de trayectoria 

en su propia capa y luego usar el ajuste de dirección de trayectoria (Path Direction) en C3 para invertir 
la dirección del corte. 

 
 
4.02.6 Archivos SVG desde KNK Studio 

• En este momento, los archivos SVG exportados desde KNK Estudio causan áreas impredecibles en el 

documento alrededor de las figuras exportadas. Además, las capas no son exportables actualmente. Por 

esa razón, es recomendable hacer uso de uno de los dos programas siguientes: 

 
 

 Make The Cut: Directamente copie y pegue en el lugar (paste-in-place) las figuras desde KNK Studio a 

Make The Cut. Organice en capas si es necesario. Luego, exporte como SVG. 

 

 Inkscape (disponible gratis en inkscape.org): Directamente copie y pegue figuras de KNK Studio a 
Inkscape. Cambie el tamaño de las figuras, según sea necesario (lo más probable es que se han 
cambiado de lo que eran en KNK Studio). Organice en capas si es necesario. Si las figuras internas se 
pierden, seleccione las figuras externas e internas y vaya a Path>Combine. 

 

 Antes de guardar como SVG, revise las instrucciones de la Sección 4.02.4 para establecer ya sea un 

modo de diseño (Layout mode) o modo Herramienta (Tool mode) para el corte. 

 
4.02.7 Archivos SVG desde Popup Card Studio (PCS) 

• En este momento, SVG exportado desde Popup Card Studio (PCS) no comenzará a cortar en C3. Los 

archivos deben ser importados en otro programa. Dado que la mayoría de los propietarios de PCS también 

poseen MTC, se presentan los siguientes pasos utilizando MTC. 

 

 Importe el archivo SVG en MTC. Este aparecerá como una sola capa en la Barra de Capas (Layers 

Bar). Haga clic con el botón derecho en la miniatura de la capa y seleccione To Each Its Own en el 

menú emergente. 

            
  

 Se obtendrán tres capas. Tenga en cuenta que se denominan Valley, Mountain, y Cut: 

Seleccione To Each Its Own 

Clic derecho en la imagen 

miniatura 
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 Las capas de Mountain y Valley, cuáles son las líneas de plegado para el proyecto, deben ser rotas 

antes de exportar. Puesto que tampoco es necesario tener estas dos capas separadas para cortar, es 

más rápido aplicar Break a ambas como sigue. 

 

 Haga clic en la miniatura para seleccionar una de las capas. Mantenga presionada la tecla Mayúscula 

(Shift) y haga clic en la otra capa para añadirla a la selección. Luego haga clic en la función Break 

 en la parte inferior de la pantalla. 

 

 Con esas capas seleccionadas, haga clic en el icono Selection to New Layer. Las líneas de plegado 

estarán todas ahora en una capa: 

 

 

 Si usted prefiere, usted puede cambiar Line Style (el Estilo de línea) de punteada a sólido. Usted 
también puede cambiar el nombre de esta capa haciendo doble clic en New Layer (Nueva capa) y 
renombrándola como mejor le parezca (tal como Líneas dobles). 
 

 Finalmente, Seleccione Todo y vuelva a exportar el archivo como SVG. 

 
 
4.02.8 Otros Archivos SVG 

• Hay muchos otros programas vectoriales que crearán archivos SVG. Si llegas a tener problemas con 

cualquier archivo SVG que no funcione correctamente en C3, favor iniciar un ticket de soporte con KNK 

USA usando este enlace: http://knkusa.com/support-ticket-request/ . Por favor, proporcione tanta 

información como sea posible sobre el origen del archivo, la naturaleza del problema, y cualquier otro 

programa de vectores que tenga su disposición. 

1. Haga clic en el 

segundo icono: 

2. Después de hacer clic en Selection to New 

Layer (Selección a nueva capa), todas las 

líneas de plegado estarán en esta Nueva Capa.  

3. Estas dos capas vacías ahora pueden 

ser eliminadas. 

http://knkusa.com/support-ticket-request/
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4.03 Actualizando C3 

 
4.03.1 Verificando la Versión Actual y la Versión Disponible  

• Si usted está conectado utilizando el modo autónomo (standalone), vaya a la Sección 4.03.3. De lo 

contrario, Haga clic en la pestaña Status. En la parte inferior usted verá la versión actual de C3 instalada 

en su Force. Para verificar la versión más reciente, asegúrese de que está conectado al Internet. Luego, 

haga clic en el enlace (update): 

 
 
 

 
 
 

• Aparece una nueva pantalla. Ahora puede comprobar la versión más reciente disponible 

 

 
4.03.2 Descargando e Instalando una Actualización  

• Cada vez que una actualización de C3 esté disponible, una notificación se mostrará en la parte superior de 
la pantalla siempre y cuando esté conectado a Internet. Es fuertemente recomendado que se instalen las 
actualizaciones a medida que estén disponibles.  

 

Clic aquí 

 

Clic en la pestaña Status 

 

 

Su versión actual La última versión 

disponible 

Su versión actual 

Notificación de una actualización 

aparecerá justo encima de la sección 

Pattern de C3: 
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• Para instalar la actualización, haga clic en la notificación y la siguiente pantalla nueva aparecerá. En 

algunos casos, un archivo de actualización puede estar disponible para descarga por separado o puede ser 
enviado por correo electrónico. En ese caso, haga clic sobre Choose File y vaya a la ubicación de ese 
archivo en el ordenador (consulte la Sección 4.03.3). De lo contrario, haga clic en Enter update mode, 
como se muestra:  

 

• Varios mensajes aparecerán según el programa es descargado. No es necesario ninguna acción a no ser 
que escojas cancelar: 

 

 
 

 

• Al ver la siguiente pantalla, haga clic sobre Install latest version:  

 

De lo contrario, clic aquí para 

comenzar la descarga. 

Clic aquí si un archivo de actualización ha 

sido descargado.  Consulte la Sección 4.03.3. 

Clic aquí para comenzar la instalación 

Mensaje 2 

Mensaje 1 

Mensaje 3 
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• Si una actualización de firmware va a ser instalada también, el siguiente mensaje aparecerá. Tenga en 

cuenta que durante el proceso de actualización, las luces de la Force cambiarán y, a veces, pueden 

apagar. Esto es normal. 

 
• IMPORTANTE: Si la Force se apaga completamente y empieza a recibir mensajes de error, ¡no se asuste! 
 

 Cierre la página del navegador. 
 

 Luego encienda la Force y espere unos dos minutos. Debe aparecer una luz azul fija. 
 

 Abra una nueva página del navegador y escriba la dirección IP que utiliza para conectarse a C3. 
 

 Usted debería poder seguir haciendo clic en Install latest version (Instalar la última versión). 
 

• Una vez finalizada la actualización, aparecerá el siguiente mensaje donde luego usted podrá salir: 

       
 

• Una vez completada la actualización, el siguiente mensaje aparece donde usted puede entonces salir: 

 

 

• El siguiente mensaje aparecerá, lo cual después volverá a la pantalla principal C3: 

 

• Usted ahora está listo para continuar el uso de C3. No hay necesidad de reiniciar la Force. 

 
 
4.03.3 Actualizando C3 Usando una Descarga de Archivos 

 

• Si usted está conectado a través del modo autónomo (standalone), utilice las siguientes instrucciones para 

actualizar. Este mismo método también se puede utilizar si no está en modo autónomo, pero tiene una 

razón para descargar un archivo de actualización mediante un enlace web en lugar de descargar desde C3 

 

• El siguiente es un enlace a la última actualización C3 disponible. Descargue este archivo y anote dónde se 

guarda en su computadora. Si es necesario, el archivo también se puede guardar en una unidad flash o 

copiar a una unidad flash desde su computadora:  

http://cutterpunk.com/files/knk/knk_force-update.bin 

 

• En C3, haga clic en Status. Si usted recibe un mensaje de error, escriba la dirección IP seguida de 
"/status". Por ejemplo, si su dirección IP es 10.0.0.1, entonces escriba 10.0.0.1/status. 
 

• Haga clic en el enlace (update) (actualizaciones) para abrir la siguiente ventana. Haga clic en Choose  
 

Clic aquí para salir y regresar a 

la pantalla principal de C3 

Haga clic aquí para salir y 

regresar a la pantalla principal 

de C3 

http://cutterpunk.com/files/knk/knk_force-update.bin
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• Navegue para encontrar la ubicación del archivo a actualizar, selecciónelo y haga clic en Open. 

 

 
 

• El resto del proceso de instalación será similar a lo que es presentado en Sección 4.03.2. 

 
4.04 Revisión del capítulo 4 

 
4.04.1 Guía Rápida para Preparar Imágenes Para C3 

 

 

Clic aquí 

Resalte el archivo 

Clic sobre Open 
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MTC SCAL Adobe Illustrator Inkscape Corel Draw

(Sección 4.02.1) (Sección 4.02.2) (Sección 4.02.3) (Sección 4.02.4) (Sección 4.02.5)

Use Join para que las figuras 

interiores se corten antes que 

las externas

Use Objeto>Combinar para 

que las figuras interiores se 

corten antes que las externas

Sólo use Stroke; NO use Fill
Para circulos y óvalos, aplique 

Path>Simplify

Aplique Convert to Curves a 

las figuras básicas

Para tiempos de reproducción 

largos aplique Flatten Paths 

en MTC

Aplique un color Trazo a las 

figuras con relleno blanco

En todas las figuras elipse, 

aplique Make Compound Path

Para todo texto, aplique 

Path>Union

In SVG Export, seleccione 

Presentation Attributes, As 

Curves, y  Embed Images

Debe seleccionar figuras 

antes de exportarlas como 

SVG

Asegúrese que todas las 

figuras a ser exportadas están 

en carpetas en el panel 

Capas

Los archivos de una capa se 

denominarán capa 

predeterminada en C3

Para todas las demás figuras, 

seleccione una capa a la vez y 

aplique Path>Combine

Use File>Save As para 

exposrtar como SVG

Use Inkscape SVG (*.svg) bajo 

Save as type

Haga clic en Use Artboards en 

la ventana File>Save As

En la ventana SVG Options 

seleccione Convert to Outline, 

Embed, y  Presentation 

Attributes.  NO marque la 

opción Preserve.  
 

 

 

 

 

 

 

 
4.04.2 Guía Rápida Para Controlar Dónde se Cortarán las Figuras  
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MTC SCAL AI Inkscape CD

(Sección 4.02.1) (Sección 4.02.2) (Sección 4.02.3) (Sección 4.02.4) (Sección 4.02.5)

Layout Mode: Coloque una 

figura diminuta, en su propia 

capa en el origen.

Ajustes de corte al cortar 

directamente: Use Corta lo 

que ves en la ventana 

Parametros de Corte.

Layout Mode: Vaya a 

File>Document Setup y  haga 

clic en Edit Artboards.

Layout Mode: Vaya a 

File>Document Properties y  

haga clic en la pestaña Pages.

Layout Mode: Vaya a 

Layout>Page Setup y  

seleccione Custom. 

Coloque otras figuras en 

relación con la figura diminuta. 

En C3, apague la capa con la 

figura diminuta

Modo Herramienta al cortar 

directamente: Use Punto de 

Origen en la ventana 

Parámetros de corte.

Seleccione desde Presets o 

introduzca W y H. Luego coloque 

las figuras, según desee, en el 

area del documento.

Seleccione desde el menú o 

introduzca dimensiones 

personalizadas. Luego, coloque 

las figuras, según se desee, en el 

área del documento. 

Introduzca dimensiones. Luego 

coloque las figuras, como 

desee, en el documento.

Tool Mode: No se necesita 

acción.

Layout Mode para C3: Clic 

en el icono Document 

(documento) y  seleccione 

Custom Size (tamaño 

personalizado).

Tool Mode (rápido): Organice las 

figuras en la esquina inferior 

derecha del área del documento.

Tool Mode (quick): Organice las 

figuras en la esquina inferior 

derecha del área del documento.

Tool Mode (quick): Organice 

las figuras en la esquina inferior 

derecha del área del 

documento.

Introduzca dimensiones. 

Luego coloque las figuras, 

como desee, en el 

documento.

Tool Mode (ningún documento): 

Seleccione la figura y vaya a 

File>Document Setup.

Tool Mode (no document): Vaya 

a File>Document Properties y  

haga clic en la pestaña Pages.

Tool Mode (ningun documento): 

Seleccione las figuras y vaya a 

File>Export y  seleccione 

SVG.

Tool Mode for C3 (quick): 

Arrange shapes in lower right 

corner of document area.

Click on Artboards. Under 

Presets, select Fit to Selected 

Art.

Haga clic en Resize page to 

content. Luego haga click en 

Resize page to drawing or 

selection.

Check the option for Selected 

only.

Tool Mode para C3 (ningun 

documento): Seleccione las 

figuras y haga clic en el icono 

Position and Size. Note W 

y H.

Haga clic en el icono 

Document y cree un Tapete 

Personalizado un poco mas 

grande de W y  H.
 

 
4.04.3 Guía Rápida para Cambiar la Dirección de Corte 

 

MTC SCAL AI Inkscape CD

(Sección 4.02.1) (Seccción 4.02.2) (Sección 4.02.3) (Sección 4.02.4) (Sección 4.02.5)

Seleciona la figura y utiliza 

Measure Tool para 

verificar la dirección de la 

trayectoria. 

Clic derecho sobre la figura y 

selecciona Path>Path 

Details.

Figuras cerradas:Haga clic 

derecho y seleccione Make 

Compound Path

Vaya a  Edit>Preferences 

(Editar>Preferencias) y  haga clic 

en Node (Nodo) bajo Tools.

Si las figuras son de formas 

básicas, aplique Convert to 

Curves.

Para cambiar la dirección, 

coloque esas figuras en 

una capa separada.

Haga clic en los elementos de 

la lista para ver el orden de 

los cortes.

Vaya a Windows>Attributes y  

cambie la dirección de la 

trayectoria.

Marque las opciones: Always 

show outline y  Show path 

direction in outlines 

Haga clic en el icono Shape 

Tool. 

Haga clic en la figura y el triángulo 

azul indicará la dirección del corte.
En C3, seleccione capa 

(layer), cambie Path 

Direction: normal a 

reversed.

Para cambiar la dirección, 

vaya a Path>Reverse Path

Figuras abiertas: 

No deben ser compuestas (haga 

clic derecho y seleccione 

Release Compound Path)

Haga clic en el icono Edit paths 

by nodes y  haga clic sobre la 

figura para ver la dirección de la 

trayectoria.

Para cambiar la dirección, haga 

clic derecho en el triangulo azul y  

seleccione Reverse Subpaths.

Haga clic en Pen Tool y  haga 

clic izquierdo donde la trayectoria 

debe terminar

Para cambiar la dirección, vaya 

a Path>Reverse.

*** Tenga en cuenta que la dirección de corte tambien puede ser cambiada en C3 para cualquier figura en particular, cambiando Path Direction de normal a  
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Capítulo 5   Utilizando las Herramientas de la Force y las Cabezas Duales 
 

 
5.01 Qué Son Las Cabezas Duales 

 
• Una de las características de la KNK Force es la capacidad de utilizar dos herramientas al mismo tiempo. 

Debido a que los asientos de la cuchilla en la Force son completamente ajustables, uno puede insertar una 
amplia gama de bolígrafos, marcadores, repujadores y otras herramientas. Sin embargo, cualquiera de las 
dos herramientas no estará necesariamente en las mismas posiciones relativas entre una y otra. Por 
ejemplo, si usted fuese a insertar un bolígrafo junto con el portacuchillas para una aplicación de "dibujar y 
cortar", usted podría terminar con esto: 

 
 
• Afortunadamente, un procedimiento de calibración fácil asegurará que las dos herramientas estén 

alineadas correctamente para el proyecto que usted desea hacer. Por lo tanto, después de esta calibración, 
el proyecto resultante se verá así: 

 
 
• Las herramientas cubiertas en este capítulo incluyen el grabador de la Force, grabador, punzón, y también 

el uso de marcadores y bolígrafos. Para obtener instrucciones sobre el uso de la herramienta rotatoria de la 
Force, consulte el Capítulo 7. 

 

 

 
5.02 Calibración de Dos Herramientas Para la Alineación 

 

 

• El proceso de calibración implica tener dos herramientas, que han sido insertadas en la Force, "dibujar" una 
figura de calibración. Tenga en cuenta que usted tendrá una calibración diferente para cada combinación 
de herramientas. Por ejemplo, una calibración para dos bolígrafos será diferente de una calibración para un 
portacuchillas y un bolígrafo. Y esa calibración será diferente de la de un portacuchillas y un grabador. Por 
lo tanto, planifique registrar cada calibración que realice para futuras referencias. De esta manera, los 
números para la calibración pueden simplemente ser mecanografiados en C3 cuando llegue el momento de 
utilizar esa combinación de dos herramientas. 

• Los números de calibración se almacenan en la parte superior de la pestaña Settings. Haga clic en 
Machine Settings. 

• Introduzca los siguientes valores para el X Offset y Y Offset:   

 

 

El círculo de corte exterior 

está alineado con el círculo 

dibujado por el bolígrafo 

El círculo de corte externo 

NO está alineado con el 

círculo dibujado por el 

bolígrafo 

Pulgadas: 

Centímetros: 

: 

https://vimeo.com/179395964
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• Haga clic en Apply Changes. Estos son valores típicos de desplazamiento X e Y para el uso del 
portacuchillas y la herramienta de grabar al relieve. También estos pueden ser utilizados como números de 
partida para otras combinaciones de herramientas, como dos bolígrafos o un bolígrafo y un portacuchillas.    

• En la Sección 2.06.1, se proporcionó un enlace a un archivo comprimido de figuras básicas. Dentro de esa 
carpeta de figuras hay una llamada AlignmentCalibration.svg. Abra ese archivo en C3. 

• Debido a que ambas capas son idénticas (dos signos de más agrupados), no es necesario mover ninguna 
de las capas. Sin embargo, al realizar una tarea como dibujar y cortar, o marcar y cortar, usted siempre 
quiere cortar último. Si éste es el caso, entonces la capa superior será para el bolígrafo o el grabador u otra 
herramienta y la capa más baja será para el portacuchilla: 

 

• Con la Capa 1 seleccionada, ingrese los ajustes de profundidad (depth) y velocidad (speed) a ser usada. 

• Ajuste la selección de herramientas (derecha o izquierda) haciendo clic en la ventana: 

 

    
 

• Haga clic en la capa 2 e ingrese la configuración de profundidad (depth) y velocidad (speed). Ajuste la 
selección de la herramienta, si es necesario.  

• Ajuste el Origen Z en cada herramienta. En este momento, la herramienta derecha irá a una ubicación 
diferente para establecer el origen. Simplemente levante las ruedas de presión y deslice el tapete para 
asegurarse de que la herramienta esté sobre el material o sobre el tapete, dependiendo de la aplicación. 
Además, recuerde bajar las ruedas de presión antes de ajustar este origen para que el tapete de corte esté 
plano. 

• Haga clic en Prepare This Cutting Job. Establezca el origen XY basado en la herramienta del lado 
izquierdo.  

• Realice el "corte" y usted debería ver la herramienta del lado derecho hacer la capa 1, seguida por la 
herramienta del lado izquierdo haciendo la capa 2.  Sin quitar el material del tapete, medir o estimar cuán 
lejos están las marcas de la herramienta en relación con las marcas de la herramienta del lado izquierdo. 

• Vuelva a Settings>Machine Settings y ajuste X o Y de acuerdo con estas reglas: 

 Si la herramienta derecha está dibujando demasiado a la izquierda, disminuya X                             
O Si la herramienta derecha está dibujando demasiado a la derecha, aumente X   

Haga clic aquí para cambiar a la herramienta de la derecha 

 

Capa 1 para herramienta alternativa 

 

Capa 2 para el portacuchillas 

 

Milímetros: 
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 Si la herramienta derecha está dibujando muy arriba, disminuya Y      O   Si la herramienta derecha 
está dibujando muy bajo, aumente Y  

 

• Recuerde también que: 

 Aumentar un número negativo hace que sea menos negativo (por ejemplo, de -1.5 a -1.4) 

 Disminuir un número negativo lo hace más negativo (por ejemplo, de -0.8 to -0.9) 

• Repita y ajuste X e Y hasta que usted tenga valores perfectos. Registre estos valores en caso de que usted 
necesite calibrar un conjunto diferente de herramientas. Además, tenga en cuenta cual herramienta estaba 
en el lado izquierdo y cual estaba en el lado derecho. ¡Esto es importante! 

 

 
5.03 Guías Generales al Utilizar Herramientas de Accesorios  

• Las herramientas de accesorio de la Force incluyen lo siguiente: grabadora, grabadora y perforadora 
(también conocida como herramienta de perforación). Estas guías también se aplican a otros accesorios, 
tales como bolígrafos misceláneos, marcadores, bolígrafos de pegamento y otras marcas de herramientas 
que encajarán en la Force. La herramienta rotativa de la Force está cubierta en el Capítulo 7. 

• Debido a que las puntas de estas herramientas de accesorios están centradas verticalmente con los ejes, 
el Blade Offset (BO) (desplazamiento de la cuchilla) siempre se establece en None (Ninguno).  
 

• Es una buena práctica mantener las ruedas de presión fuera de donde se aplicarán las herramientas de 
accesorios. Esto proporciona una superficie más uniforme y evita que las ruedas se manchen con tinta o 
pegamento cuando se utilizan esos tipos de artículos. Por lo tanto, mantenga las ruedas de presión 
externas en los bordes exteriores del tapete de corte y mantenga la rueda del centro en la posición hacia 
arriba. Alternativamente, usted puede mover la rueda de presión izquierda hacia el extremo izquierdo, dejar 
la rueda de presión derecha debajo del rectángulo más a la derecha, y luego mover la rueda de presión 
central a la posición de rectángulo más a la izquierda para asegurar el lado izquierdo del tapete. 

 

• La tabla al final de este capítulo contiene ajustes sugeridos para las pruebas iniciales. Recuerde que otros 
factores pueden afectar los resultados, como una marca diferente de papel, un tipo diferente de superficie 
debajo del material, una marca distinta de bolígrafo o marcador, etc. ¡Siempre haga pruebas primero! 

 

• Cuando usted descubra sus mejores ajustes, asegúrese de anotarlos en el formulario en blanco disponible 
más adelante en este capítulo.  
 

• Cuando se combina una herramienta accesoria con el portacuchillas, es aconsejable cortar a lo último. Así 
que, ordene las capas como se muestra en la Sección 5.02.   

  

• Los propietarios a menudo quieren tener sus figuras "llenas" cuando se utiliza una herramienta accesoria. 
La mayoría de los programas de diseño tienen sus propios métodos para lograr un patrón de relleno. 
Consulte la Sección 5.06 para obtener más detalles. 

  

 
5.04 Dibujar con un Bolígrafo o Bolígrafo de Pegamento 

 

  Demo:  

• La mayoría de los bolígrafos, marcadores, bolígrafos de pega, etc. pueden ser insertados directamente en 
el asiento del porta cuchilla de la Force. No es necesario apretar los dos tornillos siempre y cuando uno de 
ellos pueda agarrarse en una superficie vertical plana. 

• Para los bolígrafos de pegamento y bolígrafos, es mejor prepararlos (garabatear en papel de desecho) 
poco antes de montarlo para que la tinta o pegamento esté listo para fluir. Otra opción es tener una capa 
separada con una figura de prueba que será dibujada antes del proyecto. Esa figura se puede colocar para 
dibujarse en un trozo fuera del material principal que usted está utilizando para el proyecto. 

http://teamknk.com/?s="pen+holder"&submit=Search
https://www.youtube.com/watch?v=uauQLuIoJ6w
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• En la configuración sugerida al final de este capítulo, tome nota del ajuste más bajo para una punta ultra-
fina del Sharpie. Es muy fácil doblar estas puntas si el CD/ED está demasiado alto. Por lo tanto, comience 
con un ajuste muy bajo y dibuje una pequeña figura de prueba para ver si los resultados serán 
satisfactorios. Las velocidades más lentas también ayudan a obtener resultados más consistentes con 
marcadores. 

• Como con la mayoría de las otras herramientas accesorias, ajuste el origen Z utilizando la parte superior 
del material. Para evitar marcar el material de su proyecto, un desecho del material colocado en otra parte 
del tapete, puede ser utilizado para este propósito. 

  

 
5.05 Repujado y Rayado 

 

Repujado:    Rayado:     Grabado sobre Aluminio:   

• La Herramienta de Repujado de la Force tiene dos extremos. Un extremo es ligeramente más pequeño que 
el otro y útil cuando se raya papel o cartulina para los proyectos a plegar. El extremo más grande es más 
adecuado cuando se repuja al relieve en papel o cartulina para fines decorativos. 

• Al marcar, la superficie debajo del papel o cartulina puede ser el propio tapete de corte. Tenga en cuenta 
que, si sus líneas de rayado no son "profundas" en el reverso, entonces doble TODAS las líneas de rayado 
hacia delante primero. De la vuelta al proyecto y usted podrá entonces doblar cualquier línea rayada en la 
dirección opuesta fácilmente. Esto funciona muy bien con las tarjetas emergentes. 

• Para repujado, usted querrá algo suave debajo del material que permita una depresión más profunda 
cuando se presiona con una herramienta de gofrado. El material elegido a menudo es Revestimiento de 
estantería antideslizante. Otras opciones incluyen el foami, caucho del rhinestone, una tela gruesa, y fieltro. 
Estos materiales pueden ser presionados al propio tapete y aguantarlos con cinta adhesiva, según sea 
necesario. El papel o cartulina es entonces sujetado con cinta adhesiva a la parte superior del material 
acolchonado. 

•  Si usted está planeando repujar y cortar usando la función de doble cabeza en la Force, usted necesitará 
usar un material de superficie adecuado para el corte, que éste pueda tener un adhesivo reposicionable 
aplicado. En este caso, el revestimiento de estantería funcionaría mejor. 

• Al igual que con otras herramientas accesorias, ajuste el origen Z basado en la parte superior del material. 

• El uso de ajustes agresivos al marcar puede hacer que el tapete de corte se incline, dando como resultado 
que las líneas de corte ya no estén alineadas correctamente con las líneas de rayado. Aquí hay varias 
sugerencias para corregir este problema: 

 Reduzca la configuración de CD/ED y aumente las Pasadas. 

 Añada guías al tapete para estabilizar el tapete de corte. Consulte el Apéndice B4. 

 Cambie el Path Direction (dirección de la trayectoria) en líneas de rayado. Consulte la Sección 
3.02.10. 

 

 

 
5.06 Grabado  

 

   

• La Herramienta de Grabado de la Force puede ser utilizada para el grabado de líneas delgadas (aka rayar) 
en superficies tales como metales, pergamino, scratchboard y acrílico. Para un grabado más profundo y/o 
más grueso, considere la posibilidad de comprar la herramienta rotativa para la KNK Force. 

• Usted puede grabar en materiales que no pueden ser cortados en la KNK Force, tales como charms de 
joyería, placa de identidad para perros, y placas de trofeos. Usted deberá utilizar un método de alineación 

http://knkusa.com/product/force-embossing-tool/
http://www.duckbrand.com/products/shelf-liner-bath/non-adhesive-shelf-liner/solid-grip/white-12-in-x-7-ft
http://www.duckbrand.com/products/shelf-liner-bath/non-adhesive-shelf-liner/solid-grip/white-12-in-x-7-ft
http://knkusa.com/product/force-engraving-tool/
http://teamknk.com/?s=embossing&submit=Search
http://teamknk.com/?s=scoring&submit=Search
https://www.youtube.com/watch?v=ljLbZRIzRk4
http://cutterpunk.com/knk-force-engraving-tests/
http://teamknk.com/?s=engraving&submit=Search
https://www.youtube.com/watch?v=EdLXw9NIxwM&t=164s
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para asegurarse de que el grabado se coloca perfectamente en el elemento pre-cortado. Se proporcionarán 
instrucciones en una futura actualización de este manual. 

• El material a ser grabado debe ser sujetado con seguridad al tapete de corte y el origen Z configurado 
basado en la parte superior del material. 

• Para diseñar patrones de relleno, utilice lo siguiente:  

 MTC:     (Cubierto al comienzo del video del seminario web) 

 SCAL: Seleccione la figura, vaya a Efectos>Relleno de Línea, e introduzca los ajustes deseados: 

  

 Inkscape: Una extensión llamada “Eggbot” puede usarse para rellenar una figuraa con líneas: 

o Extension link: https://code.google.com/archive/p/eggbotcode/downloads 

o Blog post with details: http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-to-inkscape-
for-cutting.html 

 

 
5.07 Uso de la Herramienta de Perforación 

 

 

• La Herramienta de Ponche/Perforacion de la Force puede ser utilizada para crear diseños decorativos 
(como pergamino y otros artes en pergaminos) o para crear pequeños agujeros para bordado de papel. 

• Para proteger el tapete y el punzón fino, se recomienda utilizar un material blando y grueso como cojín 
entre el papel/cartulina y el tapete de corte. Los materiales sugeridos que funcionan bien incluyen el forro 
antideslizante para estantes, la espuma del arte, y goma para rhinestone. Presione el material suave al 
tapete y coloque cinta adhesiva en los bordes exteriores para protegerlo.  

• Si usted está planeando perforar y cortar usando la función de doble cabeza de la Force, usted tendrá que 
usar un material de superficie adecuado para el corte de modo que este pueda tener un adhesivo 
reposicionable aplicado. En este caso, el revestimiento de estantería funcionaría mejor. 

• A diferencia de otras herramientas accesorias, ajuste el origen Z basado en la parte superior de la 
superficie blanda versus a la parte superior del material que se está perforando.   

• Para diseñar un patrón de punzón, puede usarse la función de diamante de imitación en diversos 
programas vectoriales. Primero compruebe si hay un tamaño mínimo para los círculos. Para patrones de 
punzón, a mí me gusta usar ~ 0.016 "(~ 0.4 mm), pero en Make the Cut, el tamaño más pequeño es el 
doble de eso (0.032" o 0.8 mm). Mi solución es hacer que mi objeto sea dos veces su tamaño antes de 
aplicar la función de diamante de imitación y doblar el espaciado deseado. Después de aplicar la función de 
diamante de imitación, vuelvo a ajustar el diseño a la mitad y los agujeros ahora cortan con el tamaño y el 
espacio deseado. 

 
 
5.08 Usando Tres Herramientas en la KNK Force 

 
Digamos que usted tiene una tarjeta emergente que usted desea rayar y cortar, pero también desea usar un 
bolígrafo para escribir un saludo. Hay dos enfoques que pueden ser utilizados: 

https://code.google.com/archive/p/eggbotcode/downloads
http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-to-inkscape-for-cutting.html
http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-to-inkscape-for-cutting.html
http://knkusa.com/product/force-punchpiercing-tool/
http://www.duckbrand.com/products/shelf-liner-bath/non-adhesive-shelf-liner/solid-grip/white-12-in-x-7-ft
http://www.duckbrand.com/products/shelf-liner-bath/non-adhesive-shelf-liner/solid-grip/white-12-in-x-7-ft
https://www.youtube.com/watch?v=EdLXw9NIxwM&t=6s
https://vimeo.com/68701818
http://teamknk.com/?s=punch+tool&submit=Search
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• Return to Origin Method (Volver al método de origen): Más rápido para hacer, pero usted no puede 
quitar el tapete entre pasos y usted debe recordar cómo el origen fue establecido. Consulte la Sección 
5.08.1. 

• Registration Mark Method (Método de marca de registro): Más precisa y el tapete puede ser removido 
entre pasos, pero usted debe tener el portacuchillas calibrado para PNC. Consulte la Sección 5.08.2. 

 

 
5.08.1 Return to Origin Method (Volver al método de origen) 

 
Este ejemplo utilizará un bolígrafo para dibujar en el primer paso y luego usará un repujador y un portacuchillas 
en el segundo paso. 

 

Preparativos 

Si usted aún no lo ha hecho: 

• Calibre el porta cuchilla con el bolígrafo que desee utilizar para dibujar (porta cuchilla en el lado izquierdo, 
bolígrafo en el lado derecho). Anote los desplazamientos X e Y. 

• Calibre el mismo portacuchillas con la herramienta que usted utilizará para rayar (porta-cuchilla en el lado 
izquierdo, herramienta de puntuación a la derecha). Anote los desplazamientos X e Y. 

 

Asignar las Capas en el Archivo 

(1) En el programa de diseño, cree capas para cada herramienta y asigne las figuras a las capas apropiadas. 
Está bien tener más de una capa para una herramienta dada. Por ejemplo, con una tarjeta emergente, es 
posible que usted prefiera mantener los pliegues de la montaña y los pliegues del valle en capas 
separadas.  

(2) Aquí hay un ejemplo típico de MTC. Tenga en cuenta que nombrar claramente las capas las hará más fácil 
de activar/desactivar en C3 y evitar errores: 

 

(3) Una vez que las capas estén listas, exporte el archivo como SVG. 

 

Dibujar 

(1) Importe el archivo SVG en C3. Mueva las capas de plegado a la parte superior porque siempre es mejor 
rayar antes de cortar. Dado que el dibujo se hará por separado de la puntuación o el corte, no importa 
dónde este se enumere en el menú: 
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(2) Haga clic en Replace Right Tool y ubique el bolígrafo en el lado derecho. 

(3) Haga clic en Replace Left Tool y ubique el porta cuchilla en el lado izquierdo, aunque usted no cortará 
nada en esta etapa. 

(4) Vaya a Settings>Machine Settings e introduzca los desplazamientos de calibración X e Y para el 
bolígrafo. Haga clic en Apply Changes:  Estos resultan ser los míos: 

 

 

(5) Para las capas que serán cortadas y rayadas, apáguelas haciendo clic en Cut this layer: 

  

(6) Para la capa Pen, introduzca los ajustes (Passes, CD/ED, CS, etc.) que usted necesita para dibujar con el 
bolígrafo. Además, recuerde cambiar Cutting Tool a la derecha. Por ejemplo: 

 

(7) Haga clic en Prepare this cutting job. ¡IMPORTANTE! Antes de configurar el origen, tenga en cuenta la 
distancia de desplazamiento (Jog distance) utilizada y el número de pasos a la izquierda y hacia arriba o 
hacia abajo que usted está utilizando para llegar al origen deseado. Usted tendrá que repetir esto cuando 
usted haga el proceso de rayado y corte: 

Para cada capa de pliegue 

(rayado) y capa de corte, 

ajuste Cut this layer a no. 
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(8)  Haga clic en Continue para ejecutar el dibujo de la capa Pen.   

 

Rayado y Corte 

(1) Haga clic en Replace Right Tool, remueva el bolígrafo y ubique la herramienta de puntuación en el lado 
derecho. 

(2) Vaya a Settings>Machine Settings e introduzca los desplazamientos de calibración X e Y para la 
herramienta de puntuación. Haga clic en Apply Changes. Estos pasan a ser los mios: 

 

(3) Encienda las capas Fold (Doblar) y Cut (Cortar), cambiando a yes en Cut this layer (Cortar esta capa): 

   

 

(4) Haga lo mismo para la capa Pen (del bolígrafo), pero cambie Cut this layer a no. 

(5) Para cada capa, asigne los ajustes (Passes, CD/ED, CS,etc) a ser utilizados. Compruebe que Cutting tool 
(la herramienta de corte) está asignada right (a la derecha) para que las capas se marquen (las capas 
Fold arriba) y asignadas left (a la izquierda) las capas a ser corteadas. 

La capa Fold de ejemplo (recuerde asignarla al lado derecho (right): 

Para cada capa de pliegue 

(rayado) y capa de corte, 

establezca Cut this layer a 

yes. 

Tenga en cuenta Jog distance (la distancia de 

desplazamiento) utilizada para establecer el origen. 

Esta aparecerá cuando usted pase el ratón sobre el 

círculo azul. 



108 

 

 

La capa Cut de ejemplo (recuerde cambiar el Blade offset): 

 

(6) Haga clic en Prepare this cutting job (preparar este trabajo de corte). Asegúrese de que Jog distance (la 
distancia de desplazamiento) todavía está ajustada al mismo valor utilizado y, luego, ajuste el origen 
utilizando exactamente los mismos pasos. Haga clic en Continue para completar el proyecto. 

 

 
5.08.2 Método Marca de Registro4 

 
Este ejemplo utilizará un bolígrafo para dibujar en el primer paso y luego usará un embutidor y un portacuchillas 
en el segundo paso. Tenga en cuenta que las marcas de registro también se dibujarán con el bolígrafo. Si 
usted no está usando un bolígrafo o el bolígrafo es de un color muy claro, entonces imprima las marcas de 
registro desde software de diseño. 

 

Preparativos 

 
Si usted aún no lo ha hecho: 

• Calibre el portacuchillas con el bolígrafo que usted desee utilizar para dibujar (portacuchillas en el lado 
izquierdo; bolígrafo en el lado derecho). Registre los desplazamientos X e Y. 

• Calibre el mismo portacuchillas con la herramienta que usted utilizará para rayar (portacuchillas en el lado 
izquierdo; herramienta para marcar a la derecha). Grabe los desplazamientos X e Y. 

• Calibre la Force para imprimir y cortar usando este mismo portacuchillas (consulte las Secciones 6.03 – 
6.07). 

 

Asignando Capas en el Archivo  

(1) En el programa de diseño, cree capas para cada herramienta y asigne las figuras a las capas apropiadas. 
Está bien tener más de una capa para una herramienta dada. Por ejemplo, con una tarjeta emergente, es 
posible que usted prefiera mantener los pliegues de las montañas y los pliegues del valle en capas 
separadas. Eso está bien.  

(2) Asegúrese de utilizar uno de los archivos de Reg Mark (marcas Registro) que se proporcionan con los 
archivos de calibración para imprimir y cortar y mantenga esas marcas de registro en su propia capa. 

                                                 
4 Thank you, Lynn Stockberger, for the idea of using the Force to draw the registration marks! 
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(3) Aquí está un ejemplo típico de MTC. Tenga en cuenta que nombrar claramente las capas hará que sea 
más fácil encenderlas/apagarlas en C3 y evitar errores: 

 

(4) Una vez que las capas están listas, exporte el archivo como SVG. 

 

 

Dibujar 

(1) Importe el archivo SVG a C3. Mueva la capa Reg Mark a la parte inferior de la lista de capas. (NO asigne la 
capa Reg Mark. Esto se hará después de que las marcas de registro sean dibujadas.) Además, mueva las 
capas de plegado a la parte superior porque siempre es mejor marcar o rayar antes de cortar: 

    

 

(2) Haga clic en Replace Right Tool y ubique el bolígrafo en el lado derecho. 

(3) Haga clic en Replace Left Tool y ubique el portacuchilla en el lado izquierdo, aunque usted no cortará 
nada en esta etapa. 

(4) Vaya a Settings>Machine Settings e introduzca los desplazamientos de calibración (offset) X e Y para el 
bolígrafo. Haga clic en Apply Changes:  Estos pasan a ser los míos: 

 

 

(5) Para las capas que serán cortadas y anotadas, apague haciendo clic en Cut this layer: 
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(6) Para la capa Pen y las capas de Reg Marks, ingrese los diversos ajustes (Passes, CD/ED, CS, etc.) que 
usted necesita para dibujar con el bolígrafo. Además, recuerde cambiar Cutting Tool a right para ambas 
capas. Por ejemplo: 

 

(7) Haga clic en Prepare this cutting job y ejecute el dibujo de las capas Reg Marks y Pen.   

 

 

Rayado y Corte 

(1) Haga clic en Replace Right Tool, remueva el bolígrafo y ubique la herramienta de puntuación en el lado 
derecho. 

(2) Vaya a Settings>Machine Settings e introduzca los desplazamientos de calibración X e Y para la 
herramienta de puntuación. Haga clic en Apply Changes. Estos pasan a ser los míos: 

 

(3) Regrese a la pestaña Cut y haga clic en Advanced Settings y asigne la capa Reg Marks a Print-and-cut 
registration layer: 

 

 

(4) Para las capas Fold y Cut, activelas cambiando a yes en Cut this layer: 

Para cada capa de pliegue 

(rayado) y capa de corte, 

ajuste Cut this layer a no. 
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(5) Haga lo mismo para la capa Pen, pero cambie Cut this layer a no. 

(6) Para cada capa, asigne la configuración (Passes, CD/ED, CS, etc) a ser usada. Verifique que Cutting tool 
está asignado a la derecha (right) para las capas a ser rayadas y asignado a la izquierda (left) las capas a 
ser cortadas. 

Ejemplo de la capa Fold (Doblar), recuerde asignarla al lado derecho: 

 

 

Ejemplo de la capa Cut (corte), recuerde cambiar el Blade offset (desplazamiento de la cuchilla): 

 

(7) Haga clic en Prepare this cutting job (Preparar este trabajo de corte). Alinee el centro del porta-cuchilla 
sobre la marca de registro inferior derecha y, desde este punto hacia adelante, use el mismo procedimiento 
que para una aplicación de impresión y corte para alinear el "+" rojo a la esquina de cada marca.  

 

 
5.09 Revisión del Capítulo 5 

 

 
5.09.1 Cosas a Tener en Cuenta  

•            Para diseñar patrones de relleno para grabado (Sección 5.06):  

Para cada capa de pliegue 

(rayado) y capa de corte, 

ajuste Cut this layer a yes. 

https://www.youtube.com/watch?v=EdLXw9NIxwM&t=164s
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 MTC:  (Cubierto en el inicio del video webinar) 

 SCAL: Seleccione la figura, vaya a Effects>Line Fill, e introduzca los ajustes deseados: 

 Inkscape: Una extensión llamada Eggbot puede usarse para rellenar una figura con líneas: 

o Enlace de extension: https://code.google.com/archive/p/eggbotcode/downloads 

o Publicación de Blog con detalles: http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-
to-inkscape-for-cutting.html 

 

 
5.09.2 Guía Rápida: Calibración de Dos Herramientas Para la Alineación 

(1) Abra el AlignmentCalibration.svg proporcionado en el archivo comprimido Basic Shapes de la Sección 
2.06.1. 

(2) En la Sección 2.06.1, se proporcionó un enlace a un archivo comprimido de Figuras básicas (Basic 
Shapes). Dentro de esa carpeta de figuras hay una llamada AlignmentCalibration.svg. Abra ese archivo en 
C3. 

(3) Haga clic en Layer 1 e ingrese la configuración que desea usar. Asignar al lado derecho (Right). 

(4) Haga clic en Layer 2 e ingrese la configuración que desea usar. Asignar al lado izquierdo (Left).  

(5) Establecer el origen Z en cada herramienta.  

(6) Haga Clic en Begin This Cutting Job.  Establecer el origen XY basado en la herramienta de la izquierda.  

(7) Realice el "corte" y usted debe ver que la herramienta del lado derecho ejecuta la capa 1 (Layer 1), seguida 
por la herramienta del lado izquierdo realizando la capa 2 (Layer). Sin quitar el material del tapete, mida o 
estime cuán lejos las marcas de la herramienta derecha son relativas a la Marcas de la herramienta 
izquierda. 

(8) Regrese a Settings>Machine Settings y ajuste X o Y de acuerdo con estas reglas: 

 Si la herramienta derecha está dibujando demasiado a la izquierda, disminuya X                 O Si la 
herramienta derecha está dibujando demasiado a la derecha, aumente X   

 Si la herramienta derecha está dibujando demasiado arriba, disminuya Y   O Si la herramienta 
derecha está dibujando demasiado abajo, aumente Y  

(9) También recuerda que: 

 Aumentar un número negativo hace que este sea menos negativo (p.ej. de -1.5 a -1.4) 

 Disminuir un número negativo lo hace más negativo (p.ej. de -0.8 a -0.9) 

(10)  Repita y ajuste X e Y hasta que usted tenga valores perfectos. Registre esos valores. 

 

 
5.09.3 Guía rápida: Tres herramientas - Volver al método de origen 

(1) Mover las capas de puntuación sobre las capas de corte. 

(2) Ubique el porta-cuchilla en el lado izquierdo, bolígrafo al lado derecho. 

(3) Introduzca los números de calibración para el bolígrafo en Settings>Machine Settings. 

(4) Desactivar las capas para el rayado (score) y corte. 

(5) Introduzca los ajustes del bolígrafo (Passes, CD, CS, etc) para la capa de dibujo. 

(6) Tenga en cuenta Jog distance y los pasos utilizados para establecer el origen. 

(7) Ejecutar el dibujo. 

(8) Reemplazar el bolígrafo con la herramienta de puntuación en el lado derecho. 

(9) Introduzca los números de calibración de la herramienta de rayado en Settings>Machine Settings. 

(Resumen de la Sección 5.02) 

(Resumen de la Sección 5.08.1) 

https://code.google.com/archive/p/eggbotcode/downloads
http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-to-inkscape-for-cutting.html
http://susanbluerobot.blogspot.com.au/2012/03/eggbot-hatching-to-inkscape-for-cutting.html
https://vimeo.com/68701818
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(10)  Encienda las capas de rayado (score) y corte (cut); Apague la capa del Bolígrafo. 

(11)  Para las capas doblar (fold): introduzca los ajustes y asigne la Herramienta de Cortar al lado derecho.  

(12)  Para las capas cortar (cut): introduzca los ajustes y encienda Blade Offset. 

(13)  Fije el mismo origen usado anteriormente. Ejecutar el rayado y el corte.  

 

 
5.09.4 Guía rápida: Tres herramientas - Método de marca de registro 

(1) Mover la capa Reg Mark hacia abajo.  Mover las capas de rayado (score) sobre las capas de corte (cut). 

(2) Ubique el porta-cuchilla en el lado izquierdo, bolígrafo en el lado derecho. 

(3) Introduzca los números de calibración del bolígrafo en Settings>Machine Settings. 

(4) Apague las capas score y cut. 

(5) Introduzca los ajustes para el bolígrafo (Passes, CD, CS, etc) para ambas capas; pen y reg mark (bolígrafo 
y marcas de registro). 

(6) Ejecute el dibujo. 

(7) Reemplace el Bolígrafo con la herramienta para rayar en el lado derecho. 

(8) Introduzca los números de calibración de la herramienta de puntuación en Settings>Machine Settings. 

(9) Haga clic en Advanced Settings y asigne la capa Reg Mark. 

(10)  Encienda las capas Score (rayado) y cut (corte); Apague la capa del bolígrafo. 

(11)  Para las capas doblar (fold): introduzca los ajustes y asigne Cutting Tool al lado derecho (Right).  

(12)  Para las capas cortar (cut): introduzca los ajustes y encienda Blade Offset. 

(13)  Ejecutar el rayado y el corte.  

  

(Resumen de la Sección 5.08.2) 
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Formulario de Configuración para Herramientas de Accesorio de Force 1 

 
 
 
 
 
 

Tipo de Material, 

Marca, Espesor
Aplicación Herramienta Superficie P SD CD/ED CS PS Otros Ajustes y Comentarios

 
© 2015- 2017 Sandy McCauley, All Rights Reserved 

 

Aplicación: Dibujo, Grabado al Relieve, Debossing, Rayado, Grabado, Perforación, etc. 

Herramienta: Bolígrafo, Bolígrafo Pegameno, Grabador/punta pequeña; Grabador/punta grande; Grabador, Perforador, etc 

Superficie: Tapete, Foami sobre tapete, Revestimiento de estantería sobre el tapete, etc. 

Ajustes: P – Pasadas; SD – Profundidad Inicio; CD/ED: Profundidad Corte/Profundidad final; CS – Velocidad Corte; PS – 

Velocidad de Hundimiento 
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Configuraciones Sugeridas Para Varios Accesorios de la Force1 
 

 

 

 

Suggested Settings for Various Force Accessories
1

Material Aplicación Herramienta Superficie P SD CD/ED CS PS Otros Comentarios

Papel Dibujar
Bolígrafo 

Prueba
Tapete 1 35 25 40

Cartulina Dibujar
Sharpie: 

punta ultra 
Tapete 1 1 - 5 20 15

Utilice un PS bajo para proteger la delicada punta; 

Hacer pruebas con CD bajo e ir aumentado.

Cartulina - Neenah 65lb Rayar

Grabador en 

reliev e - 

punta 

pequeña

Tapete 3 95 25 40

Cartulina - Neenah 80lb Rayar

Grabador en 

reliev e - 

punta 

pequeña

Tapete 2 100 25 40

WorldWin CutMates Rayar

Grabador en 

reliev e - 

punta grande

Forro de 

Estante 

Duck

2 70 25 30
No utilice la rueda de presión del centro; Mantenga 

las ruedas lejos

Cartulina - C&C 

Tablero Espejo: 250 gm 
Debossing

Grabador en 

reliev e - 

punta 

pequeña

Tapete 1 100 20 30 C&C: Create & Craft; vendido en UK

Cartulina - C&C 

Pearlescent Bright 

Burst: 250 gsm 

Debossing

Grabador en 

reliev e - 

punta 

pequeña

Tapete 1 80 20 30 C&C: Create & Craft; vendido en UK

Cartulona - First 

Edition: 216 gm
Debossing

Grabador en 

reliev e - 

punta 

pequeña

Tapete 1 80 20 40 C&C: Create & Craft; vendido en UK

Cartulina - Darice 

Coordinates

Grabado en 

relieve

Grabador en 

reliev e - 

punta 

pequeña

Tapete 2 95 25 40

Cartulina - Neenah 65lb
Grabado en 

relieve

Grabador en 

reliev e - 

punta grande

Forro de 

Estante 

Duck

3 110 35 40
No utilice la rueda de presión del centro; Mantenga 

las ruedas lejos

Cartulina - Neenah 80lb
Grabado en 

relieve

Grabador en 

reliev e - 

punta grande

Forro de 

Estante 

Duck

3 115 35 40
No utilice la rueda de presión del centro; Mantenga 

las ruedas lejos

Aluminio Grabar Grabador Tapete 4 40 30 40 PS y LS = 20

Settings: P – Passes; SD – Start Depth; CD/ED: Cut Depth/End Depth; CS – Cut Speed; PS – Plunge 

 
 

 

 

 

 

Ajustes: P – Pasadas; SD – Profundidad Inicio; CD/ED: Profundidad Corte/Profundidad final; CS – Velocidad Corte; PS – Velocidad de Hundimiento 



116 

 

 
1 © 2015, 2016, 2017 Accugraphic Sales, Inc., All Rights Reserved 
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Capítulo 6  Impresión y Corte   
 

Demo:  

 
6.01 ¿Qué es una impresión y corte (PNC)? 

• El proceso de impresión y corte consiste en imprimir una imagen desde su software de diseño a cualquier 
impresora que poseas y luego, con la ayuda de una cámara y un ojo electrónico en la Force, cortar la 
imagen o imágenes con una precisión perfecta. 

• La cámara se encuentra en el pequeño saliente entre las cabezas laterales izquierda y derecha de la Force: 

 

• A continuación, se presentan tres tipos comunes de aplicaciones de impresión y corte. Hay más ejemplos 
de éstos, así que asegúrese de revisar las futuras subsecciones de este capítulo: 

  La línea de corte es a lo largo del borde actual de la imagen(es) impresa(s): 

      

 

 La línea de corte está fuera del borde, pero sigue la forma de la imagen (imágenes) impresa. Este también 
es comúnmente referido como un corte de contorno: 

     

 

 La línea de corte sigue una forma diferente de la imagen(es) impresa(s): 

                 

¡Incompleto! 

La imagen es precisamente 

cortada a lo largo de los bordes 

impresos. 

La imagen es cortada en la 

misma figura, pero desplazada 

fuera de los bordes impresos. 

 Una figura personalizada es 

cortada alrededor de la imagen 

impresa. 

Cámara/Localización del Ojo 

Electrónico 

https://www.youtube.com/watch?v=BiBfwy9HM_4
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6.02 ¿Qué es una calibración PNC? 

 

 

• Para obtener resultados precisos con el PNC, usted debe ajustar la calibración de la cámara5 . Esto no es 
nada más que determinar cuán lejos la cámara está localizada respecto a la punta de la cuchilla. Debido a 
que la cámara está instalada manualmente, la distancia desde el centro de la cámara a la punta de la 
cuchilla variará un poco de una Force a otra. Además, usted querrá utilizar el mismo porta cuchilla con 
todas las aplicaciones PNC, ya que la distancia podría cambiar con ligeras diferencias en los porta 
cuchillas. 

 La distancia es medida en una dirección X y en una dirección Y, donde X es cuán lejos el extremo derecho 
del centro de la cámara es localizado con relación a la punta de la cuchilla. Entonces Y es cuán lejos hacia 
delante el centro de la cámara es localizado relativamente a la punta de la cuchilla.  

• Estos números de calibración son introducidos bajo Settings>Machine Settings.  Ellos son llamados el 
desplazamiento (offset) X y Y para el ojo electrónico: 

 

• Los desplazamientos (offset) actuales en la configuración pueden ser en pulgadas y, por lo tanto, un 
número mucho menor de lo que es mostrado arriba. En el ejemplo anterior, los números son en unidades 
de mm. Es muy recomendable que mm sea utilizado durante el proceso de calibración. Esto se discutirá 
más adelante en este capítulo 

• El proceso de calibración consiste en realizar y repetir un PNC para ver cuánto usted necesita ajustar los 
valores de X y Y con el fin de obtener un resultado perfecto. ¡Y usted DEBERIA ser capaz de obtener una 
impresiones y cortes (PNC’s) perfectos!) 

 

 
6.03 Lo Que Usted Necesita Para Calibrar 

• ¡Usted necesita estar bien descansado! Usted no desea comenzar a aprender el proceso de PNC cuando 
se encuentre cansado, estresado, o en un apuro. El dominio de una PNC viene cuando usted tiene el 
tiempo para repetir esto alrededor de 4 veces consecutivas. En ese momento, usted no sólo ha repetido el 
proceso suficientes veces como para sentirse muy cómodo con el orden de los pasos, pero usted tendrá su 
calibración perfeccionada y entonces estará listo(a) para hacer un futuro PNC de forma rápida y con 
facilidad. 

• Luego, usted necesitará los siguientes productos: 

 Programa de Diseño, tales como Make The Cut, Sure Cuts A Lot, Inkscape 

 Impresora 

 Porta Cuchilla 

 Papel de Copia/impresora 

 Archivo de Calibración (disponible aquí: http://cutterpunk.com/files/knk/BasicShapes.zip) 

 

 
6.04 Imprimiendo el Archivo de Calibracion 

• Dentro de la carpeta Basic Shapes (Figurass básicas), usted encontrará los siguientes cuatro archivos 
entremezclados con los otros archivos:  

                                                 
5 Para el resto de este capítulo, la cámara y el ojo electrónico serán referidos simplemente como cámara.  

http://cutterpunk.com/files/knk/BasicShapes.zip
https://www.youtube.com/watch?v=Gk0dVQRjQ6Y
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• Los dos primeros archivos (llamados “4 Arrows PNC Calibration”) se usan para calibrar la ubicación de la 
cámara con respecto a la punta de la cuchilla. Note que uno está configurado para la impresión A4 y el otro 
para impresión tamaño Carta (8.5" x 11").  

• Los dos archivos inferiores (llamados “KNK Reg Marks”) se utilizan para todas las aplicaciones de PNC una 
vez usted haya completado la calibración. Al igual que con los dos primeros archivos, se ha establecido uno 
para uso A4 y uno para uso tamaño carta. Tenga en cuenta que, en su aplicación futura, cualquier archivo 
puede ser modificado, en cierta medida, para trabajar con su opción de tamaño de papel. Consulte las 
Secciones 6.10 y 6.11 

• Para comenzar, abra el software para impresión (por ejemplo, MTC, SCAL, o Inkscape ) y lea las 
instrucciones en la siguiente sección correspondiente. Si usted está utilizando Illustrator o Corel Draw, 

usted ya debe estar familiarizado con el procedimiento para importar un SVG e imprimirlo. 

 

 

 

 

 

 

 

 

 

 

 

 
6.04.1 Imprimiendo desde Make the Cut 

(1) Importe el archivo de calibración y posiciónelo en el Tapete Virtual (Virtual Mat): 

 

(2) Al importar un SVG en MTC, las capas no permanecerán separadas. En el caso del archivo de calibración, 
usted sólo está utilizando MTC para imprimir y no estará re-exportando el archivo ya que éste está listo 
para importarlo a C3. Solo note que, si usted fuera a hacer cualquier cambio al archivo en MTC, entonces 
usted necesitaría poner las marcas de registro en su propia capa. Esto es cubierto en la Sección 6.10. 

Importante: Siempre mueva todas las figuras a la vez de 

modo que las figuras no queden desalineadas con las 

marcas de registro.   

¡Importante! 

(1) No imprima el archivo desde su navegador. ¡Se imprimirá en un tamaño incorrecto! 
Por favor, use uno de los tres programas enumerados en las siguientes secciones. 

(2) En este momento, imprima sólo el archivo. No modifique el archivo de calibración y 
re-exporte el mismo. Usted tendrá que leer algunas de las instrucciones en la 
Sección 6.10 – 6.12 para entender los "Qué hacer y no hacer" en el diseño de sus 
propios archivos PNC. El archivo de calibración proporcionado está listo para ser 
abierto en C3.    
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(3) El color del Tapete Virtual (Virtual Mat) puede afectar el color de las marcas de registro impresas. Para 
asegurarse que ellas están negras, cambie el color a Contrast. Usted podría querer hacer otros cambios y 
luego grabar estos como ajustes pre-determinados o por defecto: 

 

(4) Luego, vaya a File>Print Setup, seleccione la impresora que planea usar, el tamaño del papel, y la 
Orientación:  

 

(5) Luego, vaya a File>Print Options y marque las siguientes dos opciones. Note que usted no necesita usar 
las marcas de registro de MTC.  

  

(6) “Show Paper on Mat” le ayudará a asegurarse de que las figuras están en el lugar adecuado en el tapete 
virtual.  “Print Shape Outlines” son necesarias para que las marcas de registro sean impresas.  

(7) Después de hacer clic en OK, usted debería ver los bordes verdes en el Tapete Virtual, indicando dónde 
las figuras serán impresas. Si cualquier parte del archivo se encuentra fuera de los bordes verdes, mueva 
todo junto de modo que todas las figuras caigan dentro de los límites: 

 

 

Información acerca de la 

configuración de su impresora es 

mostrada aquí. 

Las líneas verdes entrecortadas 

indican la parte de la pantalla que 

será impresa.  

Algunas de las figuras están fuera de los 

límites verdes de impresión. 

Todas las figuras han sido movidas juntas de 

modo que todas caen dentro de las líneas 

entrecortadas verdes. 

Seleccione Orientación 

Seleccione su impresora 

Presione OK cuando haya 

terminado 

Verifique el tamaño del 

papel 

Presione OK Cuando haya 

terminado 

Marque estas dos 

opciones 

Cambie a Contrast 

 

Presione aquí para establecer por 

defecto 
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(8) Vaya a File>Print Preview y usted será capaz de ver las flechas más las cuatro marcas de registro que 
deben estar alineadas con los límites de las flechas: 

    

(9) Siempre asegúrese de que usted puede ver las cuatro marcas de registro antes de continuar, ya que son 
una parte integral del proceso de PNC. Si la vista previa de impresión coincide con la de arriba y usted ve 
las cuatro marcas, haga clic en el botón Imprimir (Print). 

(10)  Es posible que desee imprimir varias (5 o 6) copias, ya que querrá repetir este proceso varias veces con el 
fin de obtener sus configuraciones de calibración perfectas. 

(11)  Usted ahora está listo para la Sección 6.05. Después de completar el proceso de calibración, vaya a la 
Sección 6.10 para aprender cómo configurar sus propios archivos PNC en MTC 

 
6.04.2 Imprimiendo desde SCAL 

(1) Importe el archivo de calibración en SCAL y coloque dentro de la esquina superior izquierda del tapete 
cuadriculado: 

Presione aquí para 

imprimir. 

Compruebe cuidadosamente esta 

pre-visualización 

 

¿Ve usted las cuatro marcas de 

registro? 

 

¿Estará usted recibiendo lo que 

necesita imprimir?  
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(2) Si usted desea tener el contorno de las flechas para la impresión, entonces, seleccione la capa y haga clic 
en el icono “Fill and Stroke”. Cambie el trazo de “None” a Color y luego haga clic en el cuadro de la 
derecha de este para abrir un menú de selección de color. 

     

 

 

(3) Vaya a File>Print Setup, seleccione la impresora que deseas usar, el tamaño del papel, y la Orientacion:   

 

Clic aquí para 

abrir la ventana 

Fill and Stroke  

Cambie el 

Color 

Clic aquí para 

abrir un menu 

de color. 

Importante: Siempre mueva todas las figuras a la misma 

vez, para que las figuras no queden desalineadas con las 

marcas de registro. 

Las flechas ahora tendrán una 

línea finita negra como borde 

Escoja la Orientación 

Seleccione su 

impresora 

Clic OK cuando termine. 

Verifique el tamaño 

del papel 
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(4) Vaya a File>Print y presione OK. Es posible que desee imprimir varias (5 o 6) copias, ya que tendrá que 
repetir este proceso varias veces con el fin de obtener sus configuraciones de calibración perfectas. Haga 
clic en Aceptar cuando esté listo para imprimir  

(5) Usted ahora está listo para la Sección 6.05. Después de completar el proceso de calibración, vaya a la 
Sección 6.11 para aprender cómo configurar sus propios archivos PNC en SCAL. 

 

 
6.04.3 Imprimiendo desde Inkscape 
 
(1) Abra el archivo de calibración en Inkscape usando File>Open (NO use File>Import. Refiérase a la Sección 

6.12.1). Vaya a File>Document Properties y, bajo Page Size, seleccione el tamaño que usted estará 
usando para imprimir: 

 

(2) Las figuras lo más probable estén alineadas a lo largo de una esquina. Seleccione todo y muévalo hacia el 
centro del área del documento: 

     
(3) Si usted desea tener el contorno de las flechas, entonces seleccione esa capa y vaya a Object>Fill and 

Stroke.  En el lado derecho de la pantalla, usted verá los ajustes Fill and Stroke. Presione sobre la 
pestaña Stroke paint y haga clic en el icono Flat color: 

  
(4) Presione sobre la pestaña Stroke style y entre el grosor deseado para el borde. Para propósito de 

calibración, use un grosor pequeño: 

Clic en Stroke 

paint 

Luego entre los valores 

RGB deseados. Para negro, 

ajuste todo a 0. 

Seleccione el tamaño que 

usted estará usando para su 

impresión. 
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(5) Vaya a File>Print y, si es necesario, cambie los ajustes de su impresora presionando en Preferences.  

Luego haga clic en Print. 

(6) Ahora usted está listo para la Sección 6.05. Después de completar el proceso de calibración, vaya a la 
Sección 6.12 para aprender cómo configurar sus propios archivos PNC en Inkscape. 

 

 
6.05 Preparándose para cortar 

 

 

(1) Asegúrese de que está utilizando la versión C3 0.5.16 o posterior. IMPORTANTE: no utilice Internet 
Explorer para el proceso PNC. No funciona correctamente. En su lugar, se recomienda Google Chrome o 
Firefox. 

(2)  Abra C3 e importe las mismas 4 flechas del archivo de calibración PNC que usted utilizó para imprimir. 

 

 

(3)  Haga clic en Advanced Settings. Desde el menú de Print-and-cut registration layer, seleccione el 
nombre de la capa que tiene las marcas de registro (Reg Marks):  

Clic en Stroke 

style Ingrese el ancho 

deseado 

Las fechas ahora 

tendrán una línea negra 

fina como borde. 

Las marcas de registro en un 

proyecto PNC siempre 

necesitan estar en su propia 

capa 

https://www.youtube.com/watch?v=HexQmCYPXcQ
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(4) Para la capa con las Flechas, introduzca los ajustes de corte necesarios para el corte de papel. Los ajustes 
comunes son 1 pasada en un CD de 70 (BT = 1.0). IMPORTANTE: Utilice un CS y US de 20. PNC 
(impresión y corte) son siempre más precisos con velocidades más lentas. Nota: Con sus propias pruebas, 
usted puede encontrar que velocidades más altas todavía darán resultados precisos o usted puede 
encontrar que velocidades más bajas serán necesarias. Esto depende del material a ser cortado y el 
número de repeticiones en la página. 

(5) No es requerido hacerle ajustes a la capa “Reg Marks”. De hecho, después de estas haber sido asignadas, 
Layer Settings (los ajustes de capa) ya no aparecerán y usted debería ver esto: 

 

 

(6) Las calibraciones PNC son más fáciles de hacer cuando se trabajan en milímetros. Esto se debe a que sólo 
tiene que ajustar a ± 0.1 mm para obtener un resultado preciso. Esto es más fácil que tratar de ajustar al 
0.004” más cercano". Vaya a Settings>Basic Settings y asegúrese que las Unidades se encuentran en 
Milímetros. Luego, haga clic en Apply Changes. 

(7) Los números de calibración se introducen en Settings>Machine Settings. Ellos son llamados el offset X y 
Y for electronic eye: 

 

(8) Usted puede comenzar con cualquiera de los valores predeterminados o utilizar un promedio de los 
probados (como se muestra arriba). Haga clic en Apply Changes si usted utiliza nuevas entradas o datos. 
Luego, regrese a la pantalla principal C3. 

(9)  Coloque el porta cuchilla, si es necesario. Luego, haga clic en Prepare this cutting job. 

 
6.06 Realizando la Alineación de Registro 

 
El proceso general es tener el porta-cuchilla cerca de cada marca y, luego, la cámara envía una foto de la 
pantalla para ajustar la alineación. Si usted hace el esfuerzo, en el inicio, tener el porta cuchilla centrado sobre 
la esquina inferior derecha de la marca de registro impresa, hace que el resto del proceso vaya mucho más 
rápido. Además, no tiene una luz brillando en la impresión, ya que puede decolorar las marcas de registro 
impresas y hacer más difícil la alineación. 

(1) Coloque la copia impresa sobre el tapete y alinéelo con el cuadriculado. Usted parado de frente a la Force, 
la impresión debería estar en el tapete en una orientación vertical con la flecha apuntando hacia el final del 
extremo derecho. Es importante tener la impresión bastante recta para que la cámara sea capaz de 
moverse dentro de una distancia determinada en el objetivo. Lo mismo va al insertar el tapete en la Force -  
alinee lo más recto posible, utilizando las ranuras horizontales en la misma Force. 

Este comentario aparece 

después de asignar marcas  

de Registro en el paso (3). 
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(2) Mueva la cabeza de modo que el medio del porta cuchilla esté centrado sobre la esquina inferior derecha 
de la marca de registro. Mire directamente hacia abajo sobre el porta cuchilla para que pueda asegurarse 
de que está en el centro. Esto no es fácil al principio, pero la práctica mejorará su precisión. Usted puede 
utilizar las flechas en la pantalla en C3 para mover la cabeza y el tapete. Sin embargo, yo realmente 
encuentro más fácil mover manualmente el tapete a la utilización de las teclas de flecha por lo que no tengo 
que ir y venir a mi computadora u ordenador: 

                 

(3) Después de hacer clic en Continue, la cámara enviará una imagen para C3. En la pantalla de su 
computadora (o dispositivo inteligente), haga clic en la esquina de la marca de registro y la "+" roja saltará a 
esa ubicación. Luego, utilice las teclas de flecha para alinear perfectamente el centro de la "+" roja con la 
marca de registro: 

     
 

(4) Si usted no puede ver la esquina de la marca de registro en la imagen de la cámara, note en qué dirección 
la cámara necesita ser movida y luego haga clic en Move camera. En el ejemplo siguiente, usted puede 
decir que la cámara tiene que moverse hacia arriba y hacia la izquierda, ya que sólo una pequeña parte de 
la marca de Registro es visible en la esquina superior izquierda. 

 

 

 

 

 

1. Asegúrese de 

que el porta 

cuchilla esté 

centrado con la 

parte vertical de las 

marcas de registro. 

 

2. Luego, deslice con 

cuidado el tapete hacia 

atrás y asegúrese que el 

porta cuchilla está 

centrado con la parte 

horizontal de la marca 

de registro. 

. 

 

1. Coloque la impresión en el 

tapete con las flechas 

apuntando a la derecha. 

 

2. Inserte el tapete en la Force con 

este triángulo apuntando en 

sentido opuesto a usted. 
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(5) Después de hacer clic en Move camera, usted de nuevo será llevado a la pantalla anterior. ¡Mueva el Jog 
distance al incremento más pequeño! Luego, haga clic una o dos veces en las direcciones necesarias. Esto 
no requiere muchos clics para mover una distancia larga relativo con el tamaño de la imagen ampliada 
proyectada por la cámara: 

 

(6) La marca de registro es ahora claramente visible y la "+" roja puede ser movida a la esquina de la marca de 
registro. Una vez alineados, haga clic en Continue. 

       

(7) Repita con las otras dos marcas de registro.  

(8) Una vez haya completado las tres, la cabeza volverá a su posición original para corregir la dirección de la 
cuchilla y luego procederá a cortar las figuras.  

 

 

 
6.07 Ajustando Desplazamiento X y Y para el Ojo Electrónico  

(1) Después que la impresión y el corte esté completado, examine cómo las líneas de corte fueron hechas con 
respecto a las líneas impresas. Si el desplazamiento es lo suficientemente grande, utilice una regla métrica 
para medir. Si el desplazamiento es muy pequeño, sólo la estimación estará bien si usted refina su 
calibración. 

(2) En el siguiente diagrama, las líneas rojas representan las líneas de corte y las líneas negras representan 
las líneas impresas. Utilice este diagrama para determinar si los valores de Offset (desplazamiento) tienen 
que subir o bajar de su láser: 

 

 

La marca de 

registro es apenas 

visible en la 

esquina superior 

izquierda 

 

1. Ajuste Jog 

distance a 1 

 

2. Clic una o dos veces 

en la dirección en que 

la cámara debería ser 

movida 

3. Clic en Continue 
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(3) Modifique el desplazamiento X y Y para el ojo electrónico en Settings>Machine Settings. Comience con 
ajustes de 1 mm (como se muestra arriba). Haga clic en Apply Changes antes de salir de esta ventana. 

(4) Es buena idea mantener un monitoreo de los valores anteriores de modo que usted sepa en qué dirección 
cambiar las calibraciones de pruebas subsiguientes. Recuerde que usted debe esperar obtener resultados 
perfectos, así que manténgase ajustando esos valores X y Y hasta que llegue allí. Después de ajustar por 1 
mm, usted tendrá que ajustar a 0.5 mm. Luego, aún más pequeño. Una vez que está ajustando a 0.1 mm, 
usted debe ser capaz de lograr los ajustes óptimos. Si todavía está fuera "sólo un pelo" en una dirección u 
otra, entonces ajuste por un final de 0.05 mm. 

(5) Durante la prueba, usted puede encontrar que un lado está alineado pero el otro no lo está. Por ejemplo, la 
línea de corte puede estar perfectamente alineada con la línea impresa en el lado inferior de la flecha, pero 
un poco por encima de la flecha a lo largo del lado superior. Ajuste la calibración basado en el lado que 
está fuera. 

(6) Si usted encuentra que una o dos flechas están perfectas pero las otras están fuera: 

 Verifique los ajustes CS y US. Velocidades muy altas pueden causar inexactitudes. 

 Asegúrese que las ruedas de presión están centradas bajos los rectángulos grises.  

 Asegúrese de que la parte inferior del Tapete, las ruedas de presión, y los ejes de grano están limpios. 

 Asegúrese de que nada está interfiriendo con el buen desplazamiento del tapete. 

 Asegúrese que la cuchilla no está cortando demasiado profundo en el tapete. Baje el CD, si es 
necesario. 

(7) Una vez que tenga su calibración completada, anote estos desplazamientos X y Y. Si usted prefiere volver 
a usar pulgadas, entonces, vaya a Settings>Basic Settings y cámbielo. Ya no es necesario trabajar en 
mm.  

 

 
6.08 PNC Automático     
       

• Antes de utilizar la función Auto PNC, complete los siguientes requisitos:  

 Lea y complete los pasos en las Secciones 6.03 - 6.07. La calibración manual de la 
cámara debe completarse antes de intentar realizar aplicaciones PNC automáticas.  

 Asegúrese de haber instalado la actualización 0.5.56 o posterior. (Por favor, Haga 
esto DESPUES de calibrar la Force). En el momento de escribir este artículo, 0.5.56 
es el más reciente y puede ser descargado desde este enlace:   
  

http://www.iloveknk.com/Support/Software/C3-Update_AUTOPNC/  

Si la línea de corte roja está 

debajo de la línea negra 

impresa, entonces 

disminuya el valor de Y. 

Si la línea de corte roja está 

encima de la línea negra 

impresa, entonces aumente el 

valor de Y. 

Si la línea de corte roja está 

a la izquierda de la línea 

negra impresa, entonces, 

aumente el valor de X.  

Si la línea de corte roja está a 

la derecha de la línea negra 

impresa, entonces disminuya 

el valor de  X.  

Línea de corte roja está por 

debajo de la línea negra: 

disminuya Y de 6.0 a 5.0.  

Línea de corte roja está por 

encima de la línea negra: 

aumente Y de 6.0 a 7.0 

Línea de corte roja está a 1mm 

a la izquierda de la línea negra: 

aumente X de 21.5 a 22.5  

 

Línea de corte roja está a 1mm 

a la derecha de la línea negra: 

disminuya X de 21.5 a 20.5  

 

http://www.iloveknk.com/Support/Software/C3-Update_AUTOPNC/
http://www.iloveknk.com/Support/Software/C3-Update_AUTOPNC/
http://www.iloveknk.com/Support/Software/C3-Update_AUTOPNC/
http://www.iloveknk.com/Support/Software/C3-Update_AUTOPNC/
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• Utilice las instrucciones en la Sección 4.03.3 para instalar manualmente la actualización 

C3.  

• También descargue el archivo comprimido en ese enlace y extráigalo. Este contiene un 

archivo de prueba para usarse durante su primera aplicación PNC automática. Tenga en 

cuenta que las marcas de registro dentro de este archivo representan el tamaño y grosor 

necesario para proyectos futuros.   

  

• Abra el archivo SVG y asigne la capa reg mark, tal como usted lo hace con las 

operaciones manuales PNC. Tenga en cuenta que, con este archivo de prueba, la capa 

ya debería estar asignada.  

  

• Importe el archivo SVG en el software de diseño de su elección e imprima el proyecto. 

Colóquelo sobre el tapete de corte.  

  

• Introduzca los ajustes para cortar la capa del rectángulo. Si usted todavía no lo ha hecho, 

instale el portacuchillas en la Force configurando el origen Z como lo hace normalmente.  

  

• Haga clic en Prepare this cut Job. La siguiente ventana se abrirá:  

  

  
  

• Antes de elegir manual o automático, mueva el portacuchillas de modo que quede 

centrado sobre la marca de registro inferior derecha. El método es prácticamente el 

mismo que se muestra en la Sección 6.06 o usted puede referirse a una versión 

ligeramente mejorada al final de este tutorial.  

  

• Una vez que usted esté satisfecho con la posición del portacuchillas, haga clic en 

Continue (automatic detection).   

  

• El cabezal de corte se moverá para que la cámara pueda identificar esa marca de 

registro inferior derecha. Si tiene éxito, esta se moverá a la marca inferior izquierda y la 

detectará automáticamente. Si eso tiene éxito, entonces se moverá a la marca superior 

derecha. Si eso tiene éxito, entonces regresará de nuevo a su posición original y 

golpeará ligeramente una vez para posicionar la cuchilla antes de cortar la figura.   
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• Si la detección falla en la primera marca, inténtelo de nuevo siendo más cuidadoso al 

colocar el portacuchillas sobre la marca inicial. Una vez más, eche un vistazo al tutorial al 

final de esta sección para mi método.   

  

• Si esta continúa fallando después de varios intentos, realice una prueba de detección 

manual para asegurarse de que los números de calibración siguen siendo válidos.   

  

• Si la detección falla después de ver con éxito la primera marca, compruebe lo siguiente:  

 ¿Se inclinó el tapete de corte?  
 

 ¿Está la impresión alineada a lo largo de las líneas de la cuadrícula en el tapete y 
el tapete bastante recto en la Force? 

 
  ¿Están las marcas de registro claramente impresas y en negro sólido?  
 
 ¿Está la impresión plana sobre el tapete (sin arrugas ni bulto cerca de la marca de 

registro)?  

• Si usted continúa teniendo errores de detección, por favor notifíqueme: 

smccauley45@cox.net.   

Recuerde que la detección automática está todavía en fase beta y puede necesitar 

ajustes adicionales para eliminar los errores y hacer que el procedimiento funcione para 

todos los usuarios.   

  

Configuración de Origen para PNC automática  

Este es el método que uso y lo considero infalible.  

(1) Mueva el tapete bastante hacia delante para que alinee la línea vertical de la marca 

de registro con el tornillo delantero:  

  

  
  

(2) Mueva el cabezal hacia la izquierda/derecha hasta que la línea vertical de la marca de 

registro no pueda ser vista a ambos lados del tornillo delantero cuando mire hacia 

abajo sobre este:  
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No se 

puede ver 

la línea 

vertical de 

la marca de 

registro 
 

 

 

No se 

puede ver 

la línea 

vertical de 

la marca de 

registro 
 

(1) Mueva el tapete hasta que el centro del portacuchillas esté exactamente centrado con 

la línea horizontal.  

Note que tengo una pegatina en la parte superior del portacuchillas con una línea 

horizontal apuntando a la izquierda. Usted apenas puede ver la marca de registro a la 

izquierda de esa línea.  

  

 

Note que la línea 

horizontal de la marca 

de registro puede 

verse justo a la 

izquierda del puntero 

en la parte superior 

del portacuchillas. 
 

 
(2) ¡Eso es todo! El portacuchillas está ahora centrado sobre la marca en el lugar 

correcto.    

  

6.09 Consejos Para Impresión y corte 

• Cuando esté trazando pixeles de imágenes importadas, las líneas de traza no van a estar necesariamente 
perfectas alineadas con la imagen. Esto puede resultar en pequeños trozos que aparecen en blanco en 
ciertos puntos, lo que sugiere que el PNC no estaba exacto. Acerque bastante la imagen de manera que 
usted pueda ver la línea de trazo siguiendo el contorno de la imagen. Mire los mismos puntos donde el 
PNC no siguió la imagen perfectamente. Esto podría ser la causa de la inexactitud del PNC. La mayoría de 
los programas de trazados tienen una configuración para un ajuste más apretado... trate eso primero. 

• Si un PNC no es preciso y la causa no es la alineación de las líneas de trazado, entonces, primero verifique 
el CD/ED que usted está utilizando. Cortar demasiado profundo en el tapete de corte puede causar una 
cierta cantidad de resistencia al avance del tapete, lo que conduce a errores, especialmente en 
aplicaciones con muchas figuras a cortar.  

• Si usted tiene una figura simétrica o un diseño simétrico para su proyecto PNC, asegúrese de que será 
obvio cómo colocar la impresión en el tapete de corte. Es posible que usted desee agregar algún tipo de 
identificador, como una flecha pequeña o una letra "A" antes de imprimir, para que sepa qué lado va para 
arriba. Por ejemplo: 
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• Velocidades de corte más rápidas y velocidades de subidas “Up Speeds” pueden ser utilizadas para cortar 
materiales más finos. Por ejemplo, usted debería ser capaz de utilizar 30 y 30 con diseños simples en papel 
fino. Para cartulina regular, usted podría ser capaz de utilizar 25 y 25. Para cartulina gruesa, permanecer 
con 20 y 20. Esto también depende del diseño. Corte muy preciso alrededor de una imagen impresa 
necesitará velocidades más bajas que un corte de contorno largo, como la etiqueta alrededor de la vaca 
mostrada en la Sección 6.01. Por otra parte, si el tapete se mueve varias veces, dentro y fuera de la 
cortadora, se puede producir un ligero desplazamiento, especialmente en altas velocidades. Así que 
impresión y cortes con un montón de imágenes necesitarán velocidades de corte y velocidades de subidas 
más lentas. 

• Si usted está utilizando PNC en su negocio y necesita un corte más rápido, Francisco Ulloa, desarrolló un 
método en el cual él alinea el tapete con el extremo lateral derecho de la Force y diseña sus archivos de 
manera que todas las figuras corten en sentido contrario a las manecillas del reloj. Esto hace que la fuerza 
de sesgo en el tapete sea contrarrestada por la presencia de la tapa de extremo, manteniendo el tapete 
derecho. Él ha sido capaz de utilizar CS máximo para muchas de las aplicaciones de su PNC. ¡Gracias, 
Francisco! (Nota: Para cambiar la dirección de la trayectoria en un archivo SVG en C3, consulte la Sección 
3.02.10. Para cambiar la dirección de la trayectoria dentro del programa de diseño original, consulte las 
secciones 4.02.1-4.02.5 y la tabla Guía rápida en la sección 4.04.3.) 

• Recuerde que la calibración de la desviación es específica para el porta cuchilla en particular y el tipo de 
cuchilla usada. Por lo tanto, si usted cambia, la calibración debe ser revisada y ajustada, según sea 
necesario.  

• C3 no procesa imágenes en trama (raster images). Para una impresión y corte, usted no necesitará la parte 
de la trama de una imagen para el corte. Es sólo importante importar las marcas de registro y las líneas 
vector del corte (cada uno en capas separadas, por supuesto). 

 

 
6.10 Preparando Archivos PNC Nuevos en MTC 

 
6.10.1 Usando los Archivos Reg Mark en MTC 

• Es muy recomendable que usted utilice los archivos de marca registrada proporcionados. Si usted tiene 
motivos para diseñar el suyo propio, consulte la Sección 6.13. 

• MTC puede añadir una carpeta bajo Basic Shapes llamada Your Shapes siendo esto muy conveniente 
para importar las marcas de registro necesarias para una aplicación PNC.  

 

Configurando las Marcas de Registro Bajo “Your Shapes”  

• Importe uno de los archivos KNK Reg Marks a MTC.  

• Con este todavía seleccionado, vaya a File>Export>Sel. to Basic Shapes. Se abrirá una ventana donde 
usted puede introducir el nombre de su elección : 

 

o 
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• Clic en Add y luego click en OK. 
 

• Cada vez que usted necesite añadir marcas de registro a su proyecto, haga clic en el icono Basic Shapes 

 y seleccione la carpeta Your Shapes. Haga doble clic en el archivo Reg Marks que usted: 

 
 

Moviendo las Marcas de Registro en MTC 

• Si usted desea mover las marcas de registro, utilice la función Split   o la función Break    para 
separarlas. 

• Ahora usted puede mover las marcar de registro a cualquier lugar. A partir de la versión C3 0.5.25, las 
marcas ya no necesitan alinearse entre sí. Tampoco necesitan colocarse fuera de los límites de las 
imágenes impresas. 

• ¡IMPORTANTE! Las marcas de registro tienen que permanecer como 3 nodos "L" figuras con una línea 
perfectamente horizontal y una línea perfectamente vertical. Por lo tanto, no gire parcialmente (menos de 
90 grados) una marca de registro ni aplique una inclinación/torcedura o cualquier otra función que, puedan 
alterar esos requisitos básicos. Sin embargo, usted puede utilizar las funciones Mirror, Flip y 90 ° Rotate, 
según se desee. 

• Una vez que las marcas de registro estén en su nueva ubicación, usted puede seleccionarlas y aplicar Join

. 

 

 

 
6.10.2 Moviendo Figuras a Nuevas Capas y Exportándolas 

• Cuando se prepara un archivo en MTC para impresión y corte, siempre asegúrese de que las marcas de 
registro y otras figuras estén en capas separadas por lo que las capas de las marcas de registro pueden 
ser seleccionadas por separado en C3.   

• Para mover nuevas figuras a su propia capa, seleccione la capa y luego haga clic en el icono Selection to 
New Layer situado en la parte inferior de la barra Layers. Por ejemplo, para mover las Marcas de 
Registro: 

Haga doble clic para 

colocar las marcas de 

registro en el Tapete 

Virtual 
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• Seleccione ambas capas y vaya a File>Export>Sel. to SVG. 

 

 
6.10.3 Problemas con el Contorno de la Figura en MTC 

• Habrá situaciones en las que usted no querrá la opción Print Shape Outlines activada en File>Print 
Options. Por ejemplo, la siguiente foto de un leopardo muestra un contorno vector indeseable alrededor del 
leopardo en la ventana Print Preview: 

 

• La solución es crear un conjunto de marcas de registro que se pueda imprimir sin tener esa opción 
activada. 

 Para hacer esto, seleccione las marcas de registro y haga clic en el icono Shadow Layer .  En 
Shadow Width Introduzca 0.003 pulgadas (o 0.08 mm) y luego haga clic en Accept. Una nueva capa de 
sombra aparecerá en la barra de Layers. 

Clic en 

esta capa 

Luego clic en este icono 

del medio. 

Finalmente doble clic en 

New Layer y escribale el 

Nuevo nombre deseado. 

Un contorno negro rodea la 

foto del leopardo. 
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• A menos que usted tenga el color Virtual Mat configurado en Contrast, uste necesita también asegurarse 
de que el Shadow Layer está configurado a negro. Al mismo tiempo, usted también necesita el Shadow 
Layer estar por encima de la capa Reg Marks para imprimir. Para lograr esto:  

 Clic en el icono paleta de colores y cambie el color a negro 

 Clic en el icono de la flecha verde hacia arriba para mover la capa Shadow Layer encima de la capa 
Reg Marks: 

                     

• Ahora vaya a File>Print Options y desactive la opción Print Shape Outlines. Clic OK. 

• Vaya a File>Print Preview. La vista previa mostrará ahora el leopardo sin el esquema y mostrará las 
nuevas marcas de registro necesarias para la impresión: 

      

• ¡IMPORTANTE! Antes de exportar, o bien ocultar o eliminar la capa de sombra (Shadow Layer). Si a usted 
se le olvida, usted también puede desactivar esa capa una vez que esté en C3. Usted no puede usar la 
Shadow Layer (capa de sombra) como sus marcas de registro. 

• A usted puede que le resulte útil añadir las marcas reg sombreadas a Your Shapes bajo Basic Shapes. 
Consulte la Sección 6.10.1. 

 

Clic aquí 

para mover la 

capa hacia 

arriba Clic aquí para 

cambiar el color 

a negro 

Un contorno negro ya no es 

impreso. 
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6.11 Preparando Archivos Nuevos PNC en SCAL 

 
6.11.1 Usando las Marcas de Registo en SCAL  

• Es muy recomendable que usted utilice los archivos de marcas de registro proporcionados. Si usted tiene 
motivos para diseñar el suyo propio, consulte la Sección 6.13. 

• SCAL tiene una carpeta llamada Mis diseños (My Designs) para almacenar las figuras más utilizadas. 
Antes de mover figuras a esta carpeta, cierre SCAL. 

   

Creando las Marcas de Registro en “My Designs”  

• Lo mismo en una PC o una Mac, copie y pegue cualquiera o ambos de los archivos KNK Reg Marks  
(Marcas de Registro): Documents > Craft Edge> My Designs: 

 

 
 

 

 
 

 

• Abra SCAL y abra Library  si esta no está abierta. Luego haga clic en My Designs. Los archivos KNK 
Reg Mark aparecerán: 

 

Captura de Pantalla en PC: 

Captura de Pantalla en Mac: 
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• Clic una vez en la miniatura para añadir las marcas de registro al archivo. 

• Si usted acumula una gran cantidad de archivos en My Designs, usted puede mover el archivo Reg Marks 
a otra carpeta llamada Favorites haciendo clic derecho en la miniatura y seleccionando Add to Favorites. 
Debido a que es difícil ver las imágenes actuales en miniatura para las marcas de registro, usted puede 
cambiar a un nombre de archivo de la lista haciendo clic en un pequeño icono arriba de la lista: 

 

 
 

 

 

 

Moviendo las Marcas de Registro en SCAL 

• Si usted desea mover las marcas de registro, utilice Object>Break Apart para separarlas. 

• Ahora usted puede mover libremente las marcas reg a cualquier lugar. A partir de la versión C3 0.5.25, las 
marcas ya no necesitan ser alineadas entre sí. Tampoco necesitan colocarse fuera de los límites de las 
imágenes impresas 

• ¡IMPORTANTE! Las marcas de registro tienen que permanecer como 3 nodos "L" figuras con una línea 
perfectamente horizontal y una línea perfectamente vertical. Por lo tanto, no gire parcialmente (menos de 
90 grados) una marca de registro ni aplique una inclinación/torcedura o cualquier otra función que, puedan 
alterar esos requisitos básicos. Sin embargo, usted puede utilizar las funciones Mirror, Flip y 90 ° Rotate, 
según se desee. 

• Una vez las marcas de registro estén en su nueva ubicación usted puede opcionalmente unirlas yendo a 
Object>Merge.  

 
6.11.2 Moviendo Figuras a Nuevas Capas y Exportándolas  

 

• Cuando se prepara un archivo en SCAL para impresión y corte, siempre asegúrese de que las marcas de 
registro y otras figuras están en capas separadas por lo que la capa de registro se pueda seleccionar por 

Clic en My 

Designs 

Archivos Reg Marks 

Clic en 

Favorites 

Clic aquí para ver 

detalles 

Clic una vez para añadir reg 

marks al document actual. 

https://vimeo.com/169012075
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separado en C3. Esto implica un poco más que solo arrastrar las figuras a la barra Layers porque C3 
necesita que las capas estén dentro de las carpetas. 

• El primer paso es crear la carpeta. Clic en el icono de la derecha de Layer Name y seleccione Add Layer 
Folder: 

      

• Una nueva carpeta aparecerá. Doble clic <Folder> y provea un Nuevo nombre. Clic OK. 

              

• Clic en la capa a ser movida y arrastre esta hasta que una línea negra aparezca bajo la nueva capa. Luego 
suéltela: 

                                            

 

 

 
 

• Si usted tiene más figuras para mover a una nueva capa, repita el proceso. Tenga en cuenta que usted no 
puede crear varias carpetas antes de mover figuras a ellas. Ellas desaparecerán si están vacías. Por lo 
tanto, utilice este orden: crear una carpeta, mover las figuras, crear una carpeta, mover las figuras, etc. 

• Para exportar el archivo, vaya a File>Export y asegúrese que SVG es el tipo de archivo seleccionado. 
Después de introducir el nombre del archivo y hacer clic en Save, la siguiente ventana se abrirá. Utilice los 
siguientes ajustes: 

 

Clic en esta capa. 

Luego arrastre esta 

hacia arriba de la lista 

hasta que usted vea 

una línea bajo el 

nombre de la nueva 

capa. 

Doble clic 

aquí 

Seleccione Add 

Layer Folder 
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• La única excepción es si usted tiene partes de un archivo que no desea exportar. Entonces usted necesita 
seleccionar las capas a exportar y marcar el cuadro Selection only en la captura de pantalla anterior. 

 

 

 
6.12 Preparando Nuevos Archivos PNC en Inkscape 

 

 
6.12.1 Usando los Archivos Reg Mark en Inkscape 

• Es muy recomendable que usted utilice los archivos de marcas de registro proporcionados. Si usted tiene 
motivos para diseñar el suyo propio, consulte la Sección 6.13. 

 

Abriendo los Archivos Reg Marks en Inkscape 

• Use File>Open para abrir uno de los archivos KNK Reg Marks en Inkscape. Tenga en cuenta que usando 
File>Import aparentemente hará la misma cosa sin abrir otra instancia de Inkscape. Sin embargo, usted no 
puede separar las cuatro marcas de registro en caso que usted necesite moverlas en la pantalla. 

• Usted probablemente será capaz de ver las marcas de registro al principio porque el área del documento 
será la misma dimensión que el límite alrededor de las marcas de registro. Consulta la Sección 6.04.3 
sobre cómo cambiar el tamaño del área del documento.  

 

 

Moviendo las Marcas de Registro en Inkscape 

• Si usted desea mover las marcas de registro, aplique Path>Break Apart para separarlas. 

• Ahora usted puede mover libremente las marcas reg a cualquier lugar. A partir de la versión C3 0.5.25, las 
marcas ya no necesitan ser alineadas entre sí. Tampoco necesitan colocarse fuera de los límites de las 
imágenes impresas 

• ¡IMPORTANTE! Las marcas de registro tienen que permanecer como 3 nodos figuras "L" con una línea 
perfectamente horizontal y una línea perfectamente vertical. Por lo tanto, no gire parcialmente (menos de 
90 grados) una marca de registro ni aplique una inclinación/torcedura o cualquier otra función que, puedan 
alterar esos requisitos básicos. Sin embargo, usted puede utilizar las funciones Mirror, Flip y 90 ° Rotate, 
según se desee (pero no los use en combinación en este momento). 

• Una vez las marcas de registro estén en su nueva ubicación usted puede opcionalmente unirlas yendo a 
Path>Combine.  

 
6.12.2 Moviendo Figuras a Nuevas Capas y Guardándolas 

• Cuando se prepara un archivo en Inkscape para impresión y corte, siempre asegúrese de que las marcas 
de registro y otras figuras estén en capas separadas para que la capa con la marca de registro pueda ser 
seleccionada por separado en C3.   

• Cuando usted abrió el archivo de calibración en la Sección 6.04.3, las flechas y las marcas de registro ya 
estaban en capas separadas. Inkscape reconoce capas creadas en otros programas vectoriales haciendo 
las cosas más fáciles. Sin embargo, si usted está diseñando en Inkscape, entonces usted necesita crear 
nuevas capas, según sea necesario, para mantenerlas separadas de la capa con la marca de registro.  

• Para crear una capa nueva, vaya a Layer>Layers para abrir la ventana Layers en el lado derecho de la 
pantalla. 

• Clic en el icono Create a new layer y una pequeña ventana abrirá donde usted puede nombrar la nueva 
capa: 
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• Clic en Add y la nueva capa abrirá: 

 
 
• Proceda a agregar figuras como deseadas. Consulte la Sección 4.02.4 para las directrices sobre la 

manipulación de texto, círculos, óvalos y algunas otras figuras para la representación adecuada en C3. 

• Cuando su archivo esté listo para ser guardado, vaya a File>Save As y siempre use Inkscape SVG (*.svg) 
bajo Save as type. Hay otras opciones SVG en el menú, sin embargo, estas no se visualizan 
correctamente en C3: 

      

 

6.13 Preparing New PNC Files in Adobe Illustrator 

 
6.13.1 Using the Reg Mark Files in Adobe Illustrator 

 
 Usted tiene dos opciones con los archivos de marca de registro en Adobe Illustrator: 

 

 Utilizar el archivo proporcionado para A4 o Carta y personalizarlo, según sea necesario. 

 Diseñar sus propias marcas de registro utilizando las directrices de la Sección 6.13. 
 
 ¡IMPORTANTE! Si usted utiliza el archivo de marca de registro proporcionado, usted no puede copiar y 

pegar las marcas de registro en otro archivo. En su lugar, usted debe utilizar este archivo como su archivo 
base para diseñar su proyecto de impresión y corte. Por supuesto, usted debería ser capaz de copiar y 
pegar en elementos de diseño desde otro archivo, si estos ya están creados. Nota: Esta restricción no se 
aplica si usted diseña sus propias marcas de registro dentro de AI. 

 
Abrir los archivos Reg Marks en Adobe Illustrator 

 

• Utilice Archivo> Abrir (File>Open) para abrir uno de los archivos KNK Reg Marks en Adobe Illustrator. 
 

• Usted no podrá ver las marcas reg al principio porque el área del documento tendrá las mismas 
dimensiones que el límite alrededor de las marcas de registro. Consulte la Sección 6.04.3 sobre cómo 
cambiar el tamaño del área del documento. 
 

Mover las marcas de registro en Adobe Illustrator 
 

Entre un nombre para 

la nueva capa 

Nueva capa aparece en la 

ventana Layers. 

Siempre use Inkscape SVG 
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• Si usted desea mover las marcas de registro, haga clic con el botón derecho del ratón y seleccione 
Desagrupar (Ungroup). Luego, haga clic con el botón derecho del ratón y seleccione Liberar ruta 
compuesta (Release Compound Path). 
 

• Ahora usted puede mover libremente las marcas de registro a cualquier ubicación. A partir de la versión C3 
0.5.25, las marcas ya no necesitan alinearse entre sí. Tampoco necesitan colocarse fuera de los límites de 
las imágenes impresas. 

 

• ¡IMPORTANTE! Las marcas de registro tienen que permanecer como 3 nodos formas "L" con una línea 
perfectamente horizontal y una línea perfectamente vertical. Por lo tanto, no gire parcialmente (menos de 
90 grados) una marca de registro ni aplique una inclinación/torcedura o cualquier otra función que, luego, 
altere los requisitos básicos. 

 

• Una vez que las marcas de registro estén en sus nuevas ubicaciones, usted opcionalmente puede volver a 
unirlas haciendo clic con el botón derecho del ratón y seleccionando Hacer ruta compuesta (Make 
Compund Path). 

 
 

6.13.2 Mover Figuras a Nuevas Capas y Guardarlas 
 

• Siempre cree nuevas capas para figuras adicionales. Las marcas de registro deben permanecer las únicas 
figuras en su capa para que puedan ser asignadas en C3. 
 

• Utilice las directrices recomendadas en la Sección 4.02.3 para guardar el archivo SVG para abrirlo en C3. 

 
6.14 Crear Sus Propias Marcas de Registro 

 
Si usted desea diseñar sus propias marcas de registro, tenga en cuenta las siguientes directrices: 

• Cada marca debe ser una ruta de una sola línea que contenga 3 nodos: 
 
 Estos nodos necesitan estar ordenados en un ángulo recto: 

                      

 

 

 No importa a qué dirección apunte cada marca (NE, NW, SE, SW), pero cada marca debe estar 
compuesta por una línea perfectamente vertical y una línea perfectamente horizontal. Por lo tanto, se 
recomienda usar el ajuste a la cuadrícula cuando los dibuje. 
 

 Las marcas de registro no necesitan ser una anchura o altura en particular, pero el ancho y la altura 
deben ser iguales. 
 

• Debe haber al menos 3 marcas y actualmente deben colocarse en una forma de L reflejada, de manera que 
dos estén en el lado derecho de la imagen impresa y dos debajo de la(s) imagen(es) impresa(s): 

Como este… O como este… O como este, etc… 
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• Marcas adicionales más allá de estas 3 serán ignoradas. 
 

• Alinee las marcas de modo que se forme un ángulo recto a través de las esquinas de las marcas (los 
puntos rojos y las líneas punteadas son sólo con propósito ilustrativos): 
 

     
 

 
  

O como este… Como este… O como este, etc… 

O como este… Como este… O como este… 
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6.15 Revisión del Capítulo 6 

 
6.15.1 Cosas a tener en cuenta 

• Video para calibración PNC:      

• Los números de calibración se ingresan en Settings>Machine Settings (Configuración>Configuración 
de la máquina), (Sección 6.02). 

• El archivo de calibración se puede descargar desde este enlace: 
http://cutterpunk.com/files/knk/BasicShapes.zip (Sección 6.03). 

• Calibrar es más fácil si usted: 

 Está bien descansado  (Sección 6.03). 

 Utiliza papel de impresora (Sección 6.03). 

 Cambia las unidades a mm en Settings>Basic Settings (Ajustes>Ajustes básicos) (Sección 6.05). 

 Mantiene un registro de las X e Y usadas en cada prueba (Sección 6.07). 

 Comienza usando al menos 1 mm de cambios en X y/o Y para proporcionar resultados notables. 
Luego, disminuye el cambio a 0.5 mm, luego a 0.1 mm, y posteriormente, si es necesario, a 0.05 mm 
(Sección 6.07). 

 No intenta modificar el archivo de prueba de calibración (Sección 6.04). 

• No imprima un archivo SVG desde el propio navegador. El tamaño impreso no será el mismo que las 
dimensiones reales del archivo (Sección 6.04). 
 

• Mantenga Cut Speed (la velocidad de corte) y Up Speed (la velocidad de subida) entre 20 y 25. 
 

• Si usted crea versiones de marcas de registro sombreadas en MTC para evitar la impresión de contornos 
de figuras, tenga en cuenta que las versiones originales, no las versiones sombreadas, deben usarse en C3 
(Sección 6.10.3). 

 
 

6.15.2 Guía Rápida: Realización de una Impresión y Corte 

 
(1) Prepare el proyecto PNC en el software de diseño de su elección.  

(2) Añada las marcas de registro en su propia capa separada.  

(3) Imprima el proyecto.  

(4) Exporte el proyecto como SVG.  

(5) Abra el archivo SVG en C3. 

(6) Haga clic en Advanced Settings (Configuración avanzada) y asigne la capa bajo Print-and-cut 
registration layer. 

(7) Coloque la impresión sobre el tapete de corte e inserte el tapete en la Force. Asegúrese de que la impresión 
se coloca en el tapete en la misma orientación que se muestra en C3. 

(8) Introduzca los ajustes de corte y haga clic en Prepare this cutting job (Preparar este trabajo de corte). 

(Resumen de Secciones 6.04 – 6.06) 

http://cutterpunk.com/files/knk/BasicShapes.zip
https://www.youtube.com/watch?v=Gk0dVQRjQ6Y
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(9) Mueva la cabeza de modo que el centro del soporte de la cuchilla esté aproximadamente alineado con la 
esquina de la marca de registro inferior derecha.  

(10) Haga clic en Continue (Continuar) y la cámara proyectará una imagen de esa marca de registro en la 
pantalla. Si usted no puede ver la esquina de la marca de registro, haga clic en Move Camera (Mover cámara) 
y ajuste la ubicación del porta cuchillas sobre la marca de registro.  

(11) Haga clic en la esquina de la marca de registro para mover el "+" rojo a la esquina. Luego, utilice las 
flechas para alinear el "+" rojo lo más cerca posible del centro de esa esquina.  

(12) Haga clic en Continue (Continuar) y repita los Pasos (9) - (11) para las otras dos marcas de registro.  

(13) Una vez establecida la última marca de registro, las figuras se cortarán.  

(14) Si es necesario, ajuste los números de calibración X e Y utilizando el diagrama de flechas en la Sección 
6.07 
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Capítulo 7  Herramienta Rotativa 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

¡Herramienta muy diferente!  ¡Enfoque muy diferente! 

 

¡Lo Siguiente es un DEBE LEER! 
 

 ¡Seguridad en primer lugar! Lea la Sección 7.01 antes de usar la herramienta giratoria. 

 A diferencia del porta-cuchilla, no hay muelle que compense el movimiento hacia abajo de 
la herramienta giratoria. Por lo tanto, la herramienta alcanzará la Cutting Depth / Ending 
Depth (Profundidad de corte/ Profundidad final) introducida. El número de Passes 
(Pasadas) necesarias dependerá del espesor y densidad del material. 

 Para practicar comience grabando. Hay menos riesgo de romper una punta o dañar el 
cortador. 

 Sea conservador en su enfoque. Utilice Speeds (Velocidades) lentas (en las cuatro), 
como se recomienda, y más Passes (pasadas) en lugar de menos. 

 El enfoque general para cortar implica estos pasos: 

(1) Mida el espesor del material a ser cortado (Sección 7.04.1). 

(2) Introduzca el grosor y la Altura de la Superficie en Rotary Tool Online Calculator (la 
Calculadora en línea de la Herramienta Rotativa) para obtener Cutting Depth / 
Ending Depth (Profundidad de Corte/Profundidad Final) para la prueba (Sección 
7.04.2 y 7.04.3). 

(3) Realizar la Prueba con un Bolígrafo (Sección 7.05). Repita hasta que Cutting Depth 
/ Ending Depth (Profundidad de Corte/Profundidad Final) correcto sea determinado. 

(4) Seleccione la punta de corte adecuada para la herramienta giratoria y monte la 
herramienta giratoria a la Force (Sección 7.06 y Sección 7.07). 

(5) Introduzca todos los ajustes (Sección 7.03). 

(6) Revise la Lista de Verificación Importante (Sección 7.09.2) antes de cortar.  

 

 

 

 

 

 

http://knkusa.com/product/knk-force-rotary-tool/
http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm
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7.01 Consideraciones Importantes de Seguridad y Funcionamiento 

• Accugraphic Sales, Inc. no asumirá ninguna responsabilidad por lesiones personales que pudieran ocurrir 
debido al uso de la herramienta rotativa. Por lo tanto, todos los usuarios asumen la plena responsabilidad 
en cuanto a seguridad persona. 
 

• La herramienta rotativa sólo debe ser operada por un adulto. 
 

• Se deben usar gafas de seguridad en todo momento, mientras la herramienta rotativa esté en 
funcionamiento. 

 

• Mantenga las manos, el cabello, ropa suelta, joyas, etc lejos de las partes móviles. 
 

• No deje la herramienta giratoria desatendida cuando esté en uso. ¡Los materiales pueden llegar a estar 
extremadamente calientes durante el corte y están sujetos a quemarse! ¡Si un material comienza a humear, 
apague inmediatamente la herramienta giratoria y la Force!  

 

• Siempre apague la herramienta rotativa cuando no esté en uso, para evitar un arranque "falso" o 
accidental. 

 

• Desconecte siempre el cable de alimentación del adaptador de corriente antes de realizar cualquier ajuste o 
de adjuntar cualquier accesorio. 

 

• Los accesorios deben tener una clasificación mínima de la velocidad recomendada en la etiqueta de 
advertencia de la herramienta. Las ruedas y otros accesorios que corren sobre la velocidad nominal pueden 
volar y causar lesiones. 

 

• Desconecte la herramienta giratoria cuando cambie los bits o puntas. Asegúrese de que la tuerca del collar 
esté firmemente unida. 

 

• No toque inmediatamente la punta giratoria o la tuerca después de apagar la herramienta giratoria. Ambos 
necesitan tiempo suficiente para enfriarse. 

 

• Hay un adaptador para una aspiradora en el adaptador giratorio. Este accesorio debe funcionar con la 
mayoría de las mangueras de aspiradoras si usted desea eliminar los desechos mientras opera la 
herramienta. (Nota: en el momento de escribir este documento, el accesorio para aspiradora aún no ha sido 
enviado). 

 

• Evite golpear la Force o el tapete mientras la herramienta giratoria esté en uso. Esto puede causar defectos 
o incluso roturas en el producto final.  

 

• Mantenga las ruedas de presión limpias. Una acumulación de polvo o virutas finas puede impedir el agarre 
adecuado del tapete y dará lugar a una distorsión del corte. 

 

• Por favor lea todas las instrucciones cuidadosamente. ¡No "empuje los límites" con esta herramienta! 
 

• Para proteger los bits, es sumamente importante usar la configuración correcta. ¡Es muy fácil romper los 
perforadores más delgados si no se siguen las precauciones apropiadas!  

 

• Utilice los tipos de bits correctos para la aplicación. Por ejemplo, los bits utilizados para taladrar agujeros no 
deben utilizarse para grabado o corte. Refiérase a la Sección 7.02. 

 

• Reemplace los bits una vez que se vuelven embotados. Vuelva a la configuración conservadora al probar 
nuevos bits o puntas. 

 

• Una vez más... Siempre mantenga las partes del cuerpo fuera de la punta rotativa. La KNK Force es capaz 
de movimientos rápidos y repentinos. El contacto con la punta giratoria puede causar lesiones graves. 
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7.02 Contenido en el Kit de la Herramientas Rotatoria  

• El Kit de la Herramienta Rotatoria de la NK Force consiste de los siguientes elementos: 

 Herramienta rotativa con tuerca de pinza 

 Cable de alimentación y adaptador AC/DC  

 Adaptador para adjuntar a la KNK Force 

 5 puntas para perforar 

 1 1/16” X 1/4” fresa de corte 

 1 1/16” x 1/8” fresa de corte y grabado  

 6 Collets de latón (uno está en el eje) 

 Llave Allen 

• Los bits incluidos pueden variar. La siguiente foto muestra un kit típico con una explicación de cómo los bits 
deberían ser usados: 

 

 

• Los siguientes enlaces muestran diferentes tipos de bits que pueden usarse en herramientas rotatorias y 
aplicaciones apropiadas para esos bits: 

http://woodcarvingillustrated.com/blog/choosing-power-carving-bits/ 

http://krcims.com/wp-content/uploads/2014/03/2012AccessoryPoster.jpg 
 

 

7.03 Ajustes Para la Herramienta Rotatoria 

• Antes de comenzar los detalles, aquí hay un video de demostración de un proyecto de herramienta rotativa 
de principio a fin. Esto le proporcionará una visión general de lo implicado cuando se utiliza la herramienta 

rotativa:  
 

• IMPORTANTE!   Sea conservador con los ajustes: 

 Use velocidades más lentas como se recomienda en la siguiente tabla. 

 Utilice multiple Passes (múltiples Pasadas), permitiendo así que la herramienta trabaje pasando a través 
del material. Establezca el SD dividiendo el ED por el número de Passes (pasadas). 

 Al realizar la prueba inicial, examine los resultados y, si usted necesita aumentar CD/ED, hágalo en 
incrementos conservadores.  

1, 2: Estos dos bits delgados y 

frágiles están incluidos para trabajar 

con PCBs (taladrando pequeños 

agujeros para componentes de la 

vivienda). No los utilice con 

materiales espesos y densos. 
 

3, 4, 5: Use estos para perforar agujeros. 

 

6, 7: Utilice estos para el grabado y el corte. 

http://knkusa.com/product/knk-force-rotary-tool/
http://woodcarvingillustrated.com/blog/choosing-power-carving-bits/
http://krcims.com/wp-content/uploads/2014/03/2012AccessoryPoster.jpg
https://www.youtube.com/watch?v=Sm53WYPVoIw
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• La tabla siguiente es un resumen de los ajustes utilizados por la herramienta rotatoria de la Force. Esto es 
para su conveniencia y no debe impedirle revisar la Sección 3.02 para obtener detalles sobre cada 
configuración. 
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Ajuste
Sección a 

Leer
Descripción

Rango Típico para el Uso de 

Herramientas Rotatorias

Cut>Layer Settings

Passes, P 3.02.1
Número de repeticiones a realizar en una figura antes 

de pasar a la siguiente figura
1-20; usualmente 2 - 5

Starting depth, SD 3.02.3 La profundidad objetivo para la primera pasada
Profundidad final dividida por 

Pasadas

Cutting depth / Ending depth, CD/ED 3.02.2
La herramienta de profundidad máxima se desplazará 

en la dirección Z antes de ir más allá
Utilice la calculadora en linea

Cutting speed, CS 3.02.4
Cuán rápido se mueve la herramienta mientras está en 

la posición hacia abajo
1-10

Up speed, US 3.02.5
Cuán rápido la herramienta se desplaza en la posición hacia 

arriba, moviéndose de un lugar a otro para comenzar a cortar
10-15

Plunge speed, PS 3.02.6
Cuán rápido la herramienta cae de la posición hacia 

arriba a la posición hacia abajo
5-10

Lift speed, LS 3.02.7
How fast the tool rises from the down position to the up 

position
10-15

Cutting tool, CT 3.02.8

Dado que el adaptador para la herramienta giratoria 

sólo funciona en el lado izquierdo, el CT debe estar 

siempre en L

L

Blade offset, BO 3.02.9
Una herramienta giratoria tiene un desplazamiento de 0 

porque la punta está centrada con el centro del eje
Ninguno

Path Direction, PD 3.02.10

Alterna la dirección en la que se cortarán todas las figuras (en 

el sentido de las agujas del reloj vs en sentido contrario a las 

agujas del reloj, de izquierda a derecha vs derecha a 

izquierda, etc.)

Normal

Cut>Advanced Settings

Optimize cut order, OCO 3.02.10 Actualmente no se implementa, por lo tanto, dejar en Off Off

Closed path overcut, CPO 3.02.10
Una herramienta rotativa no necesita sobrecorte porque 

la punta está centrada con el centro del eje
0

Print-and-cut registration layer 6.05
Asignar cuál capa tiene marcas de registro en las 

aplicaciones PNC

Ninguno para corte regular o 

capa con marcas de registro 

para PNC

Settings>Machine Settings

Surface Height, SH 7.04.2

El lugar donde la cabeza caerá para establecer el 

origen Z (puede ser necesario bajarlo para materiales 

más gruesos)

Utilizar el valor final en la 

calculadora en línea
 

 
 
 

7.04 Determinación de Ajustes Para Cortar un Material Nuevo  
 

• Las siguientes subsecciones presentan un método recomendado para determinar los mejores ajustes para 
el corte. ¡Mientras que usted puede ser tentado a utilizar un proceso de “ensayo y error”, esto puede 
conducir a dañar la Force si el bit termina de ir demasiado profundo y agujerar la cortadora!   

 

7.04.1 Medir el espesor del material 

• Los fabricantes muchas veces suelen redondear el espesor real de un material y estos reportan el número 
más alto en el envase o incluso en las especificaciones. Por lo tanto, es importante determinar el grosor 
verdadero tan exactamente como sea posible. 
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 Usted puede medir en mm o en pulgadas. La calculadora en línea está configurada para ambas 
formas. 

 Si usted posee un calibrador, mida en varias ubicaciones y luego planee ingresar un valor promedio en 
la calculadora en línea cubierta más adelante. 

 Si usted no tiene un calibrador, mida lo mejor posible usando una regla con pequeños incrementos.  

• No se preocupe si usted siente que la medida no es precisa. El PenTest (la prueba del bolígrafo) 
presentado en la Sección 7.05 le ayudará a ajustar la configuración de CD/ED de modo que usted no corte 
a través del tapete.   

 
 
 

7.04.2 Altura de la Superficie 

• La Altura de la Superficie (SH) es un lugar específico donde la cabeza caerá para configurar el Origen Z. 
 

• El valor predeterminado para Surface Height (la altura de la superficie) en C3 es 300, pero ese valor 
puede cambiarse a cualquier número entero entre 0 y 670. Con un ajuste de 0, la cabeza está en su 
posición más alta a lo largo del eje Z; Con un ajuste de 670, la cabeza está en su nivel más bajo. 

 

• Cuando se intenta cortar o incluso grabar materiales más gruesos, puede ser necesario bajar la altura de la 
superficie (Surface Height) para que el origen Z pueda ser ajustado. 

 

• Con los accesorios existentes de la Force, es poco probable que una Altura de Superficie (Surface Height) 
mayor de 300 sea necesaria. Sin embargo, si se introducen materiales de espesor superior a ~ 0.075” (1.9 
mm), deberá reducirse Surface Height (la altura de la superficie). La calculadora en línea indicará cuándo 
esa es necesaria al mostrar "Fail" como resultado de la prueba. 

 

• Si se requiere un cambio en la altura de la superficie (Surface Height) para pasar la prueba de la 
calculadora, vaya a Settings>Machine Settings y cambie Surface Height al nuevo valor y haga clic en 
Apply Changes: 

      
• Haga una nota para cambiar Surface Height (la Altura de la Superficie) de nuevo a 300 antes de usar su 

portacuchillas nuevamente para un corte regular. Los ajustes en las tablas del Capítulo 3 y sus propias 
configuraciones grabadas son basadas en un SH de 300.  

 
 

7.04.3 Calculadora CD/ED  

• La calculadora en línea está disponible aquí:  

http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm 

• Algunas cosas a tener en cuenta al usar la calculadora: 

 Lea las instrucciones que empiezan en la mitad inferior de la tabla. Usted sólo tiene que ingresar dos 
números: el ajuste Surface Height, Altura superficial (que se encuentra en Settings>Machine 
Settings) y el grosor del material basado en su medida. Luego, haga clic en el botón Update 
(Actualizar) en la parte inferior.  

 

http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm


151 

 

 

 Si usted necesita bajar la altura de la superficie (Surface Height), intente 200 primero y luego continúe 
bajando 50 hasta que la calculadora indique “Pass.” 

 Anote tanto el Calculated ED (ED Calculado) como los valores Recommended ED (ED 
Recomendados), así como Surface Height (la altura de superficie) necesaria para pasar. Recuerde 
cambiar Surface Height (la altura de la superficie) en C3 para que coincida (Settings>Machine 
Settings). 

 
 
 

7.05 Prueba con Bolígrafo Para Verificar CD/ED Antes de Cortar 

• Una prueba segura y relativamente fácil le ayudará a ajustar su CD/ED para que corte a través de su 
material, pero no cortar a través del tapete. Antes de realizar esta prueba, tenga disponibles los siguientes 
elementos: 

 Bolígrafo con una punta firme 

 Material a ser cortado 

 Hoja de aglomerado u otro material para proteger el tapete de corte 

 Cinta adhesiva 

 Hoja de papel de copiar 

 Opcional: trozo pequeño de papel de aluminio o envoltura de plástico para proteger el material de la 
tinta  

Siga estas 

instrucciones, 

paso a paso. 

 

Use el lado izquierdo 

para mm; Lado derecho 

para pulgadas 

Haga clic en Update  

después de hacer algún 

cambio 
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• Realice esta prueba cada vez que usted vaya a cortar un material nuevo: 

(1) Si usted utilizó un calibrador para medir el grosor del material, entonces usted utilizará el CD/ED 
Calculado para esta prueba. Si usted utilizó el grosor indicado por el fabricante o usted está 
aproximando con una regla, entonces usted utilizará el CD/ED Recomendado.  

(2) Abra un pequeño archivo de prueba, como un círculo o un cuadrado.  

(3) Es mejor utilizar el asiento del lado izquierdo para esta prueba. Si usted ya tiene montada la 
herramienta giratoria, remuévala para que pueda instalarse un bolígrafo. No utilice el bolígrafo de 
prueba o cualquier otro tipo de bolígrafo que requiera una presión significativa hacia abajo para el flujo 
de tinta. 

(4) Coloque el tablero de aglomerado o cartón (o un material alternativo) sobre el tapete. El propósito de 
esta capa es proteger el tapete de corte de la herramienta giratoria. Mientras que la prueba es utilizada 
para optimizar el CD/ED, no es inusual necesitar un ajuste ligeramente más alto porque los materiales 
no siempre son consistentes en grosor. Por lo tanto, se espera que la punta o el bit esté cortando en la 
capa debajo del material en algunos lugares. Utilice cinta adhesiva para asegurar esta capa protectora 
al tapete de corte. 

 

(5) Con cinta adhesiva, pegue un pedazo de papel de copia sobre la capa de protección:  

 

(6) Ahora coloque el material que va a cortar en la parte superior del papel: 

 

 

(7) En Settings>Machine Settings, ingrese Surface Height (la Altura de la superficie) para que coincida 
con lo que se usó en la calculadora en línea. Haga clic en Apply Changes (Aplicar cambios). Haga clic 



153 

 

en Replace Left Tool (Reemplazar la herramienta de la izquierda). Quite la herramienta del lado 
izquierdo, si algo está instalado. 

(8) Haga clic en Continue (Continuar) y el lado izquierdo caerá. ¡IMPORTANTE! Inserte el bolígrafo para 
que la punta toque la parte superior del material. Si usted está preocupado que la tinta le marca el 
material, coloque un pedazo fino de papel de aluminio o envoltura de plástico sobre el material en 
primero. Pero no use nada más grueso que eso: 

 

 

(9) Apriete los tornillos delanteros y haga clic en Continue (Continuar) para que el lado izquierdo suba y 
vuelva a su lugar. Quite el material, pero deje la hoja de papel. 

(10) La parte superior del papel representa la ubicación de destino de CD/ED para el corte. Introduzca el 
CD/ED de la calculadora en línea. Utilice sólo 1 Pass (pasada) para la prueba. Pueden dejar las 
velocidades predeterminadas o ponerlas más rápidas, si se desea. Esta es una prueba para 
simplemente determinar si el CD/ED es exacto para el material que usted está cortando. 

(11)  Establecer un origen XY y luego ejecutar el dibujo de la figura de prueba.  

 Si el bolígrafo no marca en el papel, aumente el CD/ED en 20 y repita. 

 Si el bolígrafo hace una marca oscura y corta el papel, disminuya el CD/ED en 10 y repita. 

 Si el bolígrafo hace una marca muy débil en el papel, entonces el CD/ED está dentro del rango de 
hacer un corte exitoso.  

(12)  Ahora usted está listo para probar el corte con la herramienta giratoria, utilizando este nuevo CD/ED 
que pasó la prueba del bolígrafo. Recuerde aumentar Passes (pasadas) y disminuir las velocidades 
para que el bit pueda trabajar su trayectoria a través del material. Para Starting Depth (SD) (una 
Profundidad Inicial (SD)), use ED dividido por el número de Pasadas. 

 
 
 

7.06 Colocación de una Punta o Bit6 a la Herramienta Rotatoria 
 

Método Alternativo:   
 
 
 
 
 
 
 
 
 
 
 

                                                 
6 Por conveniencia, "bit" se refiere a una broca de taladro o a una punta 

Shank  Helix (Tip) 

https://www.youtube.com/watch?v=9wT5fYBB7nA
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• Seleccione la broca o el bit que usted desea utilizar y la pinza de sujeción (collet Nut) correspondiente. El 
bit o broca debe estar ajustada pero no debe entrar forzada a la pinza de sujeción. 

 

• Retire la tuerca de la pinza de sujeción de la herramienta giratoria. Deslice la pinza y la broca o bit sobre el 
eje: 

 

• Deslice el “collet nut” sobre la pinza y el bit. Mantenga presionado el botón de bloqueo del eje mientras 
aprieta el "collet nut” en el “shaft”: 

 

• Una vez que el “collet nut” esté apretada a mano, suelte el botón. 
 
 

7.07 Adjuntando la Herramienta Rotatoria a la KNK Force 
 

7.07.1 Adjuntando el Adaptador al Asiento de la Cuchilla  
  

   

• Apague la KNK Force y asegúrese que la herramienta giratoria no esté enchufada. 

• Mueva la cabeza de la Force a la izquierda unos cuantos centímetros para permitir más espacio para la 
instalación de la herramienta. 

• Quite completamente los dos tornillos delanteros del asiento izquierdo del portacuchillas.+ 

Presione firmemente el 

botón del shaft 

Gire la tuerca del “collet 

nut” en sentido de las 

agujas del reloj hasta que 

quede apretada. 

https://www.youtube.com/watch?v=DAzfX9W2ZnI


155 

 

• Deslice el adaptador en el asiento izquierdo del portacuchillas para que la ranura del adaptador se deslice 
sobre la parte delantera del asiento: 

 

• Empuje el adaptador directamente hacia abajo hasta que los orificios del adaptador se alineen con los 
orificios del asiento del porta-cuchillas: 

 

• Vuelva a insertar los dos tornillos delanteros para que pasen a través del adaptador y a través del asiento 
del portacuchillas. Apriete a mano esos tornillos: 

 
 
  

7.07.2 Inserción de la Herramienta Giratoria al Adaptador  

• Coloque el material a ser cortado o grabado sobre el tapete de corte. Por lo general es una buena idea 
adherir el material con cinta adhesiva a lo largo de los bordes exteriores para evitar el deslizamiento. 
Aunque no se muestra en las siguientes fotos, se recomienda encarecidamente que un material tal como 
una hoja de aglomerado o cartón se adhiera con cinta adhesiva sobre el tapete para proporcionar una capa 
protectora, como se mencionado en la prueba (Sección 7.05). 

• Haga clic en Replace Left Tool (Reemplazar la herramienta del lado izquierdo). En este punto, usted sólo 
debe tener el adaptador giratorio instalado en el lado izquierdo. Haga clic en Continue (Continuar) para 

Adaptador 

Asiento del Porta-

cuchillas 
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que el lado izquierdo se mueva hacia abajo. La distancia que baje es basada en Surface Height (la altura 
de superficie) introducida en C3.  

• ¡IMPORTANTE!  Compruebe que la pantalla en C3 ahora está mostrando que es hora de insertar la 
herramienta: 

 

• Inserte la herramienta rotativa con la cerradura del eje apuntando hacia adelante para que pueda deslizarse 
a través de la pequeña abertura en la parte delantera. 

 

 

• Mueva el tapete para que el origen Z se coloque sobre la parte superior del material.  
 

• Deslice la herramienta giratoria directamente hacia abajo hasta que la punta del bit o broca toque la parte 
superior del material. Si el bit o broca no puede alcanzar la superficie, remueva la herramienta giratoria, 
presione la cerradura del eje (shaft lock), afloje la tuerca de la pinza (collet nut) y deslice el bit o broca para 
obtener más exposición. Vuelva a apretar la tuerca del collar (collet nut) y vuelva a insertar la herramienta 
giratoria al adaptador. 

 

 

 

• Apriete el adaptador utilizando la llave Allen incluida. Usted puede encontrar que sea más fácil girar la llave 
si usted retira los tornillos del lado derecho asiento: 

Cerradura del Eje (Shaft 

lock) apuntando hacia 

adelante 

La punta debe tocar la parte 

superior del material.  
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• Conecte el adaptador AC/DC al cable de corriente y enchúfelo a una toma de corriente. Hay una esfera de 
control de velocidad en el adaptador. Además, hay un interruptor de on/off (encendido/apagado) en la 
propia herramienta giratoria. ¡Antes de iniciar el corte o el grabado en C3, recuerde encender la 
herramienta giratoria!  ☺ 

 
 
 
 

7.08 Grabado  

• ¡IMPORTANTE!  ¡No intente utilizar los bits o las brocas más delgadas para grabar! 

• Con el grabado, el CD/ED es cuan profundo usted desea que el grabado sea. En general, ese número 
puede ser relativamente bajo. El mejor enfoque es referirse a la tabla al final de este capítulo. Si el material 
o un material similar no aparece en la lista, entonces comience con una estimación conservadora, tal como 
5. Más pasadas y un ED más alto puede ser utilizado para lograr el efecto deseado. También, utilice un SD 
bajo para permitir que la herramienta trabaje su manera a la profundidad de grabado deseada. 

• El cambio de CD/ED varía ligeramente a lo largo del eje Z. Para el grabado, usted puede aproximar el 
CD/ED a ingresar a C3 usando la siguiente tabla. Al igual que con todas las aplicaciones, la realización de 
pruebas con figuras pequeñas es la clave para optimizar la configuración:  

Encienda la herramienta 

giratoria aquí.  

 

Apriete el adaptador 

utilizando la llave Allen 

incluida. 
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CD/ED inches mm CD/ED inches mm

1 ~0.0004 ~0.01 140 ~0.056 ~1.42

10 ~0.004 ~0.10 150 ~0.060 ~1.52

15 ~0.006 ~0.15 160 ~0.064 ~1.63

20 ~0.008 ~0.20 180 ~0.072 ~1.83

30 ~0.012 ~0.30 200 ~0.08 ~2.03

40 ~0.016 ~0.41 220 ~0.088 ~2.23

50 ~0.020 ~0.51 240 ~0.096 ~2.44

60 ~0.024 ~0.61 260 ~0.104 ~2.64

70 ~0.028 ~0.71 280 ~0.112 ~2.84

80 ~0.032 ~0.81 300 ~0.120 ~3.05

90 ~0.036 ~0.91 320 ~0.128 ~3.25

100 ~0.040 ~1.02 340 ~0.136 ~3.45

120 ~0.048 ~1.22 360 ~0.144 ~3.66  

• Recuerde ajustar las cuatro velocidades a valores bajos apropiados. Consulte la tabla en Sección 7.03.  
 

• Recordatorio: Evite golpear la Force o el tapete mientras la herramienta giratoria está en uso. Esto puede 
causar defectos o incluso roturas en el producto final.  

 

• Recordatorio: Mantenga las ruedas de pellizco limpias. Una acumulación de polvo o virutas finas puede 
impedir el agarre adecuado del tapete y dará lugar a una distorsión del grabado. 

 

• Para obtener más información sobre el grabado, echa un vistazo al siguiente enlace enviado por Michele 
Harvey: 

http://www.antaresinc.net/EngFact.html 

• Los tipos de letra de una sola línea son muy útiles en el grabado. Aquí hay un enlace para una colección 
gratuita en formato TTF:  

http://www.mrrace.com/CamBam_Fonts/ 

7.09 Corte 
 

7.09.1 Cosas a Tener en Cuenta  

• ¡IMPORTANTE!  Si usted no ha leído las Secciones 7.03 - 7.05, entonces vaya atrás y trabaje a través de 
ellas. Es muy fácil arruinar un tapete de corte e incluso dañar la superficie de su Force si usted tiene 
configuraciones incorrectas. 
 

• ¡IMPORTANTE!  ¡No intente utilizar los bits o brocas más delgadas para cortar! 
 

• Siempre aumentar Passes (Pasadas) antes de aumentar ED. La prueba con el bolígrafo determina la ED 
necesaria para el material, pero la herramienta rotativa puede necesitar más pasadas para penetrar 
completamente el material que se está cortando.  

 

• Recordatorio: Evite golpear la Force o el tapete mientras la herramienta giratoria está en uso. Esto puede 
causar defectos o incluso roturas en el producto final.  

 

• Recordatorio: Mantenga las ruedas de presión limpias. Una acumulación de polvo o virutas finas puede 
impedir el agarre adecuado del tapete y dará lugar a una distorsión del corte. 

 

• En el Apéndice B6 se presenta un procedimiento de diagrama de flujo para el corte de prueba con la 
herramienta de rotatoria de la Force. Use esto para solucionar cualquier problema. 

 

• Una vez que usted haya terminado de usar la herramienta giratoria y volver a colocar el portacuchillas, 
recuerde cambiar Surface Height (la Altura de Superficie) en C3 (suponiendo que se cambió de la 
configuración normal de 300). 

 

Para Grabado Solamente! 

 

Refiérase a la Calculadora 

en Línea para determinar 

CD/ED al cortar.  

http://www.antaresinc.net/EngFact.html
http://www.mrrace.com/CamBam_Fonts/
http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm
http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm
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7.09.2 Lista de Comprobación Importante Antes de Cortar! 

• ¿Ha medido usted el grosor del material y ha utilizado la calculadora en línea para determinar Ending 
Depth (la Profundidad final), Starting Depth (Profundidad inicial) y Surface Height (Altura superficial) para 
el corte de prueba? 

• ¿Ha realizado usted la prueba con el bolígrafo para verificar la exactitud de Ending Depth (la Profundidad 
final)? 

• ¿Tiene usted el material firmemente pegado al tapete, en la ubicación requerida, y el tapete insertado en la 
cortadora?   

• ¿Tiene usted el tapete debajo de al menos dos ruedas de presión y las palancas bajadas en la parte 
trasera? 

• ¿Están Las ruedas de presión alineados bajo etiquetas grises? 

• ¿Ha configurado usted el Origen Z?  

• ¿Ha ingresado usted todos los ajustes? ¿Ha establecido usted las Passes (pasadas) suficientes e 
introducido velocidades lentas, según apropiadas para el uso con la herramienta giratoria? 

• ¿Ha configurado usted el origen XY en la esquina frontal derecha de su material (o donde usted necesite el 
origen)?  

• ¿Ha seleccionado usted el tipo de bit correcto para su aplicación? ¿Está todo instalado de forma segura? 

• ¿Ha encendido usted la alimentación de la herramienta giratoria? 

• ¿Sabe usted, con confianza, dónde van a cortar sus figuras? 

 
 

7.10 Consideraciones al Diseñar  

• Debido a que una herramienta rotativa es considerablemente más gruesa que una cuchilla, ajustes en el 
diseño pueden ser necesarios. 

 Por ejemplo, si una figura es delgada, es posible que no se corte correctamente porque el bit es más 
ancho que el grosor de una o más rutas en la figura: 

 

 La solución es hacer más gruesa la figura en el programa de diseño. Todos los programas vectoriales 
comunes tienen una función de contorno que se puede utilizar para este propósito. En MTC y SCAL la 
función es llamada Shadow (Sombra). En Inkscape, es llamada Outset.   

 Al determinar el tamaño del contorno, pruebe la mitad del tamaño del bit o broca que se utilizará en la 
herramienta giratoria. Por ejemplo, para bits de 1/16 ", utilice 0.031". Para bits de 1/8 ", utilice 0.062”. 

La curva es muy delgada, 

podría producirse una rotura 

aquí. 
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 Sin embargo, dependiendo del diseño, un contorno demasiado grande también podría causar una 
rotura en otra parte. Por ejemplo, en el diseño anterior, si se crea un contorno más grande, entonces el 
espacio entre las curvas podría estar demasiado cerca para un corte exitoso: 

 

 

• Así, habrá limitaciones en qué diseños se pueden cortar con la herramienta giratoria. En su programa de 
diseño, hacer un pequeño rectángulo que es el tamaño del diámetro rotatorio debe ayudarle a determinar si 
su diseño es viable para el corte. Cuando sea necesario, haga el diseño más grande, si es posible, será 
una solución. Otra cosa es, utilizar un bit o broca más pequeña para cortar. 

• A la inversa, hay situaciones en las que se requiere una línea interna para obtener el tamaño final correcto. 
Por ejemplo, si usted está intentando perforar un agujero de ½ " en un objeto usando un bit o broca de 1/8", 
entonces el agujero acabará siendo 5/8" de diámetro debido al extra 1/16" que se extiende más allá de la 
trayectoria de corte y todo el alrededor del círculo. 

• Así, en este caso, aplicar una línea interna de 1/16 "(0.0625") creará un círculo de diseño de 3/8" de 
tamaño. Cuando este círculo de 3/8" es cortado con un bit o broca de 1/8", el círculo resultante es 4/8" o ½" 
de diámetro. 

    
 
 
 

• Una vez más, estas funciones están disponibles en los programas de diseño. Un inline en MTC se crea 
utilizando un ancho negativo en la función de Shadow (sombra). En SCAL, hay una opción Insert Sombra 
para marcar en la ventana de Sombra. En Inkscape, la función se llama Inset. 

  

Las curvas están demasiado 

cerca con un contorno aún 

mayor. 

La aplicación de un contorno en 

el programa de diseño evitará la 

rotura y permitirá que la versión 

delgada ser cortada. 

 

Rojo: Círculo deseado de ½" 

Azul: Círculo resultante de 

5/8 "debido a la utilización 

de un bit de 1/8"  

Rojo: Circulo deseado de ½” 

Verde: Trayectoria cortar para 

que el resultado final sea un 

círculo de ½ " 
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7.11 Revisión del Capítulo 7 
 

7.11.1 Resumen o Configuración de la Herramienta Giratoria 
 

Ajustes
Sección a 

Leer
Descripción

Rango típico Para el Uso de 

Herramientas Rotatorias

Cut>Layer Settings

Passes, P 3.02.1
Número de repeticiones a realizar en una figura antes 

de pasar a la siguiente figura
1-20; usualmente 2 - 5

Starting depth, SD 3.02.3 La profundidad objetivo para la primera pasada
Profundidad final dividida por 

pasadas

Cutting depth / Ending depth, CD/ED 3.02.2
La herramienta de profundidad máxima se desplazará 

en la dirección Z antes de ir más allá
Use la calculadora en línea

Cutting speed, CS 3.02.4
Cuán rápido se mueve la herramienta mientras está en 

la posición hacia abajo
1-10

Up speed, US 3.02.5

Cuán rápido la herramienta se desplaza en la posición 

arriba, moviéndose de un lugar a otro para comenzar a 

cortar

10-15

Plunge speed, PS 3.02.6
Cuán rápido la herramienta cae de la posición hacia 

arriba a la posición hacia abajo
5-10

Lift speed, LS 3.02.7
Cuán rápido la herramienta sube de la posición hacia 

abajo a la posición hacia arriba
10-15

Cutting tool, CT 3.02.8

Dado que el adaptador para la herramienta rotativa 

sólo funciona en el lado izquierdo, el CT debe estar 

siempre en L.

L

Blade offset, BO 3.02.9
Una herramienta giratoria tiene un desplazamiento de 0 

porque la punta está centrada con el centro del eje
None

Path Direction, PD 3.02.10

Alterna la dirección en la que se cortarán todas las 

figuras (en el sentido de las agujas del reloj vs en 

sentido contrario a las agujas del reloj, de izquierda a 

derecha vs derecha a izquierda, etc.)

Normal

Cut>Advanced Settings

Optimize cut order, OCO 3.02.10
Actualmente no está implementado, por lo tanto, dejar 

en Off
Off

Closed path overcut, CPO 3.02.10
Una herramienta rotativa no necesita sobrecorte porque 

la punta está centrada con el centro del eje
0

Print-and-cut registration layer 6.05
Asignar qué capa tiene marcas de registro en las 

aplicaciones PNC

Lo mismo, Ninguno para corte 

regular o capa con marcas de 

registro para PNC

Settings>Machine Settings

Surface Height, SH 7.04.2

El lugar donde la cabeza caerá para establecer el 

origen Z (puede ser necesario bajarlo para materiales 

más gruesos)

Utilizar el valor final en la 

calculadora en línea
 

 
 

7.11.2 Cosas a Tener en Cuenta  

• Lea todas las instrucciones de seguridad en la Sección 7.01 antes de operar la herramienta giratoria. 

• Sea conservador con los ajustes (Sección 7.03): 

 Utilice velocidades más lentas. 

(Sección 7.03) 
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 Utilice varias pasadas.  Siempre intente aumentar Passes (las pasadas) antes de aumentar el CD/ED. 

 Aumente CD/ED en incrementos conservadores.  

• No intente utilizar los bits o brocas más delgadas para grabado o corte. Estas están destinadas a ser 
utilizadas para perforar agujeros en materiales blandos (Sección 7.02).  

 
 

7.11.3 Guía Rápida: Prueba con el Bolígrafo  

(1) Reúna los siguientes elementos: 

 Bolígrafo con una punta firme 

 Material a ser cortado 

 Hoja de aglomerado u otro material para proteger el tapete de corte 

 Cinta adhesiva 

 Hoja de papel de copia 

 Opcional: Pequeño trozo de papel de aluminio o envoltura de plástico para proteger el material de la 
tinta. 

(2) Abra un pequeño archivo de prueba, como un círculo o un cuadrado.  

(3) Utilice cinta adhesiva para sujetar el panel de aglomerado (o un material alternativo) sobre la estera para 
protección.  

(4) Adjunte una hoja de papel de copia sobre la capa de protección:  

(5) Ahora coloque el material que va a cortar en la parte superior del papel. 

(6) En Settings>Machine Settings, introduzca Surface Height que coincida con lo que se utilizó en la 
calculadora en línea. Haga clic en Apply Changes.  

(7) Haga clic en Replace Left Tool. Quite la herramienta del lado izquierdo, si alguna está instalada. 

(8) Haga clic en Continue y el lado izquierdo caerá. ¡IMPORTANTE! Inserte el bolígrafo que la punta toque la 
parte superior del material. Utilice el papel de aluminio o el plástico, si es necesario. 

(9) Apriete los tornillos delanteros y haga clic en Continue (Continuar) para que el lado izquierdo suba y vuelva 
a su lugar original. Quite el material pero deje la hoja de papel. 

(10)  Introduzca CD/ED de la calculadora en línea (use el Calculado, si usted utilizó un calibrador para medir el 
grosor; De lo contrario, utilice el Recomendado. Utilice sólo 1 pasada para la prueba.  

(11)  Establezca un origen XY y luego ejecute el dibujo de la figura de prueba.  

 Si el bolígrafo no marca en el papel, aumente el CD/ED en 20 y repita. 

 Si el bolígrafo hace una marca oscura y recorta el papel, disminuya el CD/ED en 10 y repita. 

 Si el bolígrafo hace una marca muy débil en el papel, entonces el CD/ED está dentro del alcance de 
hacer un corte exitoso.  

 
 

7.11.4 Guía Rápida: Prueba de Corte con la Herramienta Giratoria  

(1) Medir el espesor del material a ser cortado (Sección 7.04.1). 

(2) Introduzca el grosor y Surface Height (la Altura de la Superficie) en la Calculadora en Línea de la 
Herramienta Rotatoria para obtener un Cutting Depth/Ending Depth (Profundidad de Corte / Profundidad 
Final) para la prueba (Secciones 7.04.2 y 7.04.3). 

(3) Realizar la prueba con el bolígrafo (Sección 7.05). Repita hasta que se determine Cutting Depth / Ending 
Depth (la Profundidad de Corte / Profundidad Final) correcta. 

(4) Seleccione el bit de corte apropiado para la herramienta giratoria y monte la herramienta giratoria en la 
Force. (Sección 7.06 y Sección 7.07). 

(Resumen de las secciones 7.04 – 7.09) 

(Summary of Section 7.05) 

http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm
http://www.iloveknk.com/wp-content/uploads/2016/04/Force-RotaryTool-Calculator.htm
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(5) Seleccione una figura pequeña apropiada para el corte de prueba. 

(6) Introduzca todos los ajustes en C3 (Sección 7.03). 

(7) Con cinta adhesiva, asegure firmemente el material al tapete, en el lugar requerido. Añada una capa de 
protección entre el tapete y el material, si uno fue utilizado durante la Prueba con el Bolígrafo. 

(8) Inserte el tapete de corte a Force que las dos ruedas externas de presión estén sobre el tapete.  

(9) Verifique que las ruedas de presión estén alineadas bajo los rectángulos grises. 

(10)  Ajuste el Origen Z con la punta del bit o broca tocando la parte superior del material.  

(11)  Establezca el origen XY en la esquina inferior derecha de su material (o donde usted necesita el origen).  

(12)  Encienda la herramienta giratoria. 

(13)  Ejecutar el corte. 

(14)  Utilice el diagrama de flujo en el Apéndice B6 para ajustar la configuración.  

(15)  Repita los cortes de prueba hasta que esté satisfecho con los ajustes de corte. 
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Formulario de Configuración Para la Herramienta Rotativa de  la Force1 

 
 

Tipo de material y  

espesor

Material Marca, Fuente, 

Color, etc.

Tipo 

de Bit
Aplicación SH P SD CD/ED CS US PS LS Otros Ajustes y  Comentarios

 
1 © 2015- 2017 Sandy McCauley, All Rights Reserved   
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Ajustes de Grabado Sugeridos Para la Herramienta Rotativa de la Force1 
 
 
 
 
 
 
 

Suggested Settings for Force Rotary Tool
1

Material
Fuente del 

Material
Aplic. P SD

CD/

ED
CS US PS LS Otros Comentarios

Acrílico - 1/8" Grabado 1 2 10 20 10 20

Hoja de Plástico 

Decorativo
Grabado 1 2 10 20 10 20

Color dual, 'graba' saca el color superior para revelar el 

patrón en el color 'core'. 

www.decorativeplasticsheets.com

Plástico Dorado 

Reflejado

Productos de 

Midwest (ver 

Comentarios)

Grabado 1 15 15 20 10 20
Midwest Products 707-01 Super Sheets Mirror Styrene, 

0.040 Inch

Plex iglás (mejor 

conocido como acrílico 

duro)

clearscraps.com Grabado 3 1 10 15 15 10 15

These suggested settings are for initial test cut purposes. Note that Z Origin for engraving is set on top of the material; Z Origin for cutting 
and drilling holes is set on top of the mat.

P – Passes; SD – Start Depth; CD/ED: Cut Depth/End Depth; CS – Cut Speed; US –Up Speed; PS – Plunge Speed; LS – Lift Speed 

IMPORTANT: rev iew and adhere to all safety  instructions presented in Section 7.01 before using the rotary tool

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1 © 2015, 2016, 2017 Accugraphic Sales, Inc., All Rights Reserved 

  

Estos ajustes sugeridos son para propósitos de corte de prueba inicial. Tenga en cuenta que el Origen Z debe configurarse encima 

del material que usted está grabando. 

 

P – Pasadas; SD – Profundidad Inicial; CD/ED: Profundidad de Corte/Profundidad Final; CS – Velocidad de Corte; US – Up 

Speed; PS – Velocidad de Hundimiento; LS – Velocidad de Elevación  

 

IMPORTANTE: Revise y respete todas las instrucciones de seguridad presentadas en la Sección 7.01 antes de usar la 

herramienta rotativa. 
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Capítulo 8 Consejos Para Cortar Materiales Específicos 
 
 

 
8.01 Cartulina y Papel 
 

 
 

Selección de Cartulina y Papel 

 

• El cartón de núcleo blanco no produce la misma calidad de corte que el cartón de núcleo de color sólido. 

• Algunas marcas de cartón o tipos simplemente no cortan bien. Utilice ésos para algo más además de cortar 
figuras complejas. Otras cartulinas, como Worldwin Cutmates, Colormates y Michael's Recollections, cortan 
con hermosura. 

• Si el material ha sido expuesto a la humedad, seque durante unos 15 a 30 minutos en un horno que haya 
sido precalentado a la temperatura más baja, pero que luego se haya apagado antes de colocar el material 
en su interior. Una vez seca, guarde el material en bolsas de plástico o recipientes para sellar la humedad. 
Si usted sólo necesita secar una sola hoja, usted también puede utilizar un secador de pelo o una 
herramienta de calor en relieve. También se ha informado de que la cuchilla para cortar tela maneja el corte 
de cartón expuesto a la humedad mejor que las otras cuchillas. 

• Con cada marca de papel o cartulina, registre los ajustes de corte que funcionan bien para que la próxima 
vez tenga un buen punto de partida para el corte de prueba. Además, tenga en cuenta que es muy 
importante realizar un corte de prueba ya que algunos colores del mismo papel o cartulina pueden requerir 
ajustes más altos que otros colores. 

 

 
Ajustes 
 

• Hay puntos de inicio de corte de prueba que se muestran en los Ajustes de corte sugeridos para varios 
materiales en la tabla KNK Force al final del capítulo 3. Utilice estos como guías para los cortes de prueba y 
luego ajuste, según sea necesario, para factores como el embotamiento de la cuchilla, humedad, condición 
del tapete de corte, etc. ¡Recuerde registrar sus propios éxitos! 
 

• Para un corte consistente, utilice únicamente las ruedas de presiones externas, colocadas debajo de los 
rectángulos grises más exteriores. Coloque la cartulina de modo que quede entre estas ruedas de presión, 
en lugar de debajo de uno de ellos. 

 

• Para la mayoría de papel y cartulina, utilice la cuchilla con tapa roja. Para cartulinas muy gruesas o muy 
texturizadas, es posible que usted desee utilizar la cuchilla con tapa azul. Independientemente de la 
selección de la cuchilla o el grosor del papel o cartulina, siempre ajuste el origen Z utilizando la superficie 
del tapete. 

 

• Cutting Speed (CS) (Una velocidad de corte) de 25 debe funcionar bien para la mayoría de los cortes de 
papel y cartulina. Algunos usuarios prefieren cortar más rápido y algunos más lento. Utilice su propia 
experiencia como guía. 

 

• El papel puede ser especialmente sensible a desgarrarse. Primero utilice ajustes muy ligeros cuando lo 
pruebe. Ponga el Blade Tension (BT) (ajuste de la tensión de la cuchilla) en el soporte de la cuchilla 
ajustado en ~ 1,0 - 2,5, dependiendo del peso de la cartulina. 

 

• La fuerza de corte variará dependiendo de la densidad del papel o cartulina, cualquier exposición a la 
humedad, el embotamiento de la cuchilla, el estado del tapete e incluso el tinte utilizado para colorear el 
material. Dos pasadas a menudo pueden ser necesarias con algunas cartulinas, independientemente de los 
ajustes a otras configuraciones. Esto es especialmente cierto cuando se cortan figuras complejas. 

 

¡INCOMPLETO! 

http://teamknk.com/?s=cardstock&submit=Search
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• Mantenga el tapete de corte limpio y pegajoso. Utilizar un rodillo sobre la cartulina en el tapete asegurará la 
adherencia firme y uniforme. Pasar el rodillo nuevamente después del corte puede ayudar a eliminar los 
desperdicios de las figuras cortadas. Gracias a Julie Flanagan que descubrió que ubicar una caja de DVD 
debajo de la parte delantera de la mesa plegable, impide que la Force se incline hacia adelante al pasar el 
rodillo. Yo agregué una segunda caja al lado de ella para ampliar el área de apoyo. 

 

• Reemplace el tapete cuando se deforme o se cubre en una gran cantidad de cortes. Cualquier diferencia de 
grosor a lo largo del tapete puede resultar en un corte incompleto. 

 
Solución de problemas  
 

• La siguiente lista presenta las diversas causas de desgarre: 
 

 Cutting Depth (CD) / Ending Depth (ED) (La profundidad de corte (CD) / Profundidad final (ED)) es 
demasiado alta. Usted sólo debe cortar a través del material en sí y luego raspar la capa adhesiva en el 
tapete. Si usted siente cortes profundos en el tapete de corte, entonces esto puede llevar a desgarrar el 
papel. 
 

 La Blade Tension (BT) (tensión de la cuchilla (BT)) en el portacuchillas está ajustada demasiado alta. 
Para papel más ligero, utilice una configuración de 1. 
 

 La cuchilla está astillada. Pruebe con una cuchilla diferente. 
 

 El papel no se adhiere bien al tapete. Asegúrese de que el tapete esté limpio, pegajoso y que el papel 
se presione suavemente y uniformemente sobre la superficie. 
 

 Es posible que usted tenga demasiados nodos en una figura demasiado pequeña. 
 

 Si la cartulina se ha expuesto a la humedad, la humedad del material puede dificultar el corte limpio. 
Trate de secar la cartulina. 
 

 El material en sí puede estar sujeto a rasgaduras, especialmente en cortes complejos. Pruebe con otro 
papel o cartulina. 
 

• Si la cartulina tiene espacios que no cortan completamente: 
 

 Verifique que la cartulina esté bien adherida al tapete. Asegúrese de que el tapete esté limpio y 
pegajoso. Si el material se separa del tapete durante el corte, esos puntos no se cortarán. También, 
utilice un rodillo para incluso presionar del material al tapete. 
 

 Intente aumentar Blade Tension (BT) (la Tensión de la Cuchilla (BT)) por la mitad de un ajuste 
primero. Si los cortes aún no se completan, entonces, comience a aumentar Cutting Depth (CD) (la 
profundidad de corte (CD)0 por 5 ajustes a la vez (por ejemplo, intente 75 en lugar de 70). Además, 
algunas marcas de cartulina requieren dos pasadas, así que reduzca Ending Depth (ED) (la 
profundidad final (ED)) y establezca Passes (P) (Pasadas (P)) a 2. 
 

 Para “guardar un corte”, voltee toda la hoja sobre el tapete y use papel de lija para lijar los puntos 
donde los cortes no se completaron. Usted debe ser capaz de lijar hasta donde la cuchilla cortó en 
esos lugares y su diseño será liberado de la basura. Esta es la mejor manera de mantener los bordes 
exteriores lisos. 
 

• Si algunas de las figuras no están completamente cortadas donde la cuchilla comienza y se detiene: 
 
 Compruebe que Closed Path Overcut (CPO) (el ajuste de saturación de trayectoria cerrada (CPO)) 

coincide con el que se necesita para la cuchilla que usted está utilizando. Consulte la Sección 3.02.11. 
 

• Si las esquinas de los rectángulos son ligeramente redondeadas: 
 Compruebe que Blade Offset (BO) (el ajuste de desplazamiento de la cuchilla (BO)) coincide con el 

que se necesita para la cuchilla que usted está utilizando. Consulte la Sección 3.02.9. 
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• Si una cartulina con textura se corta mal, intente voltearla y colocar el lado con textura hacia abajo. 
Recuerde reflejar las figuras antes de cortar, según sea necesario (por ejemplo, texto). 
 

• Otra sugerencia para cortar la pobre cartulina es usar la herramienta de gofrado para presionar primero las 
figuras que se desean cortar. Luego, repetir el corte con el portacuchillas. Esto produce resultados más 
limpios con papel de cartón de corte pobre. (¡Gracias a Michele Harvey por este descubrimiento!). 

 

8.02 Cartón  
 

 
 
Selección de Cartón 
 

• Existen muchos tipos de materiales que se consideran aglomerados. Algunos pueden ser cortados y otros 
no. Las mejores guías son: 
 

 Si el cartón es muy grueso que la longitud máxima de la cuchilla, entonces este no se puede 
cortar. 
 

 Si el cartón es muy rígido y no se puede doblar fácilmente, entonces es posible que se pueda 
cortar, pero las figuras pueden requerir ser simples. 

 
 Si el cartón es muy grueso y muy denso, entonces corte con la herramienta giratoria KNK 

Force. 
 

 

• Los cartones flexibles delgados son la mejor opción. Vale la pena encontrar una determinada marca de 
cartón, como la que se vende en KNK USA, para usar en sus proyectos para que usted sepa qué 
configuraciones funcionan mejor cada vez. 
 

• Para obtener una apariencia más gruesa, considere cortar dos copias de la misma figura de cartón más fino 
y adherirlas juntas. 

 

• Al igual que con algunas marcas de cartulina texturizadas, algunos tipos de cartón producirán cortes más 
limpios en la parte inferior. Por lo tanto, refleje sus imágenes primero después de verificar que usted puede 
utilizar el otro lado de la figura cortada. 

 
Ajustes 
 

• El cartón puede desprenderse fácilmente del tapete. Utilice un rodillo para presionar firmemente el cartón 
en un tapete limpio y pegajoso. Además, use cinta adhesiva o cinta de pintor azul alrededor de los bordes 
exteriores del cartón para evitar que este se resbale durante el corte. También usted puede aplicar un 
estabilizador, como papel de congelador o Heat n 'Bond, en la parte inferior del cartón para mejorar en gran 
medida la consistencia del corte, así como la complejidad de lo que se puede cortar correctamente. 
 

• Ajuste el origen Z con la superficie del tapete. 
 

• Utilice la cuchilla con tapa azul. Ajuste Blade Tension (BT) (la tensión de la cuchilla) de acuerdo con las 
recomendaciones en la tabla al final del Capítulo 3. Utilice Cutting Speed (CS) (una velocidad de corte) 
más lenta y Plunge Speed (PS) (una velocidad de inmersión) más lenta, refiriéndose de nuevo a la tabla. 

 

• La Force ofrece velocidades muy lentas y el corte de cartón grueso y denso puede requerir de estas. No 
dude en reducir Cutting Speed (CS) (la velocidad de corte) a un ajuste de menos de 10, si usted encuentra 
que la cortadora está luchando para cortar el cartón o las figuras que se cortan se distorsionan. A menos 
que el cartón sea muy delgado o las figuras sean muy simples, se requerirán dos o más pasadas. 

 

• Aproveche la capacidad de la Force para cortar en profundidades cada vez más altas. Ajuste Starting 
Depth (SD) (la Profundidad Inicial) a una fuerza similar para cortar un cartón pesado y luego Ending Depth 
(ED) la Profundidad Final) en el ajuste esperado más alto. 

http://knkusa.com/product-category/materials/chipboard/
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Solución de problemas 
 

• Algunos cartones producirán una gran cantidad de "migas" durante el corte y esto puede acumularse dentro 
del portacuchillas así como acumularse alrededor de las líneas de corte causando interferencia con la 
cuchilla durante el segundo paso. Por esta razón, algunos usuarios usarán aire enlatado para soplar las 
migas lejos de la superficie entre cada pasada. También es posible que usted deba limpiar el interior del 
portacuchillas retirando la cuchilla y desmontándola para que pueda remover cualquier pieza pequeña. 
 

• Si el corte de prueba fue perfecto, pero las figuras no se cortaron correctamente, puede que el tapete no 
haya estado lo suficientemente pegajoso para sostener el cartón a lo largo del corte. En lugar de agregar 
más adhesivo, es posible que usted desee utilizar un estabilizador como se describe en Selección de 
aglomerado. También, trate de reducir la velocidad del corte si las figuras son bastante detalladas y las 
secciones sin cortar estaban en curvas cerradas. 

 

• Si se oye un sonido de tartamudeo durante el corte y/o se distorsionan las figuras, reduzca la velocidad y 
aumente el número de pasadas. Si ya usted está utilizando más de una pasada, baje Starting Depth (SD) 
(la profundidad de inicio) y aumente Passes (P) (las pasadas). La cuchilla se está atrapando en el cartón 
que hace que el tapete se deslice. Usted necesita hacer las cosas más fáciles en la cortadora como la 
cuchilla funciona su camino a través del denso cartón. 

 
8.03 Vinyl 

 

Vinil para Pared:   Vinil Decoratiovo:    
 

Tipos de Vinil 
 

• Hay muchos tipos de vinil disponibles en KNK USA: calcomanía, pared, brillo, metálico, pizarra, etc. Es un 
material muy fácil de cortar y tiene muchas aplicaciones. 

 
Settings 

 
• El vinil tiene una lámina de respaldo que puede servir como soporte/tapete durante el corte. El vinil debe 

ser de al menos 5" de ancho para que ambos lados se agarren con las ruedas de presión. Si usted está 
cortando un vinil que es más estrecho que esto o cortando de los desechos, entonces, utilice un tapete de 
corte para sostener el vinil durante el corte. 
 

• En los cortes largos, es importante tener el vinil alineado perfectamente recto en la máquina. Alimente el 
vinil al menos la mitad de la longitud del proyecto antes de dejar caer las ruedas de pellizco. Utilice los 
botones de origen en C3 para alimentar el vinil dentro y fuera, la mayor parte del camino, para asegurarse 
de que el vinil se mantiene alineado. 

 

• Al diseñar una aplicación de vinil, recuerde: 
 

 C3 actualmente sólo corta en una orientación vertical (retrato). Por lo tanto, para cortes de más de 15" 
puede que usted tenga que girar las figuras en el software de diseño para que el lado más largo de 15" 
sea hacia arriba y hacia abajo (estilo de retrato) en lugar de izquierda a derecha. 
 

 La única vez que usted necesita para reflejar figuras que serán cortado de vinil es si el diseño se 
aplicará al interior de una superficie, pero visto desde el exterior. Por ejemplo, en el interior de una 
ventana de coche o el interior de una ventana de dormitorio. (Tenga en cuenta que al cortar HTV, las 
formas deben reflejarse, consulte la Sección 8.05). 
 

• Siempre use una cuchilla con tapa roja al cortar el vinil. 

• Al configurar el origen Z: 
 
 Si el vinil se está cortando en un tapete, utilice la superficie del tapete para el ajuste del origen Z. 

http://knkusa.com/product-category/materials/vinyl/
http://teamknk.com/?s=vinyl&submit=Search
http://teamknk.com/?s=wall+vinyl&submit=Search
http://teamknk.com/?s=Decal+Vinyl&submit=Search


170 

 

 
 Si el vinil se alimenta directamente a la Force sin usar el tapete, coloque el origen Z en la superficie del 

mismo vinil. 
 

• Tenga en cuenta que los ajustes sugeridos para el vinil en la tabla al final del Capítulo 3. Cutting Depth 
(CD) (La profundidad de corte) es menor si el vinil se está cortando sin el tapete versus con tapete. 
 

• Aunque hay muchos tipos y grosores de vinil, en general, es muy fácil de cortar. Por lo tanto, comience con 
ajustes conservadores. Utilice la cuchilla con tapa roja y ponga la tensión de la cuchilla (BT) en 1. Haga el 
corte de prueba y levante suavemente la esquina del vinil de la hoja de respaldo. Asegúrese de que el corte 
de prueba es un corte limpio y la cuchilla no penetró en el papel de respaldo. 

 

• ¡IMPORTANTE! No asuma que la misma configuración funcionará en un color diferente del mismo vinil. La 
experiencia indica que el grosor del vinil (y por lo tanto los ajustes necesarios para el corte limpio) puede 
variar de un color a otro de la misma marca y tipo. Por lo tanto, siempre planee cargar una pequeña figura 
de corte de prueba para verificar que se han elegido los mejores ajustes. 

 

• Por lo general, el vinil se puede cortar a una velocidad de ~ 25-30, a menos que se trate de figuras muy 
pequeñas e intrincadas. En esa situación, Cutting Speed (CS) (una velocidad de corte) de ~ 20 - 25 
probablemente será mejor. 

 

• El adhesivo en vinil puede verse afectado por cambios en el medio ambiente (como temperaturas cálidas o 
frías). Esto puede afectar el corte. Si usted nota que el vinil se está separando del papel de respaldo, trate 
pasándole un rodillo antes de cortarlo. También tenga en cuenta que algunos colores de vinil tienen una 
tendencia a separarse de la hoja de respaldo más fácilmente que otros. Si observa el vinil se está 
levantando en las esquinas y los puntos apretados, trate de bajar la velocidad de corte. 

 
Aplicación de Vinil 
 

• Para una extracción más fácil de los residuos del papel de respaldo, añada un rectángulo alrededor del 
perímetro de la figura que usted está cortando. Seleccione todo y aplique una Combinación (o función 
similar según el software en uso). Esto asegurará entonces que las figuras interiores se corten primero, 
con el rectángulo exterior cortando último. 
 

• Cuando se eliminen los residuos de la figura, es posible que usted tenga que cortar y eliminar partes de 
desecho más pequeñas en lugar de tratar de levantar toda la sección de desechos al mismo tiempo. Usted 
no quiere que los viniles de residuos inadvertidamente entren en contacto con las figuras que desea 
mantener. Utilice un cuchillo o un perforador de papel para levantar suavemente piezas de vinil de desecho 
para descartar. 

 

• Si usted está aplicando letras pequeñas o haciendo una aplicación de grabado con crema, NO corte el vinil 
residual. La pieza entera debe ser aplicada a la superficie del proyecto, suavizada firmemente y 
uniformemente, y luego retirar el exceso. La adherencia entre el vinil y la superficie dura hará que eliminar 
los residuos sea mucho más fácil, con menos probabilidad de que las pequeñas figuras se suelten. 

 

• Para transferir el vinil a una pared (o ventana u otra superficie), aplique cinta de transferencia a través del 
vinil, repitiendo filas de cinta de transferencia para cubrir completamente las figuras. En la parte superior, 
tiene una capa de cinta con sólo la mitad inferior cubrir el vinil para que la mitad superior se puede 
presionar a la pared y utilizarse como una bisagra. Una vez que tenga el vinil alineado como desee, levante 
hacia arriba, dejando la parte superior de la cinta adherida a la pared. Retire la hoja de respaldo del vinil. 
Luego, cuidadosamente vuelva a poner el vinil y comience a presionar a la pared, suavemente y 
uniformemente. Utilice una tarjeta de crédito vieja o raspador de plástico para suavizar las arrugas y 
obtener una mejor adhesión. Despegue suavemente la cinta de transferencia de la parte superior y pulse 
de nuevo con la tarjeta de crédito o raspador. 

 
 

 
8.04 Tela y Fieltro 

 

http://knkusa.com/product/clear-transfer-tape/
http://knkusa.com/product/clear-transfer-tape/
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Tela:      Fieltro:  Estbilizadores:  Fieltro:   

 
• Se recomienda que la cuchilla para tela sea utilizada al cortar tela y fieltro. Está diseñado para dar un corte 

más nítido en esquinas y puntos apretados. El Blade Offset (desplazamiento de la cuchilla) debe ajustarse 
a 0.75 mm o 0.0295 pulg. 
 

• Al igual que con todos los materiales, estabilizar el tejido y el fieltro es esencial para obtener un gran corte. 
Algunas de las opciones son: 

 
 Pasarle un rodillo al material directamente sobre un tapete de corte super pegajoso y aplicando cinta 

adhesiva a los bordes exteriores. 
 

 Utilizando un estabilizador para planchado como Steam-a-Seam 2 o Thermo-Web's Heat n 'Bond 
 

 Utilizando un estabilizador de spray-on/ wash away como Terial Magic. 
 

 Presione el papel del congelador en la parte inferior y/o superior del material. 

 
• Con o sin estabilizador, se recomienda utilizar un tapete limpio y pegajoso. 

 

• Debido a que las hojas de respaldo de Steam-a-Seam 2 y Heat n 'Bond son resbaladizas, rociándolas con 
el adhesivo temporal Odif USA 505 puede hacer que se adhieran firmemente al tapete y no se resbalen 
durante el corte. Algunos residuos del adhesivo 505 puede quedarse en el tapete, por lo tanto, una razón 
para utilizar un tapete dedicado para la tela. Este residuo agregará unión para los cortes futuros. (¡Gracias 
a Lynn Keniston por esta idea!) 

 

• Algunos usuarios también prefieren quitar el papel de respaldo sobre telas estabilizadas antes de pasar el 
rodillo al tapete de corte. Esto funciona también. 

 

• El mejor fieltro (suave) sin rizar es 100% lana. Este corta más limpio que otros tipos. Una mezcla de lana 
también debería funcionar bien. El Nonwovens WoolFelt es 35% lana, 65% Dacron y tiende a cortar muy 
limpio. Si el fieltro que usted tiene no está cortando bien, considere aplicar uno de los estabilizadores 
mencionados anteriormente. 

 

• Si el fieltro está pre-rigidizado, debe cortar bien usando la cuchilla de material grueso con tapa azul en 
comparación con la cuchilla para tela. Debido al grosor, es posible que usted necesite aplicar cinta 
adhesiva al fieltro en tapete para evitar el deslizamiento durante el corte. 

 

• En general, usted necesitará usar 2 ó 3 pasadas para cortar la mayoría de las telas y fieltros. Es necesario 
para que todas las fibras sean cortadas limpiamente. 

 

• Consulte la tabla al final del Capítulo 2 para conocer los ajustes recomendados. Al igual que con otros 
materiales, realice siempre pequeños cortes de prueba para asegurarse de que los ajustes son perfectos 
para su tela o fieltro en particular. 

 
8.05 Heat Transfer Vinyl (HTV) 
 

   
 

Tipos de Vinil de Transferencia Por Calor 

 
• Hay muchos tipos de vinil de transferencia por calor (HTV) disponibles en KNK USA: regular, brillo, 

estampado animal, reflectante, neón y más. Al seleccionar uno, tome nota de las recomendaciones de 
aplicación, tales como qué tipos de tela se recomiendan, tiempo de prensado y temperatura, y las 
instrucciones de lavado. Esta información se encuentra fácilmente disponible desplazándose hacia abajo 
en la página de descripción del producto. 

 

http://knkusa.com/product/knk-force-fabric-blade/
http://www.commonwealthfelt.com/shopdisplayproducts.asp?id=26&cat=Wool+Felt
http://knkusa.com/product-category/materials/iron-on-materials/
http://teamknk.com/?s=fabric&submit=Search
http://teamknk.com/?s=felt&submit=Search
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Fabric_Cutting_With_KNK_LynnK.pdf
http://www.iloveknk.com/Support/Tutorials/Klic-N-Kut/Applications/Felt_Cutting_With_KNK_LynnK.pdf
http://teamknk.com/?s=heat+Transfer+Vinyl&submit=Search
http://www.youtube.com/watch?v=OUz66j1t-O4
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Cortando Iron-On 

 

• La mayoría de los materiales HTV constan de tres capas: 

 

 

 

 

 
 

• Para cortarlo, tenga el lado opaco hacia arriba (lado adhesivo hacia arriba): 

 

 

 

 

 

 

 

 
• Debido a que la transferencia por calor tiene la capa de protección contra el calor, que no se cortará, esto 

puede servir como soporte/tapete durante el corte. El material tendrá que ser de al menos 4" de ancho para 
que ambos lados se agarren con las ruedas de presión. Si usted está cortando de los desechos, entnces, 
utilice un tapete de corte para sostener el material durante el corte. 
 

• Consulte la tabla al final del Capítulo 3 para ver los ajustes de corte HTV sugeridos. Asegúrese de hacer un 
corte de prueba primero y luego ver si la capa de vinil se despega del respaldo. ¡Tenga en cuenta que las 
líneas de corte pueden ser muy difíciles de ver! Por lo tanto, no asuma que el material no se cortó hasta 
que realmente trate de levantar la figura. 

 

• ¡Recuerde invertir la imagen antes de cortarla! Debido a que usted está cortando con el lado adhesivo 
hacia arriba, usted estará volteando el material encima, después de remover los desechos y antes de 
presionar. Para reflejar su imagen, selecciónela y luego aplique cualquier función espejo/flip/reverse que 
esté disponible en el software de diseño que usted está utilizando. 

 

• Corte alrededor de su imagen con tijeras antes de remover los desechos. ¡Tenga en cuenta, una vez más, 
que es realmente difícil ver la imagen cortada, así que tenga cuidado! 

 

• Utilice un perforador de papel o un cuchillo de artesanía para agarrar un pedazo del vinil de desecho y 
luego tire para quitarlo. Recuerde sacar las partes internas pequeñas de desechos, también. 

 
 

Adhiriendo Vinil Textil 
 

• Si está utilizando la transferencia por calor de KNK USA, vaya a la página del producto específico y 
desplácese hacia abajo para encontrar la configuración de la aplicación recomendada. Si su material de 
transferencia por calor fue comprado en otro lugar, obtenga instrucciones recomendadas por el proveedor. 
 

• Use una prensa de calor o una plancha seca caliente (ajuste de algodón) y con el vapor apagado. 
 

• Si está usando una plancha, seleccione una superficie bastante firme.... No una tabla de planchar muy 
acolchonada. 

 

• Inserte un paño entre las capas de la camisa en caso de que el adhesivo se derrita al otro lado. 
 

• Presione la camisa primero para crear una superficie lisa y seca. 

Capa resistente al calor 

(lado brillante) 

Vinil Textil 

Adhesivo (lado opaco) 

) 

La cuchilla corta solamente el pegamento y el vinil y 

no a través de la capa más gruesa resistente al calor 
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• Coloque el patrón en la camisa, centrando cuidadosamente. 
 

• Presione firmemente el tiempo recomendado. No mueva la plancha alrededor ... simplemente presione 
firmemente. 

 

• Deje enfriar ligeramente y quitar la capa superior resistente al calor. Si el patrón comienza a subir, entonces 
cubra con la capa resistente al calor e inmediatamente reprimir durante otros 10 segundos. 

 

• Algunas personas también tirarán la camisa de adentro hacia afuera y presionarán desde el otro lado por 
otros 5 segundos. Nota: otros tipos de planchas pueden requerir tiempo de prensado adicional o incluso 
menos tiempo de prensado. Póngase en contacto con su proveedor para obtener información. 

 

• Espere 24 horas antes del lavarla. 
 

8.06 Plantillas para Diamante de Imitación (Rhinestone) 

 

 
 
Corte Material de Plantilla Para Diamantes de Imitación 

 
 

• Las plantillas para los diamantes de imitación (Rhinestone), se pueden utilizar cientos de veces. Hay varios 
materiales comúnmente utilizados para hacer estas plantillas. Las opciones actuales más populares son: 

 
 El material de plantilla para Rhinestone verde vendido en KNK USA es el más popular porque es menos 

costoso que las otras opciones y ha estado alrededor por más tiempo. Este se recomienda sobre una goma 
similar más delgada vendida por las compañías que comercializan su material para las cortadoras más 
bajas en fuerza. Las desventajas de usar cualquier material de plantilla de goma es que es necesario 
aplicar un soporte sólido después de cortar la plantilla y también pulverizar la plantilla con un polvo de 
modo que el polvo cubra cualquiera de los adhesivos permanentes expuestos en los agujeros. El soporte 
sólido elegido típicamente es el tablero de espuma o el tablero de plantilla. 
 

 El Rock-it Flock, también vendido en KNK USA, es más caro que el material de plantilla de goma, pero no 
requiere un soporte para ser aplicado después del corte. También no requiere polvo. Las plantillas Rock-It 
se pueden utilizar para mezclar y combinar diseños, como combinar letras e imágenes. 

 
 Sticky Flock es un material similar al Rock-it, pero es más caro aún y ligeramente más delgado. Tiene las 

mismas ventajas que Rock-it. 
 

• El primer paso antes de cortar la plantilla es comprobar el tamaño del diseño que usted ha creado y luego 
cortar un pedazo de material de plantilla para diamantes de imitación que es por lo menos 1" más grande 
en la altura y el ancho en comparación con su diseño. Es beneficioso tener un poco de material alrededor 
de los bordes del diseño donde el exceso de diamantes de imitación todavía puede ser cepillado fuera de el 
diseño. 
 

• Retire primero el papel de respaldo y presione el material a un tapete pegajoso limpio. Pase un rodillo 
firmemente para cerciorarse de que la goma tenga un contacto excelente con el tapete. 

 

• Consulte la tabla al final del Capítulo 3 para conocer los ajustes recomendados. Realice los cortes de 
prueba utilizando un patrón con un pequeño número de círculos (por ejemplo, entre 8 y 10) para 
asegurarse de que los ajustes que está utilizando son suficientes. 

 
Removiendo los desechos y Cepillando los Rhinestones 

 
• Después del corte, pase el rodillo nuevamente sobre material de la plantilla. Al levantar el patrón, la 

mayoría de los pequeños círculos deben permanecer pegados al tapete. Si todavía hay círculos 

http://knkusa.com/product/rhinestone-motif-rubber/
http://knkusa.com/product/4%E2%80%B3-x-12%E2%80%B3-stencil-board-100-pcs/
http://knkusa.com/product/klic-n-kut-rock-it-rhinestone-flock/
http://teamknk.com/?s=rhinestone&submit=Search
http://www.youtube.com/watch?v=7oknoQLXGTM
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conectados, entonces presione firmemente y levante otras partes de su tapete de corte. Eventualmente, 
usted debe tener la mayoría eliminado. 
 

• Si su plantilla fue cortada de una goma, aplique su patrón a un material de respaldo tal como tablero de 
plantilla o tablero de espuma. Asegúrese de que es un color diferente de su goma. Es posible que usted 
desee primero cubrir la placa de respaldo con cinta adhesiva transparente para una superficie más lisa y 
permanente. Compruebe que ninguno de los pequeños círculos todavía está conectados a la parte 
posterior de la plantilla y provocando un "bulto" en el patrón. 

 

• Una vez más, si su plantilla fue cortada de goma, use un cepillo de dientes viejo y cepille un poco de polvo 
(talco, hornear, facial) en los agujeros. Vírelo y con la parte de arriba hacia bajo de algunos golpecitos para 
quitar el exceso de polvo y luego limpie la parte superior del patrón. El polvo se adhiere a cualquier 
adhesivo dentro de los agujeros y evita que los diamantes de imitación queden atrapados en los agujeros. 

 

• Coloque su plantilla en la parte inferior de una bandeja para perlas, un molde para pasteles u otro 
recipiente grande y plano. Aquellos que usan los materiales “Flock” a menudo cubrirán el fondo de su 
envase con una capa del mismo “Flock”. Vierta los rhinestones en la parte superior de la plantilla. 

 

• Utilice un Shur-Line Trim and Touch-up Pad para cepillar los diamantes de imitación en un movimiento 

circular. Manténgase cepillando y usted verá que las piedras que aterrizaron al revés serán cepilladas y las 
correctas las reemplazarán. ¡Este cepillo de cojín es esencial a la facilidad y al éxito de este importante 
paso! 

 

• Cuando el ~ 95% del patrón esté correctamente lleno, utilice pinzas, un palillo de dientes, o simplemente su 
dedo para colocar los últimos rhinestones en el patrón. 

 

• Corte la cinta de transferencia para rhinestone a la medida y luego presiónela sobre sus piedras. Presione 
firmemente pero no empuje las piedras profundamente en los agujeros. Si usted tiene un problema con las 
piedras que saltan mientras que usted está dejando caer la cinta de la transferencia, después intente usar 
una hoja de Bounce o un aerosol antiestático en la cinta de transferencia antes de presionar. 

 

• Al levantar la cinta, empiece en una esquina y mantenga un lado presionado y observe para asegurarse de 
que todas las piedras están siendo levantadas. Si una piedra no se levanta, presione hacia abajo para 
recogerla. ¡Una vez que las piedras se levanten, ahora usted puede colocar la cinta de transferencia de 
nuevo en su respaldo o seguir adelante y presione las piedras a su camisa, tela o incluso cartulina! 

 

• Tenga en cuenta que la cinta de transferencia es reutilizable. Usted debe ser capaz de obtener 4 o 5 
prensas de una pieza, a pesar de que esta se arruga por la presión. Siga utilizando hasta no recoger y 
sostener las piedras. 

 

 

Presionando las Rhinestones con Calor  

 
• Si usted usa su plancha casera para presionar las piedras a una camisa: 

 
 Use una plancha caliente y seca (ajuste de algodón o superior con la opción de vapor apagada). 

 
 Use una superficie firme ... no una tabla de planchar muy acolchonada 

 
 Inserte un paño entre las capas de la camisa. 

 
 Presione la camisa primero para crear una superficie lisa y seca. 

 
 Arregle el patrón en la camisa, centrando cuidadosamente. 

 
 Presione firmemente durante 10 segundos. Luego mueva alrededor de ½" en caso de que los agujeros 

de vapor estuvieran sobre áreas de algunas piedras y luego presione firmemente por otros 10 
segundos. 
 

http://knkusa.com/product/4%E2%80%B3-x-12%E2%80%B3-stencil-board-100-pcs/
http://knkusa.com/product/4%E2%80%B3-x-12%E2%80%B3-stencil-board-100-pcs/
http://www.homedepot.com/h_d1/N-5yc1vZ1xg6/R-100141897/h_d2/ProductDisplay?langId=-1&storeId=10051&catalogId=10053
http://knkusa.com/product/rhinestone-transfer-tape/
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 Muévase a otra área de piedras y repita. 
 

 Vire la camisa hacia (lo de afuera hacia adentro) y presione durante otros 10 segundos en el lado 
donde se aplicaron las piedras. 
 

 Deje que se enfríe completamente antes de quitar la cinta de transferencia transparente. 
 

• Si utiliza una prensa de calor para presionar las piedras a una camisa: 
 

 Ajuste la temperatura a 165-375 grados F (165-375 grados C) y ajuste la presión a medio. 
 

 Presione la prenda primero para obtener una superficie plana seca. 
 

 Arregle el patrón en la camisa, centrando cuidadosamente. Presione durante 10-12 segundos. 
 

 Pele frío, cubra con una lámina de Teflón y vuelva a presionar otros 10-12 segundos. Alternativamente, 
voltear la camisa de adentro hacia afuera y presionar desde la espalda durante 10-12 segundos. 
 

 Utilice una temperatura más baja si presiona sobre tejido de algodón 50/50. Utilice una temperatura 
más alta en el dril de algodón o las bolsas de asas. 

 
 
Consejos Adicionales en Aplicaciones de Rhinestone 

 
• Si usted está combinando la transferencia de calor con los diamantes de imitación, no presione los 

rhinestones sobre el vinil textil. Si bien parece que han funcionado bien, las piedras se caen una vez que la 
prenda es lavada. Cuando utilice ambos, cree una línea de contorno alrededor de su patrón de 
transferencia para las piedras. 
 

• El prensado de diamantes de imitación para cartulina también funciona muy bien. Si presiona sobre la parte 
frontal de una tarjeta de felicitación, despliegue primero la tarjeta. 

 
• Después de presionar y dejar enfriar, use su uña o una tarjeta de crédito/tarjeta de regalo vieja para raspar 

el patrón para ver si alguna piedra se desprende. Si es así, reemplace esas piedras por otras nuevas y 
presione nuevamente. 
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Apéndice A Solución de problema 
 

 
A1 Problema de Comunicación 

 
Estoy tratando de configurar la conexión de mi Force y esta tiene luces blancas intermitentes. Nunca llegua a la 
etapa de una luz constante.  

 Lo más probable, la tarjeta SD es destituida de la computadora dentro de la Force. Apague la Force y 
desconéctela. Gire la Force hasta que se pueda acceder el panel inferior. Quite 6 tornillos, incluyendo 
los dos que aguantan los pies pequeños. Remueva el panel y en el extremo derecho de la tapa usted 
verá dos aberturas. Una de ellas tiene la pequeña tarjeta SD. Use una linterna si es necesario para 
verla. Suavemente empuje para echarla de su asiento totalmente y luego presione otra vez para 
acomodarla al igual que con otros lectores de tarjetas SD. 

 

            

 

 El cable entre la placa principal y la placa Raspberry Pi (RPI) puede haber perdido un buen contacto. El 
conector en la placa principal es generalmente bastante firme, pero la conexión dentro de la cubierta 
lateral es más susceptible al choque y se debe volver a asentar. Apague la Force y desenchúfela. 
Realice los pasos anteriores para quitar el panel inferior. Retire la cubierta lateral que sostiene el botón 
de encendido. La tapa lateral es sostenida por seis tornillos. Dos son visibles desde el frente (mire la 
placa lateral cerca del borde). Uno es visible desde la parte trasera, también en el borde de la placa 
lateral. Uno está debajo de la cubierta superior en la parte posterior y dos se ven de la parte inferior 
después de quitar el panel inferior. Después de quitar la cubierta lateral, hay cables que se conectan a 
un conector de clavija en una tarjeta pequeña (la placa RPI) en la placa lateral en la parte superior. El 
conector es un conector de dos piezas (macho/hembra) con la hembra conectada a la tarjeta y el 
macho insertado en el conector hembra. Saque el conector macho del conector hembra y vuelva a 
colocarlo. 

Gire la Force hasta esta posición y retire los 6 tornillos 

 

Vuelva a colocar la tarjeta micro SD 
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 La tercera posibilidad es que la tarjeta micro SD tiene que ser reflashed con el software. Vaya a este 
enlace: http://knkusa.com/c3-installation-guide/. Después de haya reinstalado la tarjeta y usted haya 
regresado a C3, compruebe el estado. Lo más probable es que necesite actualizar a la última versión 
de C3. 
 

 Si estas soluciones no resuelven el problema, inicie un ticket de soporte mediante este vínculo: 

http://knkusa.com/support-ticket-request/ o llame al 800-268-3672. 

____________________ 

 

 

Estoy corriendo Windows 10 y tratando de configurar la Force. Las luces son un blanco constante pero no veo 
el KNK_Force en mi lista de redes disponibles. 

 

 Vea este video:  
 

 Si usted aún no puede ver KNK_Force en su lista de menú de red, inicie un ticket de soporte mediante 
este enlace: http://knkusa.com/support-ticket-request/ o llame al 800-268-3672 
 

____________________________ 
 
 
 

 

Mi conexión Wi-Fi de la Force frecuentemente se desconecta. 

 Asegúrese de que está corriendo la última actualización de C3. Luego Siga las instrucciones en 
sección 2.05.2 para configurar una dirección estática IP. 

 Un hub USB puede ser la mejor solución. El adaptador Wi-Fi se conecta en el concentrador y el 

concentrador en la Force. Utilice el vídeo de recuperación KNK para volver a conectarse.  

 

 Si esto continua, inicie un ticket de soporte mediante este enlace http://knkusa.com/support-ticket-
request/ o llame al 800-268-3672.   

 

____________________ 
 

http://knkusa.com/c3-installation-guide/
http://knkusa.com/support-ticket-request/
http://knkusa.com/support-ticket-request/
http://knkusa.com/support-ticket-request/
http://knkusa.com/support-ticket-request/
http://www.digitalcitizen.life/how-connect-hidden-wireless-networks-windows-10
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Mi dirección IP para la Force ya no funciona. Cuando hago clic en mi lista de redes, veo KNK_Force_recovery. 

 

 Vea este video:  

____________________ 

 
 
 
Recibí un mensaje de error en C3 que dice: “Sinatra doesn’t know this ditty.” ¿Qué significa eso y qué debo 
hacer? 
 

 Intente actualizar su navegador varias veces o haga clic en otra pestaña en C3. Debe corregirse 
fácilmente por sí mismo. 
 

____________________ 

 

 
 
Cuando hago clic en la pestaña “status”, aparece un mensaje de error que dice "NoMethodError at/status." 
¿Cómo actualizo mi C3? 
 

 Asumiendo que usted está en modo independiente (stand alone), intente ingresarlo en su navegador: 
10.0.0.1/update.  
 

 Si usted está conectado a través de Wi-Fi o Ethernet, ingrese su dirección IP seguida de /update. 

____________________ 

 

 
Después de usar SCAL para cortar, la Force tiene una luz azul y no puedo conseguir nada para cortar de C3. 
¿Es esto normal? 

 Sí, es normal. SCAL debe utilizar una API (Application Program Interface) para comunicarse con la 
Force. Una vez que está en ese modo, no puede volver a usar C3 sin reiniciar la Force.  

 

____________________ 
 

 
 
Cuando envío el archivo a cortar, la luz de la Force comienza a parpadear en rojo y el corte nunca comienza. 
 

 Usted tendrá que reiniciar la Force. 
 

 Vuelva a abrir el archivo en su software de diseño. Copie y pegue las figuras en un nuevo archivo y 
guarde/exporte ese nuevo archivo para su uso en C3. Esto debería corregir el error. 

____________________ 
 

 
A2 Problemas Operando 
 
Necesito reemplazar uno de los tornillos de plástico negro en el asiento del portacuchillas. ¿Puedo comprar uno 
de metal en una ferretería? ¿Qué tamaño debo comprar? 
 

https://www.youtube.com/watch?v=C9F2Q1W9VrQ
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 Sí, usted puede comprar un tornillo de metal para reemplazar uno de plástico. El tamaño es: M6-
1.0x25. 

 
____________________ 

 
 
El inicio y el final de una figura cerrada no están emparejando.  

 Si el espacio es muy pequeña, verifique que usted haya configurado Closed Path Overcut (consulte la 
Sección 3.02.11). 

 Para espacios más anchos, asegúrese de que los dos puntos de rueda de arrastre exteriores están 
siendo usados Y que las ruedas de presión están claramente centradas bajo los rectángulos grises por 
encima de las ruedas de presión. 

 Asegúrese de que el tapete de corte puede viajar libremente y no esté corriendo en un cable, una 
pared, o cualquier otro objeto estable que puede provocar que el tapete se ruede o gire. 

 Siga Cut Speed (la Velocidad de corte) recomendada para el material a ser cortado. Si la velocidad es 
demasiado rápida, el tapete de corte se desplazará porque la cuchilla no puede cortar el material lo 
suficientemente rápido. 

 Asegúrese de que la cuchilla no esté cortando demasiado profundo en el tapete de corte que puede 
causar que el tapete de corte sea atrapado por la cuchilla. 

____________________ 
 

 
 
La Force no comienza a cortar. El proyecto se está reproduciendo, pero después de 30 minutos, no ha 
comenzado a cortar. 
 

 Esto puede ocurrir debido a figuras no cerradas, como una línea recta, estar unidas con figuras 
cerradas. Vuelva a abrir el archivo en su programa de diseño. Una o más capas necesitarán ser 
separadas/rotas/divididas, etc. Usted puede volver a unir figuras cerradas, según sea necesario. 
 

___________________ 
 
 
La Force no comienza a cortar; El porcentaje empieza a contar, pero después de mucho tiempo, nada cambia y 
el corte nunca empieza. 

 Primero intente reiniciar la Force. Si eso no corrige el problema, entonces hay un problema con el 
propio archivo. Si no sabe dónde se creó el archivo por primera vez, ábralo en uno de los programas 
recomendados en el Capítulo 4. Luego, vuelva a exportar el archivo. Si el problema persiste, inicie un 
Ticket de soporte con KNK USA: http://knkusa.com/support-ticket-request/ 

 
____________________ 

 
Mi Force no está nivelada. Se inclina ligeramente hacia un lado y mis cortes son desiguales. 
 

 La Force no necesita estar perfectamente nivelada para obtener cortes parejos.  En su lugar, 
intente aumentar el CD/ED por 5 y no utilice la rueda de presión central. Utilice solamente las dos 
ruedas de presiones externas, situadas debajo de los rectángulos grises de la izquierda y de la 
derecha. 

____________________ 
 
 
 
 
El adaptador de la herramienta rotativa se rompió cuando traté de insertarlo. ¿Qué debo hacer? 

 

http://knkusa.com/support-ticket-request/
https://www.youtube.com/watch?v=DukmYROJ8U8
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 Favor llamar a KNK USA (800-268-3672) o comenzar un Boleto para apoyo: 
http://knkusa.com/support-ticket-request/ 

____________________ 
 
 
De repente, estoy oyendo un sonido metálico durante un corte. 

 Este es el sonido que se obtiene cuando la cuchilla está siendo forzada a través de un material mucho 
más rápido de lo que el material puede ser cortado. En primer lugar, intente reducir Cut Speed (la 
velocidad de corte) en un incremento de 10 o más. También podría ser necesario utilizar más pasadas 
y Starting Depth (una profundidad inicial) más baja. 

____________________ 
 
La mesa plegadiza tiene rayas rojas en ella. Esto parece ser la tinta del tapete de corte. ¿Qué debo hacer? 

 Esto es tratado en la Sección 1.10. 
 

____________________ 
 

Los rodillos están rasgando la capa superior de mi material. 

 Es importante mantener los rodillos limpios de adhesivo. Utilice Un-Du o Goo Gone o incluso alcohol 
isopropílico para limpiar a fondo las ruedas.  

____________________ 
 

A3 Problemas Cortando 

 
 
¡Estoy usando los ajustes recomendados, incluyendo la Tensión de la cuchilla, pero mis cortes son demasiado 
profundos! ¡Incluso estoy cortando todo a través del vinil! 
 

 Lo más probable es que, mientras ajustas el Origen Z, usted está insertando y tensando el 
portacuchillas en el paso incorrecto. Lea atentamente la pantalla. Usted debe asegurarse de que 
inserta el porta-cuchillas mientras el asiento del portacuchillas está en la posición hacia abajo y no 
durante el paso anterior ni durante los pasos posteriores. 

____________________ 
 
Mis figuras cortadas no están muy cerradas al principio y al final de un camino.  

 Si el espacio es muy pequeño, verifique que usted tiene Closed Path Overcut establecido (refiérase a 
la Sección 3.02.11. Si el espacio es más de ~ 1/16 " (1.5 mm), refiérase a la misma pregunta en 
Problemas operando. 

____________________ 
 
 
Algunas de mis figuras están cortando aleatoriamente o simplemente siendo ignoradas en lugar de cortar como 
es mostrado en el diseño. 

 Esto es probablemente debido al origen del archivo SVG. Siga las directrices del Capítulo 4 para volver 
a exportar el archivo desde otro programa. 

____________________ 
 

Las esquinas de mis rectángulos y las letras son redondeadas en lugar de afilados. 

 Verifique que usted tiene entrado el Blade Offset correcto.  Refiérase a la Sección 3.02.9. 

http://knkusa.com/support-ticket-request/
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 A veces las cuchillas pueden estar ligeramente fuera de especificación. Utilice un pequeño cuadrado de 
prueba o rectángulo para ajustar el valor Blade Offset (desplazamiento de la cuchilla). Tenga en 
cuenta que al aumentarlo se afilarán las esquinas, pero si el valor es demasiado alto, comenzará a 
verse pequeñas proyecciones o burbujas. 

____________________ 
 

¡Las figuras se distorsionan en gran medida! No se parecen al diseño original en lo absoluto. 

 Verifique que usted tiene entrado el Blade Offset correcto. Por ejemplo, si usted está trabajando en 
pulgadas, el “blade offset” del empaque de la cuchilla puede estar listado en mm. Consulte la Sección 
3.02.9 para los ajustes correctos a utilizar para los distintos tipos de cuchilla de la Force. 

 Si el problema persiste después de verificar la desviación de la cuchilla (Blade Offset), entonces 
vuelva a la segunda pregunta de esta sección. 

____________________ 
 
 
Los caminos exteriores están recortando antes de los caminos interiores. ¿Cómo llego a cortar al revés? 

 En el programa de diseño, aplique Join (una unión) o Merge (unir) o Combine (combinar) (lo que sea 
que el programa de diseño use para hacer múltiples figuras en una figura). Esto debería entonces 
causar figuras internas (niño) corten antes de las figuras externas (padre). Luego, asegúrese de que 
Optimize Cut Order esté desactivado. Consulte la Sección 3.02.12. 

____________________ 
 
 
Estoy dibujando con el lápiz de prueba y hay burbujas en las esquinas. 

 Para esquinas perfectas, apague Blade Offset (ajuste a 0), ya que para bolígrafos no es necesario un 
desplazamiento. 

____________________ 
 
 
Mi corte empezó bien, pero al final del corte, no está cortando a través del material. 

 Asegúrese de que la carcasa del porta cuchilla no tiene ningún trozo de material en el interior de la 
misma. 

 Asegúrese de que los tornillos delanteros están apretados de manera que el porta cuchilla no se está 
deslizando hacia arriba durante el corte. 

 Asegúrese de que sólo está utilizando las dos ruedas externas de presión y ubicando su material entre 
ellas. 

 
____________________ 

 
 
Mi material no está siendo cortado en lo absoluto. Yo apenas estoy viendo un rasguño. 

 Intente reiniciando el Origen Z (Z Origin). Recuerde remover el porta cuchilla primero y recargarlo 
cuando la cabeza se ha movido a la posición baja. 

 Chequee la cuchilla para asegurarse de que no esté quebrada. 

 Confirme los ajustes para ese material, incluyendo la Tensión de la Cuchilla (Blade Tension). 
____________________ 

 
 
Mi corte es limpio en algunos lugares, pero no en otros. ¿Por qué no estoy obteniendo corte consistente? 
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 Asegúrese de que el material está presionado firmemente sobre un tapete de corte limpio y pegajoso 
(asumiendo que usted está cortando un material que no tiene hoja de soporte tales como papel o 
cartulina). Si usted está cortando un material con una hoja de respaldo, asegúrese de que el material 
sigue adherido a esa hoja. Por ejemplo, el vinil que ha estado almacenado durante un largo periodo de 
tiempo o expuesto a temperaturas extremas se puede separar a veces de la lámina de soporte. Con un 
rodillo el vinil estabilizará generalmente bastante bien para cortar. 

 Es posible que usted tenga que aumentar el Cut Depth (incremente en un ajuste de 5) o el Blade 
Tension (incremente por ½). Repetir el corte. 

 El material puede requerir dos pasadas. Si un material no es homogéneo o si es con mucha textura, 
utilizando dos pasadas a veces es necesaria para conseguir que la figura completa corte limpiamente. 
Además, si el material ha sido expuesto a la humedad, entonces este se convertirá difícil de cortar en 
una pasada. Usted puede secar el papel y la cartulina en un horno ligeramente calienta durante mas o 
menos unos 15 minutos para liberar la humedad. Precaliente el horno a la temperatura más baja y 
luego apáguelo antes de poner su papel en el horno. 

____________________ 
 

 
Estoy teniendo muchos desgarres en mis cortes. 

 Un número de cosas pueden causar desgarres, por lo que trabaje a través de esta lista de verificación: 

o Demasiada fuerza está siendo aplicada. Si usted ve líneas cortadas en su tapete de corte, en 
primer lugar, asegúrese de que Blade Tension (la tensión de la cuchilla) es apropiada para el 
material que está cortando. Esta puede estar demasiado alta. Suponiendo que está bien, disminuya 
la profundidad de corte (Cut Depth) por, digamos 5 o 10 y haga cortes de prueba hasta que logre 
un corte limpio. 
 

o La cuchilla está astillada. Pruebe una cuchilla diferente. 
 

o El papel no se adhiere bien al tapete de corte. Asegúrese de que el tapete esté limpio, pegajoso, y 
el papel es presionado suavemente y de manera uniforme sobre la superficie. Si el desgarre está 
ocurriendo al intentar quitar el artículo cortado del tapete, trate de usar un cuchillo de paleta de 
artista (u otra herramienta de tipo espátula delgada) para levantar suavemente la mayor parte de la 
figura de corte antes de levantarla del tapete. 

 
o  Es posible que usted tenga demasiados nodos en la figura. Utilice medidas de reducción de nodos 

en el programa de diseño para simplificar el corte. 
 
o El diseño en sí puede ser demasiado intrincado para el tamaño que está cortando. Mire el archivo 

en el software de diseño para ver si las áreas más delgadas pueden ser engrosadas y los nodos 
excesivos eliminados usando una función simplificada. 

 
 

o El material en sí puede estar sujeto a desgarrarse, especialmente en cortes complejos. Además, si 
el papel de tarjetas ha sido expuesto a la humedad, entonces, la humedad en el material puede 
hacer que sea difícil para cortar limpiamente. Trate de secar la cartulina con un secador d o 
colocarla en un horno ligeramente caliente durante media hora. El peor de los casos, intente una 
cartulina diferente. 

____________________ 
 
 
Al comienzo de cada corte, la cuchilla hará un pequeño corte en mi material y luego procede a la primera figura. 
¿Por qué está haciendo eso y cómo puedo prevenirlo? 

 Ese pequeño corte es para fijar la cuchilla en la dirección correcta para el primer corte. Es posible que 
usted tenga que reorganizar la ubicación del material en el tapete de corte o temporalmente colocar 
unos pocos de Post-it notes en ese lugar para prevenir que el material debajo sea cortado. 

____________________ 
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Estoy usando el repujador y el portacuchillas para una puntuación y corte de aplicación. He calibrado 
cuidadosamente el desplazamiento de las dos herramientas, sin embargo, cuando se corta el proyecto, las 
líneas de corte no están alineadas con las líneas de puntuación.  
 

 El uso de ajustes agresivos al marcar puede hacer que el tapete de corte se incline, lo que hace que 
las líneas de corte ya no estén correctamente alineadas con las líneas de rayado. Aquí hay varias 
sugerencias para corregir este problema: 
 

o Reduzca la configuración de CD/ED y aumente las Pasadas. 
 

o Añada guías al tapete para estabilizar el tapete de corte. Consulte el Apéndice B4. 
 

o Cambie o incluso alterne Path Direction (la dirección de la trayectoria) en líneas de rayado. 
Consulte la Sección 3.02.10. 

____________________ 

 

 
A4 Problemas con el Programa 

 

 
Estoy tratando de abrir un archivo para cortar y este no se carga. He esperado más de 20 minutos. 

 Asegúrese de que el archivo se ha abierto y re-exportado por primera vez utilizando uno de los 
siguientes programas: MTC, SCAL, Inkscape, AI o Corel Draw. 

 De lo contrario, por favor llame al 800-268-3672 KNK USA o inicie un boleto de soporte con KNK USA: 
http://knkusa.com/support-ticket-request/. 

____________________ 

 

 
No puedo ver algunas de las características de C3 mostradas en las capturas de pantalla. 

 Asegúrese de que ha maximizado la ventana del navegador. 

 Asegúrese de que ha actualizado su versión de C3 a la última versión. 

 Verifique la resolución de la pantalla del monitor. Este puede necesitar ser ajustado.  

 Verifique el nivel de zoom de su software de navegación. Puede ser necesario disminuirlo. 

____________________ 
  

http://knkusa.com/support-ticket-request/
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Apéndice B Información Adicional 
 

 
B1 Colocando Palancas a los conjuntos de rodillos de arrastre 

   

• Los conjuntos de rueda de presión pueden o no pueden estar pre-ensamblados. Si las palancas no están 
unidas, siga las instrucciones a continuación. De lo contrario, pase a la Sección 1.11.2.  
 

• Los rodillos de arrastre están incluidos en una caja separada. Debe haber tres de ellos, junto con tres 
palancas: 

 

 

• Las palancas deben estar conectadas antes de insertar el conjunto de rueda de presión en la parte 
posterior de la Force. Estos son los pasos: 
 

 El conjunto de rueda de presión y la palanca estarán orientadas de esta manera para el montaje: 

 

 

 Comience a introducir la palanca en el conjunto de rueda de arrastre con la palanca inclinada hacia 
abajo: 

 

https://www.youtube.com/watch?v=vfI5FoX5RwE
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 Una vez la palanca es insertada ligeramente, sujete el conjunto del rodillo de arrastre firmemente en 
una mano y empuje la palanca hacia adentro con la otra mano, girándola hacia arriba. El resorte 
comienza a estirarse ligeramente: 

 

 A medida que la palanca es elevada, esta se girará hacia el interior y de repente encajará en su sitio: 

 

 
 

B2 Mas acerca del Origen Z  

• Si usted hace referencia de nuevo a la Sección 2.06.3, hay una tabla de diferentes situaciones y si usted 
utiliza la parte superior del material o la parte superior del tapete de corte para establecer el origen Z. La 
siguiente información le ayudará a entender por qué es importante y cómo esto afecta los ajustes de 
profundidad. 

 
B2.1 ¿Por Qué Algunas Veces Usted configura el Origen Z sobre el tapete de corte en 
comparación al Material?  

• Al cortar con una cuchilla, se recomienda que usted utilice la parte superior del tapete de corte para 
establecer el origen. Si usted en su lugar utiliza la parte superior del material, entonces usted está más 
propenso a presentar errores e inconsistencias debido a cosas como: 

 material no presionado apropiadamente al tapete de corte. 

 diminutos trozos de desecho en el tapete, debajo del material. 

 inconsistencias en el propio material 

• Cuando esté cortando materiales respaldados laminados sin un tapete de corte (como vinil o material de la 
plantilla de imitación de diamante), estableciendo el origen en la parte superior del material funcionará bien. 
Estos materiales no están sujetos a los mismos problemas como observados anteriormente. 
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• En la actualidad, al cortar con una herramienta rotativa, se recomienda que utilice la parte superior del 
material para el origen. Usted necesitará saber el espesor del material de modo que usted no corte a través 
de él y en el tapete de corte. Usando la parte superior del material le permite establecer una profundidad 
inicial (Starting Depth) menor que la profundidad de finalización (Ending Depth) y luego trabajar a través 
de las pasadas, según sea necesario 

• Cuando se encuentre Repujando, dibujando, grabando, etc., ya sea con el porta cuchilla y grabando con la 
herramienta rotativa, usted necesita usar la parte superior del material para el origen, ya que usted sólo 
está tratando de penetrar una porción del material. De lo contrario, usted necesitaría entrar una profundidad 
de corte (Cutting Depth) negativa. 

• La herramienta perforadora o punzón es similar a la de corte. Usted quiere penetrar completamente el 
material, por lo tanto, establecer el origen sobre el tapete de corte es recomendado. 

 

 
B2.2 ¿Cómo Estableciendo el Origen Sobre el Tapete de Corte Afecta las Configuraciones? 

• Para el corte con cuchilla, si usted establece el origen en la parte superior del material en lugar de en la 
parte superior del tapete de corte, usted necesitará ajustes de profundidad de corte (Cutting Depth) más 
altos. En primer lugar, piense en lo que el origen del eje Z significa. Recuerde que éste está definiendo una 
ubicación de determinada altura a ser 0:  

L  

 

    

 

• Ahora, vamos a suponer que cuando el origen se encuentra en la parte superior del tapete de corte, la 
profundidad de corte (Cutting Depth (CD)) requerida es 75 para ese material en particular. Ese es el CD 
requerido para obtener la punta de la cuchilla a esa ubicación más compensar la resistencia del material y 
la compresión del resorte dentro del soporte de la cuchilla. En cambio, si se va a establecer el origen en la 
parte superior del material, entonces usted necesita el mismo CD de 75, pero luego una cantidad adicional 
de CD ~ igual al espesor del material. 

• Otra situación que involucra el corte de materiales laminados que tienen un respaldo que no se corta. Estos 
materiales (vinil, HTV, “Flock” para diamantes de imitación, etc.) pueden ser cortados sobre el tapete de 
corte o cortarlos insertando directamente los materiales en la Force. Aquí están los factores que 
directamente afectarán la profundidad de corte (Cutting Depth) necesario: 

 Si el origen Z es establecido en la parte superior del material o en la parte superior del tapete de corte 
(la diferencia en CD puede ser tanto como 45 con el vinil porque la hoja de soporte es más gruesa que 
la del vinil) 

 Si el material está en un tapete de corte o directamente cargado en la Force. 

 Si la hoja de soporte que viene con el material se retira primero antes de colocarlo en el tapete (esto es 
común con los materiales plantilla para diamantes de imitación) 

 En la tabla de ajustes recomendados al final del Capítulo 3, usted encontrará ajustes separados para el 
corte de materiales laminados (como vinil o materiales de plantilla de diamantes de imitación), tanto en un 
tapete de corte o sin el uso de un tapete de corte. La configuración de la profundidad de corte (Cutting 
Depth) para ellos reflejan esta diferencia.   

Tapete de Corte 

Material 
Z = 0 en la parte superior del 

material 

Configurando el origen sobre el tapete de corte: 

Configurando el origen sobre el material: 

Tapete de corte 
Z = 0 en la parte superior del 

tapete de corte 
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B3 Calculo de las Profundidades en las Aplicaciones Multi- Pasadas  

• Incremento en la profundidad Multi-pasadas (Multi-pass Depth Increase) es definido como cuan profundo 
la herramienta intentará moverse, empezando después de la primera pasada. Es un cálculo lineal basado 
en la profundidad inicial (Starting Depth), la profundidad final (Ending Depth) y el número de pasadas 
(Passes): 

 
Multi-Pass Depth Increase = (Ending Depth – Starting Depth) / (Passes – 1) 

• Por ejemplo, si Starting Depth (la profundidad inicial) = 100 y (la profundidad final) Ending Depth = 200, 
entonces los objetivos de profundidades para cada pasada serían:  

 

2 Passes 3 Passes 4 Passes 5 Passes 6 Passes

100 100 100 100 100

200 150 133 125 120

200 166 150 140

200 175 160

200 180

200  

   

B4 Guias para el Tapete de Corte 

 

• Ricardo Bernardino publicó por primera vez su archivo de diseño para las guías de tapete el 21 de junio de 
2016. Compartió el archivo de diseño con KNK USA y se modificó ligeramente y luego se publicó para 
descargarlo aquí: 

https://www.myminifactory.com/object/knk-force-cutting-mat-guides-22496 

 

• Para encontrar una empresa de impresión 3D local para imprimir estas guías, utilice este enlace: 
https://www.3dhubs.com/. El plástico menos costoso funcionará bien. 

• Usted también puede comprar un juego de guías y tornillos en este enlace: 

http://knkusa.com/product/knk-force-mat-guides-left-right/ 

 

• Las guías del tapete encajan en la ranura situada delante de la tira de corte. Dos tornillos M4 (~ 10 - 12 mm 
de longitud) se atornillan a través de las guías del tapete y en las tuercas pequeñas ya presentes en el 
interior de la ranura: 

 

 

• Algunos consejos sobre la instalación: 

 
 Identifique qué guía es el lado izquierdo y cuál es el derecho. Refiérase a la foto de abajo. 

 

Tuercas en el 

interior de la ranura 

de la KNK Force 

https://www.myminifactory.com/object/knk-force-cutting-mat-guides-22496
https://www.3dhubs.com/
http://knkusa.com/product/knk-force-mat-guides-left-right/


188 

 

 Deslice la tuerca izquierda hacia el extremo izquierdo y la tuerca derecha hasta el extremo derecho. 
 

 Apague la cortadora para que la cabeza pueda moverse hacia el centro de la cortadora. 
 

 Inserte el tapete en la posición deseada y suelte las ruedas de presión para asegurarse de que las 
ruedas están en los bordes exteriores del tapete. Asegúrese de que el tapete esté alineado recto. 
 

 Las guías del tapete tienen unos pedazos que serán empujados hacia abajo, en la ranura, una vez que 
usted tenga todo posicionado. Sujete la guía del tapete derecho por encima de la ranura y luego deslice 
la tuerca hasta que el agujero en la tuerca sea visible a través del agujero en la guía del tapete. Luego, 
empuje la guía del tapete hacia abajo. Atornille el tornillo del lado derecho. 
 

 Repita el procedimiento en el lado izquierdo. Asegúrese de que el tapete esté bien ajustado entre las 
dos guías del tapete antes de atornillar el tornillo del lado izquierdo. 

 

 
 

 
• Algunos usuarios encuentran que sólo usar la guía derecha del tapete funciona mejor para ellos. Sucede 

que soy uno de esos usuarios y descubrí que tanto las aplicaciones PNC como las aplicaciones de 
puntuación y corte eran más precisas cuando sólo se usaba la derecha. 

  

Lado Izquierdo 

guía del tapete 

Lado 

derecho guía 

del tapete 
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B5. Corte de Prueba de un Material con el Porta-Cuchilla de la Force 
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B6: Prueba de Corte de un Material con la Herramienta Rotatoria de la Force1 
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B7: Configurando la KNK Force 

 
B7.1 Terminología Usada en Procedimientos de Configuración de la Force 

 
La siguiente tabla contiene terminología utilizada en los procedimientos de configuración. En algunos casos, las 
definiciones fueron escritas específicamente en lo que respecta a su aplicación en la KNK Force. 

 

Término Definición

Barra de Direcciones Un cuadro de texto en un navegador web mostrando la dirección de la página web que se está viendo actualmente.

Navegador
Un navegador es un paquete de software gratuito que le permite ver páginas web, gráficos y otros contenidos en línea. Ejemplos: Internet 

Exporer, Firefox, Chrome, Safari

DHCP Dynamic Host Configuration Protocol (DHCP) automaticamente asigna direccione IP a los dispositivos en su red.

Ethernet Ethernet es una res estándar. Aunque hay otros tipos de redes, Ethernet es, por ahora, el más común y es casi exclusivamente el único 

estándar utilizado en redes domésticas.

Ethernet Cable The blue cable which was included with the Force. Used to connect the Force to a router.

Firewall
Un firewall es una pieza de software o hardware que bloquea ciertos tipos de tráfico . Por ejemplo, un servidor de seguridad podría bloquear el 

tráfico entrante en un determinado puerto o bloquear todo el tráfico entrante excepto el tráfico procedente de una dirección IP específica.

Dirección IP
Cada dispositivo (por ejemplo, computadoras, impresoras , routers , y la Force) en una red deben tener una dirección única . Una dirección IP 

consiste de cuatro grupos de números del 0 al 255, separados por un punto decimal (por ejemplo, 192.168.1.200 ). 

LAN Una red de área local es una red pequeña que está confinada a un área local. Por ejemplo, la red doméstica o una red de oficina es un LANA.

Módem Un módem es un dispositivo que proporciona acceso a la Internet. Al conectar el módem al router (en lugar de directamente a una 

computadora), todos los dispositivos conectados al router pueden accesar al módem, y por lo tanto, la Interne. 

Router
Un router es una pequeña caja que permite que varios ordenadores, impresoras y otros dispositivos (como la Force) se unan a la misma red.

Dispositivo Inteligente Un dispositivo que tenga acceso a Internet, tales como los teléfonos celulares más recientes (por ejemplo, iPhone, Androids) y las tabletas como 

el iPad.

Stand-alone
Capaz de ser operado de forma independiente, por ejemplo, En modo autónomo la Force está conectado a la computadora sin necesidad de 

utilizar un router. 

Wi-Fi 
Wi - Fi es una tecnología de red inalámbrica que permite a las computadoras y otros dispositivos comunicarse a través de una señal 

inalámbrica. 

Wi-Fi Adaptor
Pequeño dispositivo USB que fue conectado en la Force antes de enviarse. Esto Permite a la Force  comunicarse de forma inalámbrica con 

una computadora o un router. 
 

• Si su Force fue enviada antes de mediados de febrero de 2016, las instrucciones en las Secciones 2.2 a 

2.5 no funcionarán. Por favor utilice los siguientes procedimientos para establecer la comunicación con su 
Force y lanzamiento C3. Una vez que usted tenga la pantalla principal en C3 disponible, usted puede 
entonces, actualizar a la última versión y, a partir de ese momento, siga las instrucciones en las secciones 
2.02 a 2.05 para futuras instalaciones cuando mueva su Force a una red diferente.  

• Si usted tiene algunas dificultades en el establecimiento de la conexión, favor de iniciar un boleto para 
apoyo usando este enlace: http://knkusa.com/support/ o llame al 800-268-3672.   

 

 
B7.2 Configurando la Force 

• Coloque su Force sobre una superficie horizontal sólida. Tire hacia abajo la mesa en el frente. 

http://knkusa.com/support/
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• Conecte el cable de corriente adaptador de CA/CC. Enchufe el cable de corriente a una toma de corriente y 
el adaptador de CA/CC en el lado derecho de la KNK Force.  

• Para activar la Force, presione el botón de encendido en la parte frontal. El indicador de corriente se 
encenderá y la cortadora inicializará (el carro se moverá hacia el lado derecho de la cortadora). Usted 
notará una serie de luces intermitentes rápidas dentro de la Force, seguido de una serie de luces azules 
intermitentes lentas. El programa de la computadora está siendo cargado y esto tomará unos 90 segundos.  

• Para desactivar la Force, mantenga pulsado el botón de encendido hasta que oiga dos pitidos. Luego, la luz 
parpadeará ~ diez veces antes de que la máquina apague. 

• Debido a que su Force aún no se ha actualizado al nuevo firmware posterior a febrero de 2016, usted debe 
conectar la Force a su enrutador doméstico u oficina utilizando un modo inalámbrico. Tenga en cuenta que 
usted no necesita una conexión a Internet excepto para instalar actualizaciones de programa. Si usted 
necesita conectar su Force en una ubicación sin un enrutador disponible, considere la posibilidad de 
comprar un pequeño enrutador de viaje de bajo costo. ¡Funcionará, también! 

•  Las siguientes secciones presentan los pasos necesarios. Si usted se encuentra con problemas de 
conectividad, por favor, póngase en contacto con KNK USA para asistencia. Puede comenzar un boleto 
para soporte en este enlace: http://knkusa.com/support/ o llamar al 800-268-3672. 

• Por favor lea la siguiente información IMPORTANTE atentamente. Esta Contiene los requisitos actuales 
para que la Force se conecte exitosamente a su computadora.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
B7.3 Conexión Wi-Fi  

• El adaptador Wi-Fi está preinstalado en su KNK Force. El CD incluido NO es requerido ya que el software 
necesario ya está instalado. 

• Una conexión Wi-Fi es una conexión inalámbrica entre su KNK Force y su enrutador doméstico o de 
oficina. Hasta que usted no actualice C3, no podrá conectarse a través de un cable desde su computadora 
a su enrutador inalámbrico. Usted tendrá que conectarse de forma inalámbrica para el siguiente 
procedimiento. Una vez completado, usted puede volver a usar un cable para la conexión de su 
computadora, si lo desea. 

• Los siguientes pasos deben ser completados en el orden dado: 

 Si el adaptador Wi - Fi no está ya conectado a uno de los puertos USB en el lado de la Force, 
seleccione cualquiera de los cuatro para insertar el adaptador. 

IMPORTANTE: En este momento, las siguientes condiciones son requeridas para que la Force sea 
conectada: 

 La computadora debe estar conectado de forma inalámbrica a su router (después de la 
instalación de la Force, la computadora puede ser conectada a través de Ethernet, si usted 
desea). 

 La red inalámbrica debe estar protegida por contraseña. Usted necesitará saber el nombre de 
su red y esta contraseña para el proceso de configuración. 

 El nombre de la red inalámbrica no puede contener un espacio. Por ejemplo, RedCasera 
trabajará, sin embargo, Red Casera no trabajará. 

 Si su red está configurada para estar invisible, entonces usted probablemente necesitará 
seleccionar “otra red” en el menú desplegable y escribir en ella. 

 Su router debe estar configurado para emitir Direcciones IP estáticas. 

 La Force debe estar conectada de forma inalámbrica… el cable Ethernet incluido no puede ser 
utilizado todavía. 

 Algunos dueños de un dispositivo modem/router combinado están teniendo problemas para 
conectarse. Es recomendado que usted contacte KNK USA para asistencia. 

http://knkusa.com/support/
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 Si la Force actualmente está apagada, presione el botón de encendido en la parte frontal de la KNK 
Force y espere que la computadora dentro de la Force arranque. 

 Una vez que una luz fija aparezca (después de ~ 90 segundos), retire el adaptador.  

 Espere hasta que la luz cambie a rojo y luego conecte de nuevo el adaptador en el mismo puerto USB. 
La luz dentro de la Force ahora debe cambiar a verde. 

 Usted ahora está listo para conectarse a su computadora o dispositivo inteligente. Las siguientes 
subsecciones cubren los pasos necesarios para conectar a través de una PC con Windows (Sección 
B7.3.1), una Mac (Sección B7.3.2). Hay otras opciones también, como un iPhone y un iPad. Si usted 
tiene problemas poniendo una conexión a trabajar, contacte su suplidor KNK para asistencia.  

 
B7.3.1 Conexión Wi-Fi en una PC con Windows 

 
Las siguientes instrucciones fueron escritas para un sistema operativo Windows 10. Los pasos deben ser 
prácticamente idénticos para las versiones anteriores de Windows. Para obtener instrucciones para una Mac, 
vaya a la Sección B.5.2. 

• Cierre todas las aplicaciones innecesarias. Es también recomendado que usted desactive temporalmente el 
programa antivirus y el firewall.   

• Localice y lance el icono de red de su PC (normalmente en la esquina inferior derecha de la pantalla). 

 

 

• Usted verá KNK_Force como un dispositivo al que usted se puede conectar. Haz clic en eso. 

 

• Luego, la ventana se expandirá y usted puede hacer clic en Conectar o “Connect”: 

 

• Después de unos segundos, la siguiente ventana se abrirá. Introduzca su contraseña para la red. Haga clic 
en Pruebe estos ajustes (Try these settings): 

Clic sobre KNK_Force 

Note el nombre de su 

corriente red o network. 

Clic sobre Connect 

Clic sobre el icono Network  



194 

 

 

• Espere un minuto y la Force ahora será conectada a su red y asignada una Dirección IP. Anote esta 
Dirección IP ya que la va a estar utilizando cada vez que usted desee accesar su Force. Haga clic en 
Guardar estas configuraciones (Save these settings) y continuar (continue): 

 

• Sin embargo, si en lugar usted obtiene el siguiente mensaje, repita los Pasos 2 y 3 y luego la pantalla 
correcta, con la Dirección IP debería aparecer, como mostrado anteriormente. 

 

 

• Espere un minuto y la siguiente ventana mostrará un enlace directo a la Dirección IP. Haz clic en eso. 

 

 

• La pantalla principal del programa C3 ahora será lanzada. Tenga en cuenta que la disposición de los 
botones y las configuraciones pueden variar dependiendo del dispositivo utilizado para ver C3.   

Luego click aquí 

Entre su contraseña 

para la red. 

Verifique el nombre de su 

red aparece aquí. 

Note la Dirección IP 

asignada a su Force 

Luego click aquí 

Clic sobre la Dirección IP 
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• Si algo falla en lograr esta conexión, comience nuevamente en el paso 1. A veces toma más de un intento 
en conseguir que la conexión sea activada. Además, en el paso 5, intente aumentando el tiempo de espera 
de DHCP a 30 segundos en lugar de 10. Dependiendo en lo fuerte de la señal del router, puede ser 
aconsejable moverse más cerca al router para el proceso de instalación. Tenga en cuenta que una vez que 
se le asigna la Dirección IP, ya no tendrá que repetir estos pasos a no ser que usted remueva el 
adaptador. 

• Ahora que usted tiene la Force configurada, por favor, actualice a la última versión. Estos pasos se explican 
en la Sección 4.03. Siguiendo la actualización, vaya a la Sección 2.06 para probar su nueva KNK Force! 

 
B7.3.2 Conexión Wi-Fi en una Mac 

 
 
Las siguientes instrucciones fueron escritas para un sistema operativo Mac 10.9.4. Los pasos deben ser 
prácticamente idénticos para otras versiones. 

• Cierre todas las aplicaciones innecesarias.  

• Localice y lance el icono de red para su Mac (normalmente en la esquina superior derecha de la pantalla) 

 

 

• Después de unos segundos, usted verá KNK_Force aparecer como un dispositivo al que usted se puede 
conectar. Haz clic en eso. 

 

Note el nombre de su red 

actual. 

Clic sobre KNK_Force 

Clic sobre el icono Red “Network” 

http://cutterpunk.com/knk-force-videos/#macwifi
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• Después de unos segundos, la siguiente ventana se abrirá. Introduzca su contraseña para la red. Haga clic 
en Prueba estos ajustes (Try these settings): 

•   

 

• Espere un minuto y la Force ahora será conectada a la red y asignada a una Dirección IP. Anote esta 
Dirección IP ya que la va a utilizar cada vez que desee acceder a su Force. Haga clic en Guardar estas 
configuraciones (Save these settings) y continuar (continue): 

 

• Espere otro minuto y la siguiente ventana mostrará un enlace directo a la Dirección IP. Haz clic en eso: 

 

La pantalla principal del programa C3 ahora será lanzada: 

 

Note la Dirección IP 

asignada a su Force 
Luego clic aquí 

Clic sobre la Dirección IP 

Luego clic aquí 

Entre su contraseña 

para la red. 

Verifique que su nombre 

de red aparece aquí 
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• Si aparece un mensaje de error que indica que el servidor no puede ser conectado, haga clic en el icono de 
la red, una vez más, como en el paso (2). Asegúrese de que está conectado de nuevo a su red principal: 

 

• Si algo falla en lograr esta conexión, comience nuevamente en el paso 1. A veces toma más de un intento 
en conseguir que la conexión sea activada. Además, intente aumentando el tiempo de espera de DHCP a 
30 segundos en lugar de 10. Dependiendo en lo fuerte de la señal del router, puede ser aconsejable 
moverse más cerca al router para el proceso de instalación. Tenga en cuenta que una vez que se le asigne 
la Dirección IP, ya no tendrá que repetir estos pasos a no ser que usted remueva el adaptador. 

• Ahora que usted tiene la Force configurada, por favor, actualice a la última versión. Estos pasos se explican 
en la Sección 4.03. Siguiendo la actualización, vaya a la Sección 2.06 para probar su nueva KNK Force! 

 
B8 Conexión de la KNK Force Directamente a su Computadora 

 
 
• Gracias a Darrel Farris por el siguiente tutorial para conectar en una PC. Por favor, vea el video si usted 

tiene una Mac. 
 
(1) Conéctese a su red Wi-Fi normal. Si usted no tiene una red Wi-Fi, conéctese a la red inalámbrica 

knk_force.  
 

(2) Abra el Panel de Control de Windows (Windows Control Panel).  
 

(3) Haga clic en Ver estado y tareas de la red (View Network Status & Tasks) para abrir el Centro 

de redes y recursos compartidos (Network & Sharing Center).  
 

(4) Haga clic en Cambiar la configuración del adaptador (Change Adapter Settings).  
 

(5) Utilice la tecla CTRL para seleccionar varias conexiones Wi-Fi y Ethernet.  
 

(6) Haga clic con el botón derecho y seleccione Conexiones de puente (Select Bridge Connections).  
 

(7) Apague la computadora.  
 

(8) Apague la Force.  
 

(9) Conecte el cable de red entre la Force y su computadora.  
 

(10)  Encienda la computadora.  
 

(11)  Encienda la Force.  
 

(12)  Si usted tenía un IP estático configurado, introdúzcalo en su navegador web. Si la conexión por cable 
de la Force está configurada para usar DHCP, intente navegar hasta el nombre de host http: //knk-
force.local (predeterminado) o inicie sesión en su enrutador para determinar la dirección IP que le 
asignó su enrutador. 
 

  

Asegurese su red está 

seleccionada.  

Tambien, la KNK_Force 

No aparecerá más en la 

lista. 
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Expresiones de Gratitud 
 
 
Por favor envíe un correo electrónico a sandy@iloveknk.com si se encuentran errores en este manual o si 
usted tiene sugerencias de adiciones o cambios.  
 
Gracias a las siguientes personas por revisar este manual. ¡Sin su ayuda, este manual estaría plagado de 
errores tipográficos y demasiadas comas! También aprecio enormemente sus cambios sugeridos para hacer 
las cosas más claras, más consistentes y más precisas: 

Melanie Flickinger  

Jim Bailey 

Michele Harvey 

Whizzy Heritage 

Louis D. Monaghan, Jr. 

Lynn Stockberger 
 
Quisiera agradecer a Omayra Duarte por traducir este manual a español. 
 
Gracias a las siguientes personas por sus contribuciones técnicas: 

Liz Ackerman 

Ricardo Bernardino 

Linda Calderone 

Darrel Farris: http://cutterpunk.com/ and https://www.youtube.com/c/CutterPunkCrafts  

Julie Flanagan: https://groups.yahoo.com/neo/groups/MTC_Tuts.info/    

Benjamin Flaming: http://www.tripoli-consortium.com/  

Melanie Flickinger 

Michele Harvey: http://cuttinupdesigns.com/  

Whizzy Heritage 

Judy Keating 

Janene Spratt 

Lynn Stockberger 

Clint Taggart 

Francisco Arenas Ulloa 

Chad Youngblut: http://knkusa.com/ 

 
Gracias a las siguientes personas por probar materiales y enviar ajustes para las tablas de este manual: 

Liz Ackerman 

Jim Bailey 

Leslie Cernocky 

Karisa Doane 

Darrel Farris: http://cutterpunk.com/ and   https://www.youtube.com/c/CutterPunkCrafts  

Julie Flanagan: https://groups.yahoo.com/neo/groups/MTC_Tuts.info/    

Melanie Flickinger 

Jaynny Geelan 

Michele Harvey: http://cuttinupdesigns.com/  

Whizzy Heritage 

Tracy Stein 

Diana Tunnicliff 

Chad Youngblut: http://knkusa.com/ 

 
¡Y un gran agradecimiento a mi familia y amigos por su paciencia y su apoyo por mi pasión Klic-N-Kut! 

 

Sandy McCauley:  http://www.iloveknk.com/  
 

mailto:sandy@iloveknk.com
http://cutterpunk.com/
https://www.youtube.com/c/CutterPunkCrafts
https://groups.yahoo.com/neo/groups/MTC_Tuts.info/
http://www.tripoli-consortium.com/
http://cuttinupdesigns.com/
http://knkusa.com/
http://cutterpunk.com/
https://www.youtube.com/c/CutterPunkCrafts
https://groups.yahoo.com/neo/groups/MTC_Tuts.info/
http://cuttinupdesigns.com/
http://knkusa.com/
http://www.iloveknk.com/
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